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Disclaimer 

Information in this document is subject to change without notice and does not 
represent a commitment on the part of Software Bisque. The software and/or 
databases described in this document are furnished under a license 
agreement or nondisclosure agreement. They may be used or copied only in 
accordance with the terms of the agreement. It is against the law to copy the 
software on any medium except as specifically allowed in the license or 
nondisclosure agreement. The purchaser may make one copy of the software 
for backup purposes.  No part of this manual and/or databases may be 
reproduced or transmitted in any form or by any means, electronic or 
mechanical, including (but not limited to) photocopying, recording, or 
information storage and retrieval systems, for any purpose other than the 
purchaser's personal use, without the express written permission of Software 
Bisque. 
 
Sky Charts created with TheSky6 are for personal use only. They may not be 
published in any form without express written permission of Software Bisque, 
Inc. 
 
TheSky6 includes routines from Astronomical Algorithms Software, © 1991 
by Jeffrey Sax, and option to the book Astronomical Algorithms by Jean 
Meeus copyright © 1991 by Willmann-Bell. ISBN 0-943376-35-2. Non-
exclusive use has been specifically granted, in writing, by Willmann-Bell, for 
use in TheSky6. Serial Number U11A445. Photographs in the AAO folder of 
TheSky6’s media are copyright © Anglo-Australian Observatory (AAT 
images) and/or © ROE/AATB (UK Schmidt Telescope images) and are 
reproduced with permission. Photographs from the Anglo Australian 
Observatory telescopes are by David Malin. 
 
The photograph of the Milky Way is licensed from Digital Sky LLC. 
 
TheSky6 copyright © 1984–2005 Software Bisque, Inc. All rights reserved. 
 
AutomaDome, CCDSoft Image Processing Software, Orchestrate Scripting 
Software, TheSky6 Astronomy Software, and TPoint Telescope Pointing 
Analysis Software for Windows are trademarks of Software Bisque, Inc. 
 
Windows™ is a trademark of Microsoft Corporation. 
 
All other product names are trademarks of their respective owners and are 
used solely for identification. 
 
Revised: May 2005 
 





  

5  

Table of Contents 

 

Table of Contents......................................................................................................... 5 

Chapter 1 Installing & Getting Started ..................................................................... 11 

Welcome! .......................................................................................................................... 11 
Typographic Conventions............................................................................................................. 11 
Windows Conventions .................................................................................................................. 11 
Getting Help.................................................................................................................................. 12 

Chapter 2 Orienting the Virtual Sky.......................................................................... 13 

Selecting Terrestrial Coordinates....................................................................................... 13 
Non-Standard Time Zone Entry.................................................................................................... 15 

Setting the Time and Date ................................................................................................. 15 
Understanding Projections................................................................................................. 21 

Projections (View menu)............................................................................................................... 22 
Setting the Orientation.................................................................................................................. 23 

Chapter 3 Navigating the Virtual Sky ....................................................................... 27 

Zooming the Display.......................................................................................................... 27 
The Zoom To Command .............................................................................................................. 27 

Scrolling the Display .......................................................................................................... 30 
Dragging the Screen.......................................................................................................... 32 

The Move To Command (Orientation menu)................................................................................ 32 
Centering the Display ........................................................................................................ 34 
Making It All Make Sense .................................................................................................. 34 
Undoing Changes to the Virtual Sky .................................................................................. 35 

Chapter 4 Displaying Celestial Objects ................................................................... 37 

Type Selection................................................................................................................... 37 
Limiting the Magnitude of Displayed Objects ............................................................................... 38 

How TheSky6 Displays the Principal Catalogs .................................................................. 39 
Catalog Contents .......................................................................................................................... 40 
Disclaimer ..................................................................................................................................... 42 

Chapter 5 Finding and Identifying Celestial Objects .............................................. 43 

Identifying Objects............................................................................................................. 43 
Using the Information Buttons ...................................................................................................... 45 
Copying Information ..................................................................................................................... 45 
Using the Multimedia, Utility, and Telescope Sheets ................................................................... 47 
Customizing the Object Information Report ................................................................................. 49 

Finding Objects ................................................................................................................. 52 

Chapter 6 Display Modes and Options .................................................................... 65 

Real Mode Options (View menu) ....................................................................................... 65 



TheSky6 
 

6 

Display Explorer (View menu) ........................................................................................... 67 
Full Screen (View menu) ................................................................................................... 81 
Chart Mode (View menu) .................................................................................................. 81 
Projections (View menu) ................................................................................................... 82 
Mirror Image / Inverting the Display (View menu) .............................................................. 83 
Stellar Options (View menu).............................................................................................. 83 

Non-Stellar Options (View Menu) .................................................................................................86 
Night Vision Mode (View menu) ........................................................................................ 88 

Halt Update (ESC) ........................................................................................................................89 
Redraw Screen (View menu)............................................................................................. 90 
Update Solar System (Tools menu)................................................................................... 90 
Options (Tools menu)........................................................................................................ 90 

Precessing Equatorial Coordinates...............................................................................................91 
Computer Time (Tools menu)............................................................................................ 91 
Toolbars (View menu) ....................................................................................................... 91 
Status Bar (View menu) .................................................................................................... 94 
Scroll Bars (View menu).................................................................................................... 95 
Undo (Edit menu) .............................................................................................................. 95 

Chapter 7 Reference Lines ........................................................................................ 97 

Adding Reference Lines to the Display.............................................................................. 97 
General Lines................................................................................................................................98 
Constellation Lines........................................................................................................................98 
Equatorial Lines ............................................................................................................................98 
Horizon-based Lines .....................................................................................................................99 

Field of View Indicator (View menu) ................................................................................ 104 
Creating FOVIs for Your Equipment ...........................................................................................106 
Telrad™ Finder ...........................................................................................................................110 

Chapter 8 Labels ...................................................................................................... 113 

Label Setup..................................................................................................................... 113 
Extended Labels .........................................................................................................................114 

Chapter 9 Comets, Minor Planets, and Satellites .................................................. 117 

Entering Orbital Elements ............................................................................................... 117 
Obtaining Orbital Elements from the Internet..............................................................................120 

Extended Minor Planet Data............................................................................................ 120 
Satellites ......................................................................................................................... 121 

Chapter 10 Configuring TheSky6 with Sky Documents........................................ 125 

What is a Sky Document? ............................................................................................... 125 
Loading a Different Sky Document .............................................................................................126 
Creating Multiple Sky Documents...............................................................................................126 
Sky Documents Supplied with TheSky6 .....................................................................................126 
Sending a Sky Document as an Email Attachment ....................................................................127 

Chapter 11 Customizing with Display Properties.................................................. 129 

The Display Properties Dialog Box.................................................................................. 129 
Font .............................................................................................................................................129 
Line..............................................................................................................................................130 



Table of Contents 
 

7 

Fill ............................................................................................................................................... 131 
Color Selection Tips ................................................................................................................... 132 
Symbol........................................................................................................................................ 132 
Creating Display Properties Files ............................................................................................... 133 

Chapter 12 User-Defined Data ................................................................................ 135 

Basics of Adding User-Defined Data.......................................................................................... 135 
Changing the Default Data Type ................................................................................................ 135 
Adding Reference Points/Objects .............................................................................................. 136 

Adding Labels.................................................................................................................. 136 
Adding Lines/Polygons ............................................................................................................... 136 
Adding Ellipses ........................................................................................................................... 138 

Chapter 13 Star Charts and Tables ........................................................................ 141 

Printed Charts............................................................................................................................. 141 
Star Chart Format....................................................................................................................... 141 
Orientation .................................................................................................................................. 141 
Changing the Printing Options.................................................................................................... 142 

Adding Star Charts to Other Documents.......................................................................... 146 
Displaying and Printing Uranometria 2000.0™ Charts .............................................................. 146 

Exporting Star Charts (Professional Edition only) ............................................................ 147 
Data Wizard – Exporting Data ......................................................................................... 149 

Sun and Moon Report ................................................................................................................ 156 

Chapter 14 The Sky Database Manager ................................................................. 159 

Searchable Databases ............................................................................................................... 160 

Chapter 15 Custom Databases ............................................................................... 163 

Database Requirements............................................................................................................. 163 
Creating Custom Databases ...................................................................................................... 168 
Database Types ......................................................................................................................... 171 
Format Restriction ...................................................................................................................... 173 
Defining Database Indexes ........................................................................................................ 173 
Multipliers.................................................................................................................................... 175 
Export Restrictions ..................................................................................................................... 177 
Editing Object Symbols .............................................................................................................. 177 

Chapter 16 Image and Multimedia Databases ....................................................... 179 

Displaying Pictures ..................................................................................................................... 179 
Show Picture Command (Tools menu) ...................................................................................... 180 
Slide Show Command (Tools menu).......................................................................................... 180 
Creating Your Own Image Databases........................................................................................ 182 

Associating Sounds with Events in TheSky6 ................................................................... 188 

Chapter 17 Image Link Overlays............................................................................. 189 

Inserting the Image to be Linked...................................................................................... 189 
Aligning Automatically with the Link Wizard™ (Professional Edition) ........................................ 190 
Image Requirements .................................................................................................................. 190 
Image Link Setup........................................................................................................................ 190 
Aligning Manually with Object Dragging..................................................................................... 194 
Creating an Automatically Linked Digitized Sky Survey Image.................................................. 195 



TheSky6 
 

8 

Chapter 18 Object Paths and Time Skips............................................................... 197 

Object Paths ................................................................................................................... 197 
Time Skips ...................................................................................................................... 201 

Orientation and Animation ..........................................................................................................201 
Setting Up a Simulation...............................................................................................................201 
Running the Simulation ...............................................................................................................202 
Using the Time Skip Toolbar.......................................................................................................203 
Using the Time Skip Controls with the Virtual Sky......................................................................204 

Chapter 19 Simulations and Tools.......................................................................... 205 

3D Solar System View..................................................................................................... 205 
Changing the Field of View .........................................................................................................205 
Using the Tracking Setup Dialog Box .........................................................................................206 
Printing the Display .....................................................................................................................207 

Daytime Sky Mode .......................................................................................................... 208 
Eclipse Finder and Simulator (Tools menu)..................................................................... 208 
Jupiter’s and Saturn’s Moons .......................................................................................... 210 
Moon Phase Calendar (Tools menu)............................................................................... 210 
Moon Viewer (Tools menu) ............................................................................................. 211 

Conjunction Finder (Tools menu)................................................................................................213 
Mosaic Command (Tools menu)...................................................................................... 214 

Using the Mosaic.........................................................................................................................218 
Options............................................................................................................................ 219 

Saving Document Changes Before Exiting.................................................................................219 
Showing the Wait Cursor ............................................................................................................219 
Copying Sample Files to the My Documents Folder...................................................................219 

Chapter 20 Controlling Your Telescope................................................................. 221 

WARNING!..................................................................................................................................221 
Introduction .................................................................................................................................221 
Setting Up and Using Optical Encoder Systems ........................................................................223 
Using the Link .............................................................................................................................227 
Terminating the Link....................................................................................................................228 
Finding a Particular Object..........................................................................................................228 

Setting Up and Using your Go To Telescope .................................................................. 228 
Slewing While the Link is Suspended .........................................................................................230 
Slewing to a Specific Object .......................................................................................................230 
Motion Controls ...........................................................................................................................231 
Focuser .......................................................................................................................................231 
Reticle .........................................................................................................................................232 
Set Park ......................................................................................................................................232 
Park .............................................................................................................................................232 
Find Home...................................................................................................................................232 
Align Home..................................................................................................................................232 
Terminal ......................................................................................................................................232 
Set LST .......................................................................................................................................232 
Star Search .................................................................................................................................233 
Status ..........................................................................................................................................233 
Terminating the Link....................................................................................................................233 
Using the Telescope Simulator ...................................................................................................233 
Digital Setting Circles ..................................................................................................................233 

Troubleshooting the Telescope Setup ............................................................................. 234 



Table of Contents 
 

9 

Appendix A File Locations and Database Errors .................................................. 237 

Database File Locations ............................................................................................................. 237 
User-Defined File Locations ....................................................................................................... 239 
Missing or Anomalous Catalog Data .......................................................................................... 240 

Appendix B Function & Accelerator Keys ............................................................ 241 

Windows Function & Accelerator Keys ...................................................................................... 241 
Object Information Dialog Box Keyboard Shortcuts ................................................................... 244 

Appendix C Reference Data.................................................................................... 245 

Common Star Names ................................................................................................................. 245 
Object-Type Index Numbers....................................................................................................... 246 

Index ......................................................................................................................... 247 

 





  

11  

Chapter 1 Installing & Getting Started 

Welcome! 

This document includes detailed information about TheSky6’s features. See 
the printed TheSky6 Getting Started Guide for details about installing and 
starting TheSky6. 

Typographic Conventions 

This manual uses the following typographic conventions. 
 
Example of Convention Description 
normal.sky 
a:install 
; This is a comment. 
Courier   
 

Courier typeface is used for file and folder 
(directory) names, for text typed from the 
keyboard, and to display the contents of files. 
 

dimmed 
Press and hold the left button. 
Paramount ME 
 
 

Italic text is used to highlight new terms. 
It’s also used for emphasis... 
and to identify product names. 

W 
ENTER 
ALT+Z 
 

Keystrokes are shown in SMALL CAPS. If there is 
a plus sign (+) between two keys, press and hold 
the first key, then press the second. 
 

UP, DOWN 
LEFT, RIGHT 
 

The “arrow” directional keys are represented by 
words, rather than arrow symbols. 
 

Windows Conventions 

This manual assumes you have a basic knowledge of the Windows interface. 
Here are a few reminders about mouse usage and terminology. 
 
Example of Convention Description 
Click  
 

“Click” always means “left-click.” If you’re 
supposed to press the right mouse button, the 
text will say “right-click.”  

Select  Point the mouse pointer at a command, an item 
in a list, or a tab, and then click. 

 
Drag  

Press and hold the left mouse button. Then 
move the mouse to outline the area or objects 
you want to select.  

 
Dimmed  

When a command or function is not available, it’s 
shown in gray text (instead of black). Unavailable 
commands and Functions are therefore said to be 
dimmed. 

Marked / If a checkbox has a check mark, it’s “marked.” 
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Clear 
 

If there is no check mark, it’s “clear.” 

 
 

Getting Help 

The Help file explains each command and option in TheSky6. Access it by 
selecting the Contents and Index command from the Help menu. 
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Chapter 2 Orienting the Virtual Sky 

 
When you run TheSky6, the first thing you’ll usually do is adjust the display 
(which we call the Virtual Sky) to show the part of the heavens you want to 
study. This chapter (and the following) explains how to position the Virtual 
Sky exactly how and where you want. 

Selecting Terrestrial Coordinates 

The first step in orienting the Virtual Sky is setting the point on the surface of 
the Earth from which you’d like to view the heavens. To begin, select the 
Location command from the Data menu. Your location can be selected from a 
list of pre-defined locations, or from a world map, or entered manually. 
 

 
 
 List tab – You can select a pre-defined location from the lists on this tab. 

The coordinates of many locations and selected observatories are 
presented here.  

 
To see if your city is listed, click the + at the right of the United States, 
World Observatories, World Cities or User-Defined Locations text and 
then scroll the listings. When you find your city, click on its name to 
highlight it. Then click Set Location to make it the default setting. (Click 
Cancel to quit without changing the location.)  

 
You can jump to an entry by typing its name. Click the +, and then enter 
the first letters of the name. For example, typing DEN moves the list to the 
first entry starting with ‘DEN’ – that is, Denver, Colorado. Click OK to 
return to the Virtual Sky (or click Apply if you want to see the changes 
without exiting).  
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 World map tab – Select the World Map tab to select your location from a 
map of the world. The brighter area represents the sunlight portions of 
the globe. A small white dot represents the current location, with a 
description listed below the map. Click anywhere on the map to select 
your location, or click and drag on the map to find a city near you. 

 
When you find your city, click OK to make it the default setting. (Click 
Cancel to quit without changing the location.)  
 

 
 

 User-Defined Location tab – Enter your location manually. 
 

1 Enter the Latitude and Longitude. Use positive values. Click on 
the North/South and East/West radio buttons to indicate the 
hemisphere. 

2 Enter the Time Zone. Time zone numbers start at 0 at Greenwich, 
and increase to the west. For example, the Pacific coast of the US is 
time zone 8. Negative time zones are supported. 

3 Enter the Elevation (in meters). The elevation affects the visibility 
of objects near the Virtual Sky’s horizon.  

4 Enter the time zone. TheSky6 automatically determines the sign of 
the time zone based on your longitude. 

5 Select the daylight saving option. TheSky6 automatically adjusts 
time based on this setting and the current date. That is, you do not 
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need to make time adjustments for Daylight Saving Time vs. Standard 
Time. 

6 Enter a name or identifier for these coordinates in the Location 
box. This is usually the city and state (or country), but it can be 
anything you like.  

7 If you use an existing name, the new coordinates will replace the old 
ones. Click Apply or Close. The new site coordinates are now the 
default. 

 
To delete an entry, highlight it and click Remove. You are prompted to 
confirm the deletion. 
 

Non-Standard Time Zone Entry 

TheSky6 uses a convention where Eastern longitudes have a positive time 
zone value between 1 and 12, and Western longitudes have a negative time 
zone value between -1 and -12. TheSky6 determines the sign of the time zone 
using the East or West Longitude setting on the User-Defined tab of the 
Location dialog box.  
 
Some non-standard time zone locations do not follow this convention. An 
example of a non-standard time zone is one that is West of the Prime 
Meridian, but ahead of universal time (UT), as is the case in parts of France 
and Spain.  
 
If you live in a non-standard time zone, you must mark the Allow Non-
Standard Time Zone option on the Time Options dialog box (page 19) so that 
TheSky6 computes the non-standard time zone, and therefore the correct 
local time. 

Setting the Time and Date 

TheSky6 also needs to know the time. By default, TheSky6 uses the current 
time from your computer’s internal clock. Click the button that looks like an 
analog clock to turn on and off using the computer’s clock for time.  
 
If you want to see how the sky will look tonight (or next week, or next month, 
or on 10/12/1492) you need to enter the appropriate month, day, year and 
time of day.  
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Figure 1 – The large format Time dialog box. 

 
1 Click Date | Time to display the Time window. 
2 Click the desired date on the Calendar, or enter the month, day, year and 

time of day.  
3 Click the Go Forward button (or any of the other time control buttons) to 

apply these changes. 
 
As before, TheSky6 computes the positions of Solar System objects. Then it 
draws the heavens as they appear at the time and place you selected.  
 

11 22 33 44

55

66

77 88

99 1010 1111 1212 1313 1414 1515 16 1716 17
 

Figure 2 – The numbered circles represent individual Time dialog box controls. 

 
The “simple looking” Time dialog box contains many useful options for 
controlling time and setting time-related options. Use the TAB key to access 
the standard controls. 
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Number (see 
Figure 2) 

Control Name Description 

1 Month Click on the Month control to change the current 
month. Use the spin buttons or manually enter the 
value. 
 

2 Day Click on the Day control to change the current month. 
Use the spin buttons or manually enter the value. 
 

3 Year Click on the Year control to change the current month. 
Use the spin buttons or manually enter the value. 
 
TheSky6 uses the Gregorian calendar for date entry. So, 
enter a negative year for B.C. dates (year zero does not 
exit in using this convention).   
 
The minimum year that TheSky6’s algorithms are 
accurate is –4713. The latest year is 10,000 A.D. 
 

4 Time Enter the current time.  
 

5 Analog/Digital 
Clock 

The analog clock provides several different methods for 
setting time. 
 
 Click and drag the hour hand to go forward or 

backward in time by one hour. 
 Click and drag the minute hand to go forward or 

backward in time by one minute. 
 Click and drag the second hand to go forward or 

backward in time by one second. The second hand is 
rather narrow, and may be tricky to "catch" on the 
first try! 

 Click on any hour number to change time to that 
hour. For example, click on the number 3 to set the 
time to three o'clock. 

 Click in the middle of the hour numbers to change 
time to the nearest half hour. For example, click 
between the numbers 3 and 4 to set the time to 3:30. 

 
See the Time Options dialog box (page 19) for details 
about the digital clock settings. 
 

6 Calendar  The large and medium Time dialog box displays 
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calendar control that highlights the current date and 
also lets you quickly change the date by clicking on any 
day of the month. 
  
 Dates in the current month are black. 
 Dates for the previous and following months are 

grey. 
 Click on any number (for the previous, current or 

next month) to set TheSky6's date to this value.  
 The current date is highlighted in a white rectangle 

(red in Night Vision Mode). 
 

7 Time Interval Select the length of time between successive 
computations.  The default time interval options 
include: 
 
1x  (real time) – Positions of objects are constantly 
computed. The frequency of screen updates is specified 
in the Time Options dialog box (page 19). 
50x – Positions of objects are computed at 50 times the 
“real time” rate.  
500x – Positions of objects are computed at 50 times 
the “real time” rate. 
1 second 
1 minute 
1 hour 
1 day 
1 week 
1 year 
Sunrise – The time skip interval is the length of time 
between sunrises for successive days.  
Sunset – The time skip interval is the length of time 
between sunsets for successive days. 
Dawn twilight – The time skip interval is the length 
of time between morning astronomical twilight for 
successive days. 
Dust twilight –The time skip interval is the length of 
time between evening astronomical twilight for 
successive days. 
 
You can also manually enter any interval. For example, 
enter 1d 4h 52m 30s skips 1 day, 4 hours, 52 
minutes, 30 seconds. 
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8 Slider Drag the slider control to quickly advance or retreat 
time. This can be quite handy when you need to 
determine the path of a satellite, or the position of a 
planets’ moon. 
 
This control is not accessible when one of the “real 
time” intervals is selected (1x, 50x and 500x).  

9 Reset Time Resets the date and time to the beginning of the time 
skip simulation. See Chapter 18 Object Paths and Time 
Skips  on page 197 for details. 

10 Go Backward Time runs backward. See Chapter 18 Object Paths and 
Time Skips  on page 197 for details. 

11 Step Backward Step backward on time skip increment. See Chapter 18 
Object Paths and Time Skips  on page 197 for details. 

12 Stop Stop time. See Chapter 18 Object Paths and Time Skips  
on page 197 for details. 

13 Step Forward Step forward on time skip increment. See Chapter 18 
Object Paths and Time Skips  on page 197 for details. 

14 Go Forward Time runs forward. See Chapter 18 Object Paths and 
Time Skips  on page 197 for details. 

15 Object Paths Create time skip paths for solar system objects. See 
Chapter 18 Object Paths and Time Skips  on page 197 
for details. 

16 Use Computer 
Time 

Click this button to use you computer’s clock to track 
time. 

17 Setup Click this button to specify the Time dialog box 
properties. See “Time Dialog Box Options” on page 19 
for details. 

Time Dialog Box Options 

The Time Options dialog box allows the size of the Time dialog box can be 
modified, and for the time display format to be changed.  
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Figure 3 – Use the Time Options dialog box to change the 
appearance of the Time dialog box. 

 
Changing Time dialog box options 

1 Click the Time Options button on the Time widow. Or right-click on 
the face of the clock to display the Time Options dialog box. 

2 Specify the size of the Time window. Full displays the calendar, clock 
and the time control tool bar. Medium displays just the calendar and 
clock, while Small shows only the date and time. 

3 Click on the Analog or Digital option. In addition to local time, the 
Digital option displays the Local Sidereal Time (LST), Universal Time 
(UT) and the Julian date. 

4 Mark the 24-hour clock option to display time based on a 24-hours, 
rather than 12-hours with AM and PM. 

5 Specify how often TheSky6 re-computes the positions of solar system 
objects and stars. 

6 If you live in an area where the time zone does not follow convention, that 
is, your longitude is West of Greenwich, but the time zone is positive, 
then mark the Allow non-standard time zones option, and then enter a 
–1.0 for the Time Zone on the User-Defined tab of the Location dialog 
box. TheSky6 will now compute the correct local time.  

7 Click OK. 

Setting Your Computer’s Clock 

Personal computers have notoriously inaccurate clocks that can gain or lose 
many seconds each day. The best way to accurately maintain time is to use a 
network time server. The Windows XP operating system has built-in Internet 
time server software. See “Keeping Accurate Time” page 21 for more 
information. 



Chapter 2 Orienting the Virtual Sky 
 

21 

Screen Update Frequency 

The position of both Solar System and deep-sky objects is updated 
automatically every 15 minutes when the “Use computer’s clock” button on 
the Time dialog box pressed. 
 
The update interval can be changed. The Screen Update Frequency section 
has separate settings for the Stellar (deep-space) and Solar System update 
intervals. You can select 30 seconds, 1, 5, 15, or 30 minutes, 1 hour, or Never 
for either, plus 0.25, 0.5, 1, 5, 10, or 15 seconds for Stellar. Never fixes the 
display at its last update, even if “Use computer’s clock” is marked.  
 
When “Use computer’s clock” is clear, the display does not automatically 
change. The interval settings are therefore dimmed and have no effect. 

Keeping Accurate Time 

Internet time servers are the best way to keep accurate time. If you’re 
running XP, click Start | Control Panel | Date & Time | Internet Time 
tab to configure automatic time synchronization. There are also several 
freeware programs are available for non-XP users.  
 
Examples: 
 
 D4Time from Thinking Man Software 

(http://www.thinkman.com/index.html) 
 Tardis 2000 from HC Mingham-Smith, Ltd 

(http://www.kaska.demon.co.uk/). 

Understanding Projections 

Ever since we discovered that the Earth isn’t flat, but spherical, 
cartographers have been looking for ways to represent a curved surface on a 
flat surface.  
 
A sphere cannot be projected onto a plane without introducing distortion. In 
the most commonly used projection – called the Mercator projection – objects 
get larger the farther they are from the equator. This causes Greenland to 
look nearly as large as the rest of the United States on world maps. 
Navigators adopted the Mercator projection because a straight line on a 
Mercator projection, called a rhumb line, represents a constant compass 
bearing from true north.  
 
Other projections have their own combinations of strengths and weaknesses. 
All projections are compromises – the “best” projection is the one whose 
advantages outweigh its disadvantages for a particular application.  

http://www.thinkman.com/index.html
http://www.kaska.demon.co.uk/
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By default, TheSky6 uses the stereographic projection for fields of view of 50° 
or wider. Stereographic projection is said to be “conformal.” Although (as 
with all flat maps) the overall projection is distorted, all lines of declination 
and right ascension intersect at right angles, as they do on the celestial 
sphere.  
 
The advantage of stereographic projection is that, over small areas of the 
display, object shapes are only slightly distorted. Constellations remain easy 
to identify. Compare this with the polar projection of a planisphere. There is 
almost no distortion near the poles, but constellations near the horizon are 
badly stretched out of shape. (A planisphere is one of those rotating star 
charts that approximate what’s visible in the sky at a given date and time.)  
 
When the Virtual Sky is set to a field of view less than 50°, the projection 
automatically switches to an orthographic projection, which displays the sky 
more as it would appear on the surface of a sphere. (This is the only 
projection used at 50° fields of view and smaller.) The orthographic projection 
provides the best match of the image plate to the Virtual Sky when using 
Image Link (page 189).  

Projections (View menu) 

Stereographic projection is the default for fields of view of 50° and greater. 
The Projections command from the View menu changes the projection. In the 
Projections dialog box, click the radio button of the projection you want.  
 

 
Figure 4 – The Projections dialog box. 

 
The selected projection becomes the wide-angle default when you click OK to 
exit. It takes effect only when the field of view is 50° or greater – no change 
occurs if the current field of view is less than 50°. 
 
 Stereographic – The default for fields of view equal to and greater than 50°. 

It keeps lines of right ascension and declination at right angles and 
minimizes local distortion. Conformal. 235° maximum field of view. 
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 Orthographic – Displays the sky more as it would appear on the surface of 
a sphere. It’s the default (indeed, it’s the only available projection) for 
angles of view less than 50°. It is used with the Image Link function (page 
189) to match the projection of photographic and CCD images, which are 
inherently orthographic. Conformal. 180° maximum field of view.  

 Mercator – Shows the celestial sphere like a conventional map. It allows 
wider fields of view, including a 360° view that shows the entire celestial 
sphere. Conformal. 360° maximum field of view.  

 Gnomonic – Displays meteor paths as straight lines, as seen when viewing 
a meteor shower. Non-conformal. 150° maximum field of view.  

 Azimuthal Equal-Distance – The distance between objects having a 
particular angular separation on the celestial sphere is the same at any 
part of the Virtual Sky. Non-conformal. 300° maximum field of view.  

 Azimuthal Equal-Area – The areas of any sections of the celestial sphere 
subtending a particular solid angle are the same at any part of the Virtual 
Sky. Non-conformal. 235° maximum field of view. 

Setting the Orientation 

Before navigating the Virtual Sky, you need to choose an orientation. The 
orientation sets the basic layout of the Virtual Sky and selects the coordinate 
system (horizon or equatorial). There are three orientations. 
 
 Zenith Up  
 Pole Up 
 Free Rotation 
 
You can select the orientation from the Orientation menu, or click the 
corresponding button in the Orientation toolbar. Either way, the button 
remains “down” to show which mode is selected.  

Zenith Up 

Zenith Up projection is referenced to horizon-based coordinates. It’s used 
when you want TheSky6 to simulate the view from your observing site. 
Selecting Zenith Up rotates the Virtual Sky so the selected site’s zenith (90° 
altitude) is at the top (whether or not that part of the sky is visible in the 
current field of view). The current field of view and coordinates of the center 
of the Virtual Sky do not change. In Zenith Up mode, scrolling the display left 
or right changes the azimuth. Scrolling the display up or down changes the 
altitude. 

Pole Up 

Pole Up orientation references the Virtual Sky to equatorial coordinates. It’s 
the most-intuitive mode when you’re studying celestial objects themselves, 
rather than how they’re viewed from a specific site. Selecting Pole Up 
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positions the Virtual Sky so that the North or South Celestial Pole is at the 
top (whether or not the pole is visible in the current field of view). Which pole 
is determined by whether your site location is north or south of the equator. 
The current field of view and coordinates of the center of the Virtual Sky do 
not change. Since Pole Up is not referenced to the site location, the Local 
Horizon line (page 99) has no meaning and is removed from the display. In 
Pole Up orientation, scrolling the display left or right changes the right 
ascension. Scrolling the display up or down changes the declination. 

Free Rotation 

Free Rotation lets you rotate the Virtual Sky to any angle. 
 
1 Select Free Rotation from the Orientation menu. Or click the Free 

Rotation button or the Rotate Tool button in the Orientation toolbar, or 
press ALT+R. The Rotate Tool is displayed.  The Rotate Tool is a line that 
runs from the center of the display and points to the North celestial pole, 
with the letter N in a circle.  

2 Drag the N circle to rotate the display. If you press CONTROL while 
dragging, the display is positioned at multiples of 15° (0°, 15°, 30°, 45°, and 
so on). To return the Rotate Tool to 0°, click the N circle.  

3 Click the Rotate button a second time to hide the Rotate Tool. Or 
press ALT+R a second time. Even though the Tool is now hidden, the display 
remains in Free Rotation mode.  

 
The Look Commands 
 
When previewing the night sky, you usually want to orient the display to the 
approximate direction you’ll face. There are five preset orientations – North, 
South, East, West, or Zenith (Look Up). These commands appear in the Look 
command of the Orientation menu, and as buttons on the Orientation toolbar. 
Or you can right-click anywhere in the Virtual Sky, and select Look from the 
pop-up menu.  
 
Each Look command also has an accelerator key. Press N, S, E, W, or Z.  
 
 North, South, East, and West place the horizon at the bottom of the 

screen, with the zenith at the top. The field width is set to 100°, giving a 
detailed view of about ¼ of the sky.  

 Zenith adjusts the field width to 200°, with the zenith at the center of the 
screen. This view is similar to that of a planisphere, or the monthly star 
charts published in astronomy magazines.  

 
Selecting any Look command switches the Virtual Sky to Zenith Up 
orientation. Scrolling movements now move the display with respect to 
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horizon (Alt-Az) coordinates. (”Up” scrolling is disabled in Zenith view, 
however, since you cannot move “above” the zenith.) 

Interrupting a Screen Redraw 

TheSky6 redraws the Virtual Sky whenever you scroll or zoom. The more 
items displayed (stars, deep-space objects, reference lines, labels, 
photographs, and so on), the longer the redraw takes.  
 
The calculations are performed first, and then the screen is redrawn. The 
redraw is not instantaneous. You can interrupt it by pressing ESC. The Virtual 
Sky shows only those objects that had been redrawn at the time you pressed 
ESC. To complete the redraw, select Redraw Screen from the View menu or 
press F5.  
 
Scrolls or zooms can also be interrupted by pressing any scroll or zoom key. 
TheSky6 immediately begins redrawing the display at the new coordinates or 
magnification. You can “tap” the scroll or zoom keys to make a big change in 
the display, without having to wait for multiple redraws.  
 
Interrupting a redraw can also speed things up when you make more than one 
change at a time. For example, if you want to hide the constellation 
boundaries, and then display the horizon lines, you can press ESC as soon as 
you turn off the boundaries, instead of waiting for the redraw. 
 
TheSky6 shows a “wait cursor” during redraws. To prevent this, select the 
Options command from the Tools menu, clear the Show Wait Cursor When 
Drawing Screen” option and then click OK. 

Undoing Changes to the Virtual Sky 

Selecting Undo from the Edit menu can reverse changes to the Virtual Sky’s 
orientation. Or press CONTROL+Z.  
 
TheSky6 remembers up to 15 orientation and move changes made since the 
beginning of each session, including the automatic display updates that occur 
every 15 minutes in Zenith Up mode. You can keep undoing changes until you 
exhaust the “undo” list. At that point, the Undo command is dimmed.  
 
The list of changes is discarded when you exit TheSky6. If there’s a group of 
settings you want to keep, use the Save As command to create a Sky 
Document (.SKY file).  See page 125. 
 
You can also undo changes that have not yet been saved in the current Sky 
Document. Select the New command from the File menu (or press 
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CONTROL+N, or click the New button in the Standard toolbar). You are prompted 
to save changes to the current Sky Document. Click No to discard the 
changes. The last saved version will then be reloaded.  If you don’t want to be 
prompted to save changes when exiting TheSky6, select the Options 
command from the Tools menu, then clear the check mark from the Prompt 
to Save Modified Documents option. 
 
TheSky6 also remembers, and can “undo” the previous display property 
setting for each object.  
 
Changes that don’t affect orientation, position, or field width – such as turning 
on the Equatorial Grid – are not recorded. They are undone by deselecting 
them. 
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Chapter 3 Navigating the Virtual Sky 

 
This chapter explains how to scroll the Virtual Sky, change its field of view, or 
display a specific area of the heavens. 

Zooming the Display 

When TheSky6 first runs, the field of view has the default value of 100°. This 
is approximately the same field of view as the human eye. 
 
You can “zoom in” or “zoom out” to see less or more of the sky. As the field 
is narrowed, fainter, higher-magnitude objects are displayed. 

The Zoom To Command 

There are several ways to change the field width. One is to use the Zoom To 
command from the Orientation menu (or from the pop-up that appears when 
you right-click in the Virtual Sky). Choose from the list of seven preset 
angles. You can also select one directly with the keystrokes listed below.  
 
Designation  Field of View Keyboard 

Shortcut 
Maximum  150°-360° (varies 

with projection) 
HOME 

Wide Field 150°–180° (varies 
with projection) 

CONTROL+W 

Naked Eye  100° CONTROL+E 
Binoculars 50° 
 

50° CONTROL+B 

Finder 10°  
 

10° CONTROL+ALT+F 

Telescope   
 

1° CONTROL+T 

Minimum  
 

30" END 

 
HOME and END are easy to remember, because they represent the beginning 
(lowest) and ending (highest) limits of magnification. The others correspond 
(approximately) to the fields of view suggested by their names. For a simple 
mnemonic, think “WEBFooT.” 

Zoom Buttons 

Another way to change the field width is to click one of the “magnifying glass” 
buttons on the Orientation toolbar. Like Alice’s mushroom, one side 
(“minus”) shows you more of the sky, the other side (“plus”) shows you less. 
When zooming in, the incremental change is 20% of the current field width. 
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For example, if the width is 180°, clicking the plus button decreases it to 144°. 
When zooming out, the change is 25% of the current field width. (A 25% 
increase and a 20% reduction are equivalent changes.) 
 
Pressing CONTROL when you click reduces the increment to about ¼ its default 
value – 5% in each direction.  
 
Pressing CONTROL+SHIFT when you click reduces the increment to about 120 its 
default value – 1% in each direction.  
 
The PAGE UP and PAGE DOWN keys work the same as the “minus” and “plus” 
zoom buttons (respectively). If you hold down either one, the Virtual Sky 
zooms as rapidly as it can, without pausing for a full redraw. As with the zoom 
buttons, pressing CONTROL or CONTROL+SHIFT at the same time reduces the zoom 
increment to ¼ or 120 its default value. 

The Zoom Box 

The most flexible way to “zoom in” is to outline the desired area with a zoom 
box. This gives exactly the magnification you want, and automatically centers 
the selected area. To select a specific area: 
 

 
Figure 5 – Dragging a zoom box. 

 
1 Point the mouse cursor at the upper-left corner of the area. If you 

normally hold the mouse in your left hand, you can point at the upper-right 
corner instead.  

2 Drag the mouse cursor to outline the desired area. The selected area 
is outlined with a rectangle. Its angular dimensions – in degrees and 
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minutes – are shown at the top of the zoom box and in the lower-left 
corner of the Status Bar. If the zoom box is too large or has the wrong 
shape, you can drag “backwards” to change it. Dragging past the starting 
point “flips” the zoom box right-to-left.  

3 Release the mouse button. If the zoom box doesn’t have the shape or 
position you want, click outside the zoom box to remove it. Or right-click 
in the Virtual Sky and select Remove Zoom Box from the pop-up menu. 
Then repeat Steps 1–3.  

4 Click anywhere inside the zoom box to zoom in. 
 
The zoom box can be drawn with any aspect ratio, regardless of the aspect 
ratio of the display. (If you want the zoom box to have the same aspect ratio 
as the display driver, press CONTROL as you drag.) The Virtual Sky zooms to 
the highest magnification that shows at least the area you outlined.  
 
You cannot zoom closer than an angle of view of 30". If you try to zoom closer, 
the center of the Virtual Sky is repositioned at the center of the zoom box. 
 
Large Zoom Boxes 

If the zoom box’s height or width is larger than about half the screen, the new 
view might show more than the previous screen. This is a side effect of 
stereographic projection. If it occurs, just select a smaller zoom area. 

Entering a Field Width Directly 

If you want a specific field width, you can enter it in the Find dialog box. 
 
1 Click Edit | Find, or press F, or click the Find button in the 

Objects toolbar. The Find dialog box appears.  
2 Type Z in the Find edit box, followed by the angle you want (in 

degrees). You can enter fractional angles. For example, Z11.27 produces 
a field of view of 11° 16' 12". To enter an angle in arcminutes, add the 
letter m after the angle.  

3 Click OK. The Virtual Sky zooms to the angle you entered. 

Minimum and Maximum Angles of View 

To remind you that you can’t zoom any farther, the minus button is dimmed 
at the maximum field of view, and the plus button is dimmed at the minimum 
field of view (1'). Regardless of how you change the viewing angle, TheSky6 
will “beep” (if you have your speakers plugged in) if you try to zoom wider 
than the maximum field of view allowed for that projection, or narrower than 
1'. 
 



TheSky6 
 

30 

The maximum field is 360° for Mercator, 300° for azimuthal equal-distance, 
235° for azimuthal equal-area & stereographic, 180° for orthographic, and 150° 
for gnomonic. 

Zooming and Planet Size 

At wide angles of view, the planet symbols are all about the same size – 
almost as large as the Sun. This makes them easy to find and recognize. 
 
As the field width narrows, the size of a planet remains constant until the 
point at which the planet would actually be visible as a disk. A photograph or 
ellipse whose diameter matches what you would see through a telescope then 
replaces the planet symbol. (Pluto is the only exception. Even at the Virtual 
Sky’s minimum field width, it cannot be resolved as a disk.)  
 
Keep this in mind if you set the Virtual Sky’s field of view to match your 
telescope’s field of view. Until you reach the transition point, the planet looks 
smaller through the telescope than it does in the Virtual Sky. 

Scrolling the Display 

TheSky6’s display can be scrolled, just as a document in a word processor can 
be scrolled. There are several ways to scroll. 

Scrolling with the Scroll Bars (View menu) 

Use scroll bars on the Virtual Sky to adjust center of the field of view. The 
horizontal scroll bar adjusts right ascension or azimuth and the vertical scroll 
bar adjusts declination or altitude (depending upon the current projection).  
 
Select the Scroll Bar command from the View menu to turn on and off the 
scroll bars. These settings are saved and restored each time the application is 
started.  
  
When dragging the scroll bar “thumb” (the rectangular button in the scroll 
bar) the status bar displays the destination coordinates in both right 
ascension/azimuth and declination/altitude. 
 
Hold down the Control key to disable “dynamic” scrolling (that is, redrawing 
the screen after each move) when dragging the scroll bar's thumb. 

Scrolling with the Arrow Keys (Orientation toolbar) 

The arrow keys scroll the display directly. You can use any of the three sets 
of arrow keys. 
 
 the “inverted T” group on the keyboard 
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 the arrow keys in the keyboard’s numeric keypad 
 the arrow-key buttons in the Orientation toolbar 
 
The default movement is about 10% of the current field of view. Scrolling can 
be modified in the following ways. 
 
 If you hold down any of the keyboard arrow keys, the display scrolls as 

rapidly as it can, without pausing for a full redraw. 
 Pressing CONTROL while scrolling reduces the scroll increment to ¼ its 

default value. 
 
Pressing CONTROL+SHIFT while scrolling reduces the scroll increment to a single 
pixel. 
 
Scrolling Direction 

First-time users sometimes find the screen movement confusing. “When I 
press the DOWN arrow, the display moves up. Is that right?” Yes, it is.  
 
The arrow movements represent motion in the sky. The arrows point in the 
direction you’d move your head to look at a different part of the sky.  
 
How Left/Right Scrolling Looks on the Screen 

Left-right scrolling is not left-right movement of the Virtual Sky, but a change 
in azimuth or right-ascension coordinates. How it looks depends on which 
part of the sky is displayed.  
 
Imagine a spinning sphere. If you view it from above a pole, it appears to be 
rotating. If you view it from the equator, it appears to be moving sideways.  
 
Left-right scrolling works the same way. If Pole Up is selected, and either 
pole is visible, pressing the LEFT or RIGHT buttons rotates the display. If a pole is 
not visible, the display scrolls sideways.  
 
The same movements occur when Zenith Up is selected, whether or not the 
zenith is visible in the Virtual Sky. 
 
Either way, it’s the same motion. Only the point of view differs. 
 
Upward Scrolling Disabled in Zenith Orientation 

In Zenith (Look Up) orientation, the local zenith is at the center of the screen. 
Upward scrolling is disabled, because you cannot scroll “above” the zenith. 
(You can still scroll “down.”) Pressing LEFT or RIGHT rotates the display. 
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Dragging the Screen 

Another way to alter the current field of view is to drag the screen. Right-
click and drag the mouse. After a short mouse drag (about 6 screen pixels) 
you’ll notice the cursor changes to an open, then closed hand. Moving the 
mouse left, right, up or down moves the screen accordingly. Release the right 
mouse button to exit the screen-dragging mode. 

The Move To Command (Orientation menu) 

The Move To dialog box positions the center of the Virtual Sky at any 
combination of right ascension–declination, or altitude–azimuth. You can 
enter coordinate values, or select them graphically by dragging a cursor. 

Entering Coordinates 

1 Select the Move To command from the Orientation menu. Or right-
click anywhere in the Virtual Sky and select Move To from the pop-up 
menu. The Move To dialog box appears.  

 
Figure 6 – Move To dialog box. 

2 Click the Entry Mode radio button of the coordinate system you 
want – Equatorial or Horizon. You can use either, regardless of 
whether you’re in Pole Up or Zenith Up mode.  

3 Enter the new coordinates in the edit boxes. Enter Altitudes and 
Declinations as positive numbers. Then click the North or South radio 
button to indicate the hemisphere. Right ascension is assumed to be in 
hours – not degrees. If you enter a value larger than 23, TheSky6 treats it 
“modulo 24” – it divides the value by 24 and uses the remainder. For 
example, an entry of 53 would be treated as 5.  

4 Select the Epoch – Current, 2000.0, or 1950.0. Current is for the year 
shown on the Date and Time sheet. If you select a different Epoch, 
TheSky6 converts your coordinates to the Current Epoch.  
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5 Click OK. The screen is redrawn with the new coordinates at the center 
of the display.  

Telescope Slewing 

If TheSky6 is actively linked to your telescope, the Slew button is displayed at 
the lower right. Click it to slew to the coordinates you entered. 
 
Selecting Coordinates Graphically 

1 Select the Move To command from the Orientation menu. Or right-
click anywhere in the Virtual Sky and select Move To from the pop-up 
menu. The Move To dialog box appears.  

2 Click the Entry Mode radio button of the coordinate system you 
want to use – Equatorial or Horizon. You can choose either, 
regardless of whether you’re in Pole Up or Zenith Up mode. 

3 Position the mouse cursor anywhere within the coordinates 
window at the top of the dialog box. In Horizon mode, the axes are 
azimuth (horizontal) and altitude (vertical). In Equatorial mode, the axes 
are right ascension (horizontal) and declination (vertical). The cross-
shaped cursor shows the coordinates of the current screen center. 

4 Drag the cursor to the new coordinates. The mouse cursor changes to 
a rectangle with marker lines when you drag. To cancel the move, drag 
the cursor out of the coordinates window.  

5 Release the mouse button. The screen is redrawn with the new 
coordinates at the center of the display. 

 

Dragging the cursor is not as precise as entering coordinates. However, it 
lets you see both the old and new positions. It’s an easy way to move the 
display close to known coordinates without having to type them in. 

Understanding Coordinate Systems 

Remember that Equatorial (right ascension-declination) and Horizon 
(altitude-azimuth) are two entirely different coordinate systems.  
 
 Equatorial coordinates point to absolute positions on the celestial sphere. 

Use them when you want to center a specific object (such as a galaxy or 
variable star). TheSky6 adjusts the coordinates of objects due to the effects 
of precession, nutation and aberration and refraction. 

 Horizon coordinates are relative to the sky above your current horizon 
line. Use them when you want to position the display toward a particular 
compass direction. 
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Centering the Display 

Sometimes you want to move a point in the Virtual Sky to the center of the 
screen. For example, Sirius might be at the upper-left corner, and you want to 
move it to the center. There are three ways to do this.  
 
 Left-click on the point (or object) you want to be at the screen center. In 

the Object Information dialog box, select Cursor Position (or the object) 
from the Object List. Then click the Center button. 

 Right-click on the point you want to be the new screen center. Then click 
Center in the pop-up menu. 

 Drag the screen – place the mouse pointer over the object, then right-click 
and drag the point to the center of the display. 

Where am I? 

As you zoom and scroll the Virtual Sky, you might lose track of where you’re 
looking. TheSky6 normally displays more stars than can be seen with the 
naked eye, so constellations are sometimes hard to identify.  
 
If this is a problem, try displaying the Equatorial Grid, Horizon Grid, or 
Constellation Lines. Any of these provides a useful reference.  
 
To see exactly where the display is centered, select the Status Bar command 
from the View menu. Mark either the “Equatorial” or “Horizon” checkbox in 
the Screen Position section and click OK. This adds a set of coordinates to the 

Status Bar that show the RA-Dec or Alt-Az of the center of the Virtual Sky.  

Making It All Make Sense 

We’re often asked about the differences between Pole Up and Zenith Up 
modes. Understanding each helps you keep your bearings when switching 
between the modes.  
 
The following explanation should clarify the differences.  
 
Pole Up and Zenith Up are separate modes that display the sky in different 
ways. Confusion sometimes occurs because users expect these modes to 
“relate” to each other in some way. They don’t. They have nothing to do with 
each other.  
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You would normally select the mode that’s appropriate for the way you’re 
using TheSky6 and stay with that mode until you have a reason to change. The 
following examples should make this clear.  
 
 When planning a night’s viewing, you’d probably select Zenith Up (or one 

of the Look modes – North, South, East, West, Look Up). These modes 
show the sky the way you’d see it from the viewing site – which objects 
are visible, where they rise and set, and so on. Scrolling moves the display 
with respect to the local coordinates.  

 When studying celestial objects, you’d probably select Pole Up mode. If 
you’re learning the constellations, memorizing the locations of Messier 
objects, or viewing TheSky6’s image database, you’re interested in the 
celestial sphere itself – not how it looks at a particular place or time. You 
want to move and position the display with respect to celestial coordinates 
– not those of your viewing site. 

Undoing Changes to the Virtual Sky 

Selecting Undo from the Edit menu can reverse changes to the Virtual Sky’s 
field width and position. Or by pressing CONTROL+Z.  
 
TheSky6 remembers up to 15 orientation and move changes made since the 
beginning of each session, including the automatic display updates that occur 
every 15 minutes in Zenith Up mode. You can keep undoing changes until you 
exhaust the “undo” list. At that point, the Undo command is dimmed.  
 
The list of changes is discarded when you exit TheSky6. If there’s a group of 
settings you want to keep, use the Save As command to create a Sky 
Document (.SKY file).  
 
You can also undo changes that have not yet been saved in the current Sky 
Document. Select the New command from the File menu (or press CONTROL+N, 
or click the New button in the Standard toolbar). You are prompted to save 
changes to the current Sky Document. Click No to discard the changes. The 
last saved version will then be reloaded.  
 
Changes that don’t affect orientation, position, or field width – such as turning 
on the Equatorial Grid – must be undone manually. 
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Chapter 4 Displaying Celestial Objects 

TheSky6’s core databases include entire catalogs (such as the Hipparcos-
Tycho Catalog, the Smithsonian Astrophysical Observatory Catalog, the 
Guide Star Catalog or the New General Catalog). From these catalogs you 
select the types of objects displayed and their limiting magnitudes.  
 
The Hipparcos, Tycho, and Hubble Guide Star catalogs are supplied with the 
Serious Astronomer and Professional Editions, plus catalogs with specialized 
contents. The Professional Edition incorporates additional stellar catalogs, 
such as the UCAC and portions of the USNO catalogs. Please refer to 
TheSky6’s help and search for “databases explained” for a complete 
description.   

Type Selection 

The Display Explorer on the View menu controls which objects and object 
types are displayed in the Virtual Sky. You can hide those you aren’t 
interested in to reduce screen clutter.   
 

 
Figure 7 – The Display Explorer window. 

 
There is a large number of distinct object types, to provide fine control over 
what is and isn’t visible. Object types are grouped into the following general 
categories.  
 
 Stars 
 Non-stellar 
 Solar system 
 Reference objects 
 Real Mode options 
 Sky Databases 
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 Core Databases 
 Image Groups 
 
Each category is further divided by object type.  
 
To select an object, open the desired node, and then click on its name, or type 
the first letter of its name in the Go To text box. Press the TAB key to select 
the object.  
 
Each object has its own checkbox. Mark or clear the checkbox to display or 
hide objects of that type.  
 
Marking a checkbox will not display the associated object type if there isn’t 
anything to display! For example, if Comets is marked, but no comets are 
selected in the Comets and Minor Planets dialog box, no comets will appear.  
 
By default, the following objects and symbols are not shown. You must mark 
their checkboxes to display them.  
 
 Variable Star; Suspected Variable; Double Star 
 Constellation Boundary 
 Horizon Grid; Equatorial Grid; Galactic Equator 
 Field of View Indicator Reference Point 

This isn’t the Field of View Indicator itself, but the “marker” at the center 
of the FOVI. The Field of View Indicator is displayed or hidden from the 
Field of View Indicator dialog box. 

 Telescope Limit Lines 
 
Constellation Boundaries, Galactic Equator, Horizon Grid, Equatorial Grid, 
Local Horizon, and Telescope Limits can also be selected or deselected from 
the Reference Lines dialog box (page 97). 
 
Changes made to the Display Explorer are applied to the Virtual Sky 
immediately. 
 
To make changes to the default filtering permanent, save the current Sky 
Document (page 125). 
 

Limiting the Magnitude of Displayed Objects 

The magnitude limit settings provide additional filtering, displaying objects 
only within a specified brightness range. Larger magnitude values represent 
dimmer objects. The brightest objects have negative magnitudes. 
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Right-click on any object to set its display properties, or use the Display 
Explorer command on the View menu.  
 

 
Figure 8 – Display Properties tab. 

Enter the magnitude limits in the Brightest and Faintest boxes. Fractional 
values are okay. The default range is 30.0 to -6.0. If you enter values outside 
this range, you’ll get a warning message and won’t be able to exit the dialog 
box. 

How TheSky6 Displays the Principal Catalogs 

TheSky6 uses the Hipparcos/Tycho and Hubble Guide Star catalogs as the 
principal charting databases. The 1.2 million stars in the Hipparcos-Tycho 
catalogs include every star down to about 12th magnitude. The 19 million stars 
in the now ubiquitous GSC contain stars to about magnitude 14.5. TheSky6 
includes additional catalogs that are better suited for astrometry, photometry 
and generating CCD image comparison charts. These include the USNO and 
the UCAC databases. 
 
The corresponding Guide Star Catalog (GSC) and SAO stars are therefore 
cross-referenced in the Object Information dialog box. GSC/SAO objects are 
displayed only when there is no corresponding Hipparcos-Tycho object, or 
when the display density is increased at narrower fields of view.  
 
It’s impossible to display all the 1.2 million objects in the Hipparcos and 
Tycho catalogs, even at wide viewing angles. Even a 1200x900 display doesn’t 
have enough pixels to distinguish 1.2 million distinct objects. (Every pixel 
would be illuminated – a computer version of Olbers’ Paradox, in reverse.) 
TheSky6 therefore limits the number of objects plotted, to avoid cluttering the 
display. Only the brightest objects of each type from the Hipparcos and Tycho 
catalogs are shown at field widths greater than 50°. This limiting is easy to 
see in the Virgo Cluster. Center the display at 12h 30m right ascension and 
8d 30m declination. Start with the field width at 60°, and then reduce it to 50°. 
You’ll see a big increase in the number of galaxies. You expect to see more 
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objects at narrower fields of view; additional high-magnitude objects are 
displayed below 50°. Another transition point occurs at 20° – many objects 
from the GSC, UCAC and USNO catalogs are added.  

Catalog Contents 

The following are brief descriptions of the catalogs supplied with TheSky6. 
 
Hipparcos-Tycho Catalogs 

These catalogs were assembled to support the Hipparcos and Tycho 
missions. They contain fewer stars (about 1.2 million total) than the GSC, but 
these include many stars amateur astronomers are interested in.  
 
The Hipparcos-Tycho coordinates are significantly more accurate than those 
in the GSC (though you're unlikely to see any difference in their plotted 
positions, expect perhaps at very narrow fields of view). The Hipparcos-
Tycho catalogs contain data that isn't in the GSC, including proper motion, 
parallax, position errors and spectral class.  
 
Hubble Guide Star Catalog (GSC) 

The Hubble Guide Star Catalog was assembled to support the Hubble Space 
Telescope’s need for off-axis guide stars. The GSC contains nearly 19 million 
objects brighter than magnitude 15, of which more than 15 million are 
classified as stars. 
 
UCAC 2.0 (Professional Edition only) 

The United States Naval Observatory CCD Astrograph Catalog contains 48 
million stars to about 40 degrees declination. The positions of the stars are 
very accurate and can be used to generate precise astrometric measurements. 
 
Non-Stellar Guide Star Catalog (NSGSC) 

The NSGSC is the non-stellar portion of the GSC. 
 
Smithsonian Astrophysical Observatory (SAO) 

The Smithsonian Astrophysical Observatory catalog is a subset of the GSC. It 
is cross-referenced using the stars from the GSC and you’ll see SAO entries 
in the Object Information dialog box. 
 
New General Catalog (NGC) 

The New General Catalog contains updated positions on 7840 objects from 
the NGC/IC Project, including galaxies, nebulae, and clusters. Most of the 
NGC objects classified as galaxies also appear in the Principal Galaxy Catalog, 
causing some overlap. 
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Index Catalog (IC) 

The Index Catalog includes the same types of objects that are in the NGC, 
and contains 5386 additional objects. Many IC objects overlap galaxies in the 
Principal Galaxy Catalog. 
 
Principal Galaxy Catalog (PGC) 

The Principal Galaxy Catalog is one of the most-comprehensive catalogs of 
galaxies. It contains detailed information on over 900,000 galaxies. The PGC 
also contains cross-references to other galactic catalogs. 
 
The Find command can be used to access over 130,000 cross-references to 
popular catalog designations, including the following: 
 
 Arakelian Catalog of Galaxies (ARAK) 
 Catalog of Galaxies and Clusters of Galaxies (CGCG) 
 David Dunlop Observatory Catalog of Galaxies (DDO) 
 Fairall Catalog of Galaxies (FAIR) 
 Karachentseva Catalog of Galaxies (KARA) 
 Kazaryan UV Galaxies (KAZ) 
 Kiso UV Galaxies (KUG) 
 Morphological Catalog of Galaxies (MCG) 
 Suspected Variables (NSV) 
 Second Byurakay Survey (SBS) 
 Tololo Galaxies (TOL) 
 University of Michigan Catalog of Galaxies (UM) 
 Uppsala General Catalog of Galaxies (UGC) 
 Virgo Cluster Catalog of Galaxies (VCC) 
 Weinberger Catalog of Galaxies (WEIN) 
 
Planetary Nebulae (PK) 

This catalog of 1455 planetary nebulae is derived from the Strasbourg Catalog 
of Galactic and Planetary Nebulae. 
 
General Catalog of Variable Stars (GCVS) 

About 28,000 variable stars are included from the General Catalog of 
Variable Stars. Variable stars are represented by a small red V below and to 
the left of the star. Suspected variables include a question mark (?). 
 
Suspected Variables (NSV) 

This catalog contains about 14,000 stars that are believed to be variable. 
 
Washington Catalog of Double Stars (WDS) 

TheSky6 includes about 98,000 double stars from the Washington catalog of 
visual-double stars.  
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The stars in the WDS are displayed with the yellow star/blue star symbol. To 
see these symbols, the Virtual Sky must be set to a field width of 50° or less, 
and the Double Star checkbox in the Display Explorer dialog box must be 
marked (or the Double Stars button in the Objects toolbar must be “down”). 
At field widths below about 0.5°, double stars often have enough separation to 
be plotted as separate objects. In these cases, TheSky6 draws a line drawn 
between the WDS coordinates of the two stars, rather than drawing the 
yellow/blue double-star symbol. 
 
TheSky6 uses the latest, more accurate WDS catalog. Earlier versions used an 
older WDS catalog, so double star coordinates usually did match the 
coordinates from the GSC or SAO catalogs (mostly because their coordinates 
were given only to the nearest arcminute).  
 
United States Naval Observatory (USNO) (Professional Edition only) 

TheSky6 Professional Edition supports this database (but does not include the 
database itself). The A1.0 edition of the USNO contains 488 million stars on 
10 CD ROMs, complete to about 21st magnitude. The SA1.0 edition covers 55 
million stars on a single CD. TheSky6 can display these data at a field of view 
of 1° or less.  
 
The USNO data are broken into zones. You can specify a separate location for 
each zone, so that the data can be split among multiple hard disks and/or CD 
ROM drives. Use the USNO Databases sheet in the File Locations dialog box 
to specify the drive and folder where each zone is located. 
 
To display the USNO catalog, zoom to a field width of 1° or less. Open the 
File Locations dialog box and select the USNO Databases tab. Mark the “Plot 
USNOA-1.0” checkbox.  

Disclaimer 

Software Bisque uses copyrighted astronomical catalogs and has no way to 
verify the accuracy of data. Additionally, we are not allowed to modify most of 
the catalogs supplied with TheSky6. We want to be informed of errors, but we 
aren’t permitted to correct inaccurate data from copyrighted catalogs. 
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Chapter 5 Finding and Identifying Celestial Objects 

Identifying Objects 

The Virtual Sky is linked to TheSky6’s databases. Clicking on an object (or 
locating it with the Find command) displays a wealth of information… 
 
 the object’s common name and/or its catalog designation  
 cross references to other catalogs 
 the object’s type (variable star, irregular galaxy, and so on) 
 the constellation in which the object lies 
 the object’s magnitude 
 a star’s Bayer (Greek-letter) brightness designation 
 the Dreyer description of the object, in plain English 
 the object’s distance from Earth, in light years and AU (where known) 
 catalog-specific information (such as min/max magnitude of variable stars, 

spectral class, parallax, proper motion, position error, distance from the 
Solar System) 

 the object’s equatorial (RA-Dec) coordinates, for both the date specified in 
the Site Information dialog box and Epoch 2000.0  

 the object’s horizon (Alt-Az) coordinates at the time displayed in the 
Status Bar when the object was clicked on (or found using Find) 

 the object’s rise time, transit time and set time for the site location the 
object’s angular dimensions 

 the angular separation from the last object identified 
 the object’s position angle (the angle between the line connecting the 

object and the last-identified object, and the line connecting the last 
identified object and the North or South Celestial Pole) 

 
Clicking on any object displays the Object Information dialog box. The object 
is surrounded by a “bull’s eye” of three concentric circles. 
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The object you clicked on, and up to ten “nearby” objects, are listed in the 
Object list box. This eliminates any need to click exactly on the object, and 
makes it easy to study groups of objects without having to click on each one. 
The Object list box also includes a Cursor Position entry that shows exactly 
where you clicked. If you click in an area without any nearby objects, Cursor 
Position is the only entry.  
  
To view information about any item in the Object list box, click on it. The 
bull’s eye moves to the item’s coordinates.  The Less Information/More 
Information buttons control the amount of information displayed. The default 
is Less. Clicking Less Information removes the tabbed sheets and object 
type/coordinate summary. 

 
 
The Object Information dialog box is non-modal. You don’t have to close it to 
do other things, such as scrolling the display or selecting commands. 

Identifying Galaxies, Nebulae, and Open Clusters 

At wide fields of view, galaxies, nebulae, and open clusters are displayed as 
their standard symbols. At higher magnifications, the symbols are replaced 
with circles or ellipses that represent the shape and dimensions of the object. 
Within these extended objects, there is no marked point on which to click. If 
the object is displayed as a circle, you can click anywhere within the circle. 
For objects displayed as ellipses, click within the circular region defined by 
the ellipse’s minor axis, as shown in the drawing below.  
 

 
 
 
 

 
 
The Andromeda galaxy (M31) is one example of this sort of object. You need 
to click on a point towards the center of M31 – without too many nearby stars 
– to identify it. Click on the central region of stars to identify them.  
 

The ellipse defines the 
galaxy’s extent. 

Click within the 
circle to identify the 
galaxy. 
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To override this default behavior, press and hold the SHIFT key when 
identifying objects. The point directly beneath the mouse cursor will be 
identified. This is useful to identify objects within extended objects, or to slew 
a telescope to a point inside an extended object. 

Using the Information Buttons 

The second group buttons at the bottom of the Object Information dialog box 
represents distance, rise/transit/set times, spectral class, angular separation 
from the last object located, and a toggle to Format Coordinates between 
degrees, minutes, seconds and decimal degrees when the Object Information 
dialog box is in More Information mode.  
 
If the Object Information dialog box is in Less Information mode, the Format 
Coordinates and Distance buttons are replaced with Azimuth/Altitude and 
Right Ascension/Declination buttons. 
 
Click any button to highlight the corresponding data. If a button is dimmed, no 
data is available for (or applicable to) the selected object. 

Copying Information 

To copy all the information in the Object Information dialog box to the 
Clipboard, click the Copy button at the bottom of the dialog box. To copy part 
of the data, drag across the parts you want. Then press CONTROL+C.   
 
Don’t use the Standard toolbar’s Copy button. 

Centering an Object 

The Center Object button repositions the Virtual Sky with the identified 
object at the center. Unlike the Find dialog box’s Find & Center control, the 
field of view is not adjusted. 

Adding Objects to the Observer’s Log 

TheSky6 can create an observer log of the objects you’ve identified. This file is 
called My Observing Log.txt. It’s written into the My Documents\Software 
Bisque\TheSky6\Observer Logs\ folder. To add an item to the log, select the 
item from the Object list, and then click the Show Observer Log button. This 
opens the Observer Log dialog box, with the object data displayed in an edit 
box. Selecting additional objects and clicking adds their Observer Log data to 
this file. You can edit the data at any time. 
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Figure 9 – Observer Log dialog box. 

 
Clicking Update Observer Log saves the log under its default name (My 
Documents\Software Bisque\TheSky6\Observer Logs\My Observing Log.txt). If 
you want to save it under a different name, click Browse. Enter the name you 
want, then click Save. Clicking Cancel discards any entries added to the log 
since you last saved it. 
 
My Observing Log.txt is never overwritten. New entries are appended to it, 
regardless of when you last opened the file. It is also the default log file; you 
cannot make another file the default. However, you can save it under a 
different name. 
 

 
 
TheSky6 keeps track of your observer log with the Find command on the Edit 
menu. Navigate to the Observed objects node in the Find list to view them. 
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Using the Multimedia, Utility, and Telescope Sheets 

The Object Information dialog box is initially displayed with the General 
property sheet open. There are three other property sheets – Multimedia, 
Utility, and Telescope. 
 
The Multimedia sheet displays any image of the object in a currently loaded 
database. If there’s more than one image for the object, the images are listed 
in the right-hand box. Click on the name of the one you want to view.  
 
If the object is a star, and the star has an assigned spectral class, the class is 
shown. The approximate visual color of the star is marked on the  “spectrum” 
with two triangles. 
 

 
Figure 10 – Multimedia property sheet. 

 
The Utility sheet provides functions that you would otherwise have to call 
from menus or dialog boxes. 
 

 
Figure 11 – Utility property sheet. 



TheSky6 
 

48 

 
 The Properties button brings up the corresponding dialog boxes. The 

selected object or its type is highlighted in their Object lists. 
 Add Object Path displays the Object Paths dialog box to generate the 

path of the selected object against the fixed starry background (This 
button applies to solar system objects only). 

 Lock On keeps the selected Solar System object at the center of the 
Virtual Sky or 3D Solar System view, even if you change the time or date.  

 Show Orbit switches to 3D Solar System mode (for Solar System 
objects). 

 View From switches to 3D Solar System mode (for Solar System objects) 
and shows Solar System motion as seen from the selected object.  

 Replace Image replaces the existing photograph of this object with the 
one pasted from the Windows Clipboard. 

 Time Skip Label allows you to add custom labels at specified increments 
for time skip paths. 

 Deactivate disables the Sky Database containing this object, for the 
remainder of the current session. 

 Copy to Local copies the orbital elements of the selected Extended 
Minor Planet to the local minor planet list. 

 Time Skip Label adds a time/date “balloon” to the selected step (or the 
full sequence) in a recorded Time Skip simulation. 

 
The Telescope sheet provides only alignment controls, since the Slew and Map 
buttons are always available from the toolbar at the bottom of the dialog box. 
These controls are not active until you establish a link with your telescope’s 
drive system. 
 

 
Figure 12 – Telescope property sheet. 

 
 Sync synchronizes the telescope to the selected object.  
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 Align On sets the selected star to be an alignment star when aligning encoders.  
 Set Park sets the telescope’s park position (ACL, Astro-Physics GTO, Meade 16" 

LX200, Software Bisque Paramount ME, Paramount GT-1100S, and Paramount GT-
1100 only).  

 Park moves the telescope to the park position (ACL, Astro-Physics GTO Meade 16" 
LX200, Software Bisque Paramount ME, Paramount GT-1100S, and Paramount GT-
1100, Paramount ME). 

 Set Tracking Rates computes the right ascension and declination tracking rates for 
the current object and sends them to the telescope control system (Paramount ME, 
Paramount GT-1100S only). 

 Track Satellites computes the rates of the selected satellite and sends them to the 
telescope’s control system (Paramount ME, Paramount GT-1100S only). 

 Slew Prior slews the telescope to the slewed to object. 

Customizing the Object Information Report 

The information displayed in the Object Information dialog box's report 
section is configurable. By editing the text file named Object Information 
Format.txt (in the <My Documents>\Software Bisque\TheSky6 folder) you 
can specify the order of the information displayed, as well as the content of 
the report.  
 
See the default Object Information Format.txt below for the format of this text 
file, as well as comments (the lines that begin with a semi-colon character are 
not part of the report) on each field in the report. 
 

 Fields in the report are separated by the '|' character. 
 The first field is the text that appears in Object Information report. 
 The second field is the TheSky6's object attribute that is associated 

with this text. 
 Fields that are not applicable to a particular object are ignored. For 

example, information about a planet will not appear when 
identifying a star. 

 
Sample Object Information Text file 
 

Object name|Object name| 
"Other ID"|Name 2| 
Catalog ID|Catalog ID| 
Magnitude|Magnitude| 
Apparent magnitude|Apparent magnitude| 
"Equatorial"|"RA: "|RA (current epoch)|"   Dec: "|Dec (current epoch)|"(current)"| 
"Equatorial 2000"|"RA: "|RA (epoch 2000)|"   Dec: "|Dec (epoch 2000)| 
"Horizon"|"Azim: "|Azimuth|"   Alt: "|Altitude| 
"Size"|Major axis |" x "|Minor Axis| 
Apparent angular diameter|Apparent angular diameter| 
"Alternate names"|Name 3|" "|Name 4|"  "|Name 5| 
"Visibility"|"Rise "|Rise time|",  "|"Set "|Set time| 
Transit time|Transit time|"  "|Rise/set notes| 
Phase (%)|Phase (%)| 
Flamsteed-Bayer|Flamsteed-Bayer| 
Name 6|Name 6| 
Name 7|Name 7| 
Name 8|Name 8| 
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Name 9|Name 9| 
Object type|Object type| 
Spectral|Spectral| 
Source catalog|Source catalog| 
; These are fields that are particular to the catalog.  
DB field 1|DB field 1| 
DB field 2|DB field 2| 
DB field 3|DB field 3| 
DB field 4|DB field 4| 
DB field 5|DB field 5| 
DB field 6|DB field 6| 
DB field 7|DB field 7| 
DB field 8|DB field 8| 
DB field 9|DB field 9| 
DB field 10|DB field 10| 
DB field 11|DB field 11| 
DB field 12|DB field 12| 
DB field 13|DB field 13| 
DB field 14|DB field 14| 
DB field 15|DB field 15| 
DB field 16|DB field 16| 
;Text record|Text record| 
Earth distance (km)|Earth distance (km)| 
Sun distance (au)|Sun distance (au)| 
Position angle|Position angle| 
Hour angle|Hour angle| 
Air mass|Air mass| 
Magnitude B|Magnitude B| 
Magnitude V|Magnitude V| 
Magnitude R|Magnitude R| 
"Screen x,y"|Screen X|", "|Screen Y| 
RA rate (arcsecs/sec)|RA rate (arcsecs/sec)| 
Dec rate (arcsecs/sec)|Dec rate (arcsecs/sec)| 
Altitude rate (arcsecs/sec)|Altitude rate (arcsecs/sec)| 
Azimuth rate (arcsecs/sec)|Azimuth rate (arcsecs/sec)| 
Azimuth rise|Azimuth rise| 
Azimuth set|Azimuth set| 
Minor planet active|Minor planet active| 
Minor planet epoch month|Minor planet epoch month| 
Minor planet epoch day|Minor planet epoch day| 
Minor planet epoch year|Minor planet epoch year| 
Minor planet mean anomoly|Minor planet mean anomoly| 
Minor planet eccentricity|Minor planet eccentricity| 
Minor planet semi-major axis|Minor planet semi-major axis| 
Minor planet inclination|Minor planet inclination| 
Minor planet long-ascend node|Minor planet long-ascend node| 
Minor planet long. perihelion|Minor planet long. perihelion| 
Minor planet eclip|Minor planet eclip| 
Minor planet mag 1|Minor planet mag 1| 
Minor planet mag 2|Minor planet mag 2| 
Comet perihelion month|Comet perihelion month| 
Comet perihelion day|Comet perihelion day| 
Comet perihelion year|Comet perihelion year| 
Comet eccentricity|Comet eccentricity| 
Comet perihelion distance|Comet perihelion distance| 
Comet inclination|Comet inclination| 
Comet long-ascending node|Comet long-ascending node| 
Comet long-perihelion|Comet long-perihelion| 
Comet eclip|Comet eclip| 
Comet mag 1|Comet mag 1| 
Comet mag 2|Comet mag 2| 
"Heliocentric"|"l: "|Heliocentric longitude|"b: "|Heliocentric latitude|"r: 
"|Heliocentricadius| 
"Geocentric"|"l: "|Geocentric longitude|"b: "|Geocentric latitude|"r: "|Geocentric 
radius| 
"Geocentric mean"|"l: "|Geocentric mean longitude|"b: "|Geocentric mean 
latitude|"r:|Geocentric mean radius| 
True RA|True RA| 
True Dec|True Dec| 
Altitude w/refraction|Altitude w/refraction| 
"Ecliptic"|"l: "|Moon ecliptic longitude|"b: "|Moon ecliptic latitude|"r: "|Moon 
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ecliptic radius| 
Moon parallax|Moon parallax| 
Moon angular diameter|Moon angular diameter| 
Moon distance (km)|Moon distance (km)| 
Moon true RA|Moon true RA| 
Moon true Dec|Moon true Dec| 
Moon topocentric RA|Moon topocentric RA| 
Moon topocentric Dec|Moon topocentric Dec| 
Moon topocentric ang. diameter|Moon topocentric ang. diameter| 
Moon altitude w/refraction|Moon altitude w/refraction| 
"Moon optical libration"|"l: "|Moon optical libration l|" "|"b: "|Moon optical libration| 
"Moon physical libration"|"l: "|Moon physical libration l|" "|"b: "|Moon physical 
libration b| 
"Moon total libration"|"l: "|Moon total libration l|" "|"b: "|Moon total libration| 
Moon position angle|Moon position angle| 
Moon phase angle|Moon phase angle| 
Moon position angle of bright limb|Moon position angle of bright limb| 
Penumbra radius|Penumbra radius| 
Umbra radius|Umbra radius| 
Sun position angle|Sun position angle| 
Heliocentric longitude|Heliocentric longitude| 
Heliocentric latitude|Heliocentric latitude| 
Declination of Sun|Declination of Sun| 
Declination of Earth|Declination of Earth| 
Polar diameter|Polar diameter| 
Longitude of the central meridian|Longitude of the central meridian| 
Longitude of the central meridian (II)|Longitude of the central meridian (II)| 
Defect of illumination|Defect of illumination| 
Phase correction|Phase correction| 
Ring axis (a)|Ring axis (a)| 
Ring axis (b)|Ring axis (b)| 
Parallax|Parallax| 
"Proper Motion"|Proper motion RA|", "|Proper motion Dec| 
"Position error"|Position error RA|", "|Position error Dec| 
Position error parallax|Position error parallax| 
Proper motion error RA|Proper motion error RA| 
Proper motion error Dec|Proper motion error Dec| 
Civil twilight start|Civil twilight start| 
Civil twilight end |Civil twilight end | 
Nautical twilight start|Nautical twilight start| 
Nautical twilight end|Nautical twilight end| 
Astronomical twilight start|Astronomical twilight start| 
Astronomical twilight end|Astronomical twilight end| 
Sidereal time|Sidereal time| 
Click distance|Click distance| 
Point 3D x|Point 3D x| 
Point 3D y|Point 3D y| 
Point 3D z|Point 3D z| 
Frame size (mins)|Frame size (mins)| 
Light years|Light years| 
Parsecs|Parsecs| 
Scale|Scale| 
Height|Height| 
Width|Width| 
Catalog number|Catalog number| 
Celestial type|Celestial type| 
Star ID|Star ID| 
GSC block|GSC block| 
GSC num|GSC num| 
Index|Index| 
NGC/IC|NGC/IC| 
Skip index|Skip index| 
Non-stellar fields|Non-stellar fields| 
Text record start|Text record start| 
Satellite visible|Satellite visible| 
Satellite eclipsed|Satellite eclipsed| 
Satellite extended|Satellite extended| 
Satellite name|Satellite name| 
Satellite TLE1|Satellite TLE1| 
Satellite TLE2|Satellite TLE2| 
Julian date|Julian date| 
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Latitude|Latitude| 
Longitude|Longitude| 
Earth altitude|Earth altitude| 
Range|Range| 
Range rate|Range rate| 
Depth of eclipse|Depth of eclipse| 
Catalog|Catalog| 
Angular separation|Angular separation| 
Observer's Log|Observer's Log| 

Finding Objects 

You don’t have to locate an object in the Virtual Sky to get information about 
it. The Find command can locate every object in TheSky6’s databases. The 
Find command is in the Edit menu. You can also access it by pressing F, or by 
clicking the “binocular” button in the Objects toolbar. Selecting the Find 
command displays the Find dialog box, which provides several ways to locate 
every object in TheSky6’s databases. 
 

   
 

Finding by Object Type 

 
Objects are categorized by type in the Find tree list. A simple way to find any 
object is to first determine its type. Next, determine what catalog you want to 
search and then select the name of the object from the catalog list. The table 
below lists each category in the Find tree list. 

  
Object Type  Catalog/Cross Reference Description 

  Lists databases of stars 

Bayer Bayer catalog designations 

Common name Common star names 

DM Bonner Durchmusterung number 

Flamsteed Flamsteed designations 

GCVS General Catalog of Variable Stars 

GSC Guide Star Catalog 

Stellar  

HD Henry Draper Number 



Chapter 5 Finding and Identifying Celestial Objects 
 

53 

NSV Catalog of Variable Stars 

SAO Smithsonian Astrophysical Observatory 

Struve Struve Catalog stars 

WDS Washington Double Star catalog 

    

  Lists databases of non-stellar objects 

Caldwell Caldwell Catalog objects 

Common names Names of common non-stellar objects 

Herschel Herschel 400 catalog  

IC Index Catalog 

Lorenzin Tomm Lorenzin Catalog 

Messier Messier Catalog 

NGC New General Catalog 

PGC Principle Catalog of Galaxies 

PGC cross reference Cross references to the Principle Catalog of 
Galaxies 

PLN Planetary Nebulae 

Non-stellar 

SAC Saguaro Astronomy Club Deep Space Object 
catalog 

  Lists objects in our solar system 

Comets Names of comets selected in the Comet Input 
dialog box. 

Extended minor planets Names of minor planets imported from the 
Extended Minor Planets dialog box. 

Minor planets Names of minor planets selected in the Minor 
Planet Input dialog box. 

Moon The Earth's Moon. 

Satellites Names of satellites imported from the 
Satellites dialog box. 

Sun The Sun. 

Mercury The planet Mercury. 

Venus The planet Venus. 

Earth The planet Earth (visible in the 3D Solar 
System Mode). 

Mars  The planet Mars. 

Jupiter The planet Jupiter. 

Saturn The planet Saturn. 

Jupiter The planet Jupiter. 

Uranus The planet Uranus. 

Neptune The planet Neptune. 

Pluto The planet Pluto. 

Solar System  

    

Constellations   List the names of the 88 constellations. 

      

Sky 
Databases 

Contents defined by the user. Lists Sky Databases imported from the Sky 
Database Manager dialog box. 
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Asterisms and other Contains the names of common asterisms and 
other not-so-common objects. This Sky 
Database is loaded automatically and cannot 
be removed using the Sky Database Manager. 

David Malin Images 2003  List photographs from the David Malin 
collection. This Sky Database is loaded 
automatically and cannot be removed using 
the Sky Database Manager. 

     

Observed 
objects 

Contents defined by the user. 
  

Lists objects added to the Observer Log dialog 
box. 

  
If the object is within the current field of view, it is marked with a bull’s eye. 
If the object is not within the field of view, the display is not repositioned. To 
guarantee the object will be visible, click Center & Frame or check the Frame 
Object option. The object is centered, and the field width is adjusted to tightly 
frame it. If the object is a planet, the field width is selected so the planet 
appears as a disk (rather than the default symbol). If the object is a point 
source (such as a star), the field width is set to 1°. 
 

Finding by Name 

Another way to find an object is to enter its name (Aldebaran, Bear Paw) in 
the Find edit box. You can enter the names of comets, minor planets, and 
auxiliary objects that appear in any active Sky Database.  
 
For example, to find the Great Nebula in Orion, type Great Nebula in 
Orion and click Find. The Object Information dialog box opens with 
information about the Great Nebula. If the Great Nebula is within the current 
field of view, it’s marked with a bull’s eye.  
 
You can also search for a star by manually entering its Bayer (Greek-letter) 
magnitude designation, followed by the constellation’s three-letter 
abbreviation. For example, to find the third-brightest star in Orion, type Gamma 
Ori. Clicking Find locates that star, Bellatrix. 
 
Great Nebula in Orion   
Gamma Ori  
 

Multiple Finds 

Because Find looks for any near match (not just an exact match), it often 
locates more than one object. For example, entering “Polaris” finds Polaris, 
Polarissima Australis, and Polarissima Borealis. These near-matches also 
appear in the Object Information dialog box. 
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Find also locates matches with Common Name labels. For example, searching 
for “Andromeda” not only finds the constellation, but references to M31 (the 
Messier number of the Andromeda galaxy). Antares is found too, since it 
starts with the same letters. 

 

If You’re Not Sure of the Right Spelling… 

Star names are Greek, Arabic, or Latin. You don’t have to know the correct 
spelling. The Find command looks for the closest phonetic match. 
 
For example, if you enter “Cassyop,” “Casopea,” or “Casiopeeyah,” the Find 
command correctly locates Cassiopeia. The search requires the correct first 
letter, however. Entering “Kassyop” will not locate Cassiopeia. 

Finding by Catalog Designation 

Yet another way to find an object is to enter its catalog designation. Leading 
zeroes are not required; the search routine automatically adds them. Typing 
just the catalog abbreviation (with no number) lists the first 10 items in the 
catalog. 
 
The Tycho catalog’s designers indexed it with the corresponding GSC 
numbers. We have therefore not included it as a searchable catalog.  
 

Catalog  Number Format 

GSC Objects 
 

Navigate to the Stars | GSC node in 
the Find tree list, and then select the 
desired GSC catalog number. Or, 
manually enter GSCbbb:oooo, where 
bbbb is the Guide Star block number 
(1-9537) and oooo is the offset of the 
object in the block. 
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SAO objects 
 

 
 

Navigate to the Stars | SAO node in 
the Find tree list, and then select the 
desired catalog number. Or, manually 
enter SAOnnnn, where nnnn is the 
SAO catalog number.  
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Hipparcos Enter HIPnnnnn where nnnnn is the 
Hipparcos catalog number. 

Messier objects 

 
 

Navigate to the Non-stellar | 
Messier node in the Find tree list, 
and then select the desired catalog 
number. Or, manually enter Mnnn, 
where nnn is the Messier catalog 
number. 

NGC objects 
 

Navigate to the Non-stellar | NGC 
node in the Find tree list, and then 
select the desired catalog number. Or, 
manually enter NGCnnnn, where nnnn 
is the NGC catalog number. 
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PGC objects 
 

Navigate to the Non-stellar | PGC 
node in the Find tree list, and then 
select the desired catalog number. Or, 
manually enter PGCnnnnnn, where 
nnnnnn is the PGC catalog number. 
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IC objects 
 

 
 

Navigate to the Non-stellar | IC 
node in the Find tree list, and then 
select the desired catalog number. Or, 
manually enter ICnnnn, where nnnn is 
the IC catalog number. 

PK planetary nebulae 
 

Enter PK plus the desired number. For 
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example, PK 118 +2.1. 
GCVS variable stars 
 

 
 

Navigate to the Stellar | GCVS node 
in the Find tree list, and then select 
the desired star from the list of 
constellations. Or, manually enter the 
star designator, followed by the 
constellation abbreviation. For 
example, to find GCVS RR 
Andromeda, enter h IGCVS RR AND. 

NSV suspected variable stars 
 

Navigate to the Stellar | NSV node 
in the Find tree list, and then select 
the desired star from the list of 
constellations. Or, manually enter 
NSVnnnnn, where nnnnn is the NSV 
catalog number. 
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Searching Other Catalogs 

Other catalog designations can be used to find objects. The table below lists 
the available catalogs and their prefixes, along with the number of galaxies in 
the catalog (Count) and an example of the correct format. Catalog numbers 
requiring leading zeroes are noted in the Comments. 
 
In some cases, the name of the catalog is not known. These entries are 
marked with a dash (–). 

 
Catalog 

 
Prefix Count Example Comments 

 
— 1SZ 26 1SZ 39 Numbering is not 

contiguous. 
— 2SZ 32 2SZ 4  

Zwicky1 1ZW 238 1ZW 1  
Zwicky2 2ZW 199 2ZW 1  
Zwicky3 3ZW 158 3ZW 1  
Zwicky4 4ZW 203 4ZW 1  
Zwicky5 5ZW 531 5ZW 1  
Zwicky6 6ZW 238 6ZW 1  
Zwicky7 7ZW 1145 7ZW 1  
Zwicky8 8ZW 645 8ZW 1  

Arakelian Catalog of Galaxies ARAK 595 ARAK 38  
— ARP 560 ARP 70  

Catalog of Galaxies and Clusters of 
Galaxies 

CGCG 29809 CGCG 502-64  
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David Dunlop Observatory Catalog 
of Galaxies 

DDO 242 DDO 11  

– ESO 16239 ESO 152-5  
Fairall Catalog of Galaxies  FAIR  1185  FAIR 700  

Infrared Astronomical Survey IRAS  9347  IRAS 01293-2548 5-digit prefix must be 
padded with zeros/ 

Karachentseva Catalog 
of Galaxies  

KARA  183  KARA 4  

Kazaryan UV 
Galaxies  

 

KAZ  581  KAZ 9  

Kiso UV Galaxies  KUG  5455 KUG 0001+311  4-digit prefix must be 
padded with zeros. 

– 
 

LGS  5  LGS 4  

Second Byurakay Survey  SBS  259  SBS 1209+550  
Tololo Galaxies  

 
TOL  111  TOL 29  

Uppsala General Catalog 
of Galaxies  

 

UGC  13073  UGC 8100  

University of Michigan 
Catalog of Galaxies  

 

UM  652  UM 533  

– 
 

VV  1161  VV 222  

Virgo Cluster Catalog 
of Galaxies  

VCC  2097  VCC 3  

Weinberger Catalog 
of Galaxies  
 

WEIN  207  WEIN 1  

 

Entering Catalog Numbers with the Mouse 

Because it can be difficult to type keyboard keys in the dark, TheSky6 
includes a method for entering catalog numbers with the mouse.  
 
Click the numbers (and the decimal point) on the right to enter numerical 
keys. Clicking Space enters a space. Clicking Back deletes the last 
(rightmost) character in the edit box, regardless of the current location of the 
text cursor.  
 

Occulted Objects 

The Sun, Moon, and planets often occult deep-sky objects. To keep the 
occulted objects visible, select the Non-stellar Options command from the 
View menu and mark the “Translucent Sun and Moon” checkbox.  
 
Non-stellar objects (galaxies, nebulae, and so on) can also cover stars 
“behind” them. Select the Non-Stellar Options command from the View 
menu. Set Non-stellar fill “Style” to Outline Only. The outline of the object 
remains, but it is no longer filled, and the stars (or other objects) become 
visible. 
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The Milky Way and the Magellanic Clouds 

The Milky Way (our galaxy) is displayed as a photograph or draw as a complex 
polygon that can cover a significant portion of the Virtual Sky. Keeping track 
of its boundaries in all cases would consume too many resources. It was 
therefore decided not to identify the Milky Way when you click inside it. At 
narrow fields of view, the Milky Way’s boundaries are not usually visible and 
the polygon forms a solid background color. This is potentially confusing (”Is 
that the Milky Way or a nebula?”), so the Milky Way is not displayed at fields 
of view below 50°. 
 
The Magellanic Clouds (the two smaller galaxies “attending” our galaxy) are 
large, complex objects. It was decided to treat them differently from other 
deep-space objects. Neither Magellanic Cloud is indexed by name. The Small 
Magellanic Cloud has its own polygon object and is easy to spot in the Virtual 
Sky – it’s located at a right ascension of about 1h, not far from the south 
celestial pole. To locate it with the Find command, enter one of the SMC’s 
catalog numbers (such as NGC 292). The angle of view needs to be about 7° 
for all of the SMC to be displayed. 
 
The Large Magellanic Cloud is not shown as a specific object. To display the 
region in which it’s located, search for NGC 1965 (the LMC’s catalog 
number), or the name or catalog number of one of its components (the 
Tarantula Nebula, for example). At field widths of 20° or less, the LMC 
appears as a group of about 30 star clusters and nebulae. 

Showing Object Information 

Mark the “Object Information” option to display the Object Information dialog 
box for the selected object. 
 

 
 

Figure 13 – Object Information option on 
the Find dialog box. 
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Chapter 6 Display Modes and Options 

Real Mode Options (View menu) 

TheSky6 can render realistic views of your observing site using Real Mode 
options. The customizable photographic horizon, photographic Milky Way, 
horizon glow, and brightness halos surrounding the Sun and Moon might 
make you wonder, “Is it live, or is it Memorex™?” 
 
The Real Mode Options dialog box controls which Real Mode options are 
displayed, and the properties of each option. 
 

 
Figure 14 – Real Mode Options dialog box 

 
 Constellation Drawings Displays or hides the detailed sketches of 

the constellations. 
 Horizon Image Turns on or off the photographic horizon. 
 Horizon Glow When you look at the sky near the horizon, you’re 

looking through a greater portion of the Earth’s atmosphere. Plus 
smog and light pollution cause a distinct dimming effect “down in the 
muck.” The Horizon Glow option attempts to mimic these effects. 

 Milky Way Picture This option displays or hides the color 
photograph of our Milky Way galaxy. 

 Moon Halo The bright Moon at night obscures the visibility of 
surrounding objects. The Moon halo simulates this phenomenon. 

 Sky Background TheSky6 automatically controls the color of the sky 
background, such as at sunrise and sunset. This option overrides the 
automatic sky background color. 

 Sun Halo The bright Sun obscures the visibility of surrounding 
objects.  The Sun Halo option simulates this phenomenon during 
daytime hours.  
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Color Adjustment 

The intensity of the colors in real mode pictures and in the horizon glow can 
be manually adjusted using Red, Green and Blue slider controls. 
 
Manual 

Use this option to override the automatic color control.  
 
Intensity 

Clear this option to allow each color slider (Red, Green, and Blue) to be 
adjusted individually. 
 
Preview  

Click the Preview option to apply your changes to the Virtual Sky without 
closing the Real Mode Options dialog box. 
 
Advanced Options 

The Advanced Options gives access to properties of the real mode options. 
 
Constellation Drawings 

There are no advanced options for the constellation drawings. 
 
Horizon Image 

 Azimuth offset (degrees) 
Enter the azimuth offset for the "right edge" of the photograph. This 
allows you to align the horizon picture with the actual location. 

 Alt Ascend (degs)  
Enter the height (or altitude ascension) for the horizon photograph. This 
is the degrees above the local horizon that the photograph is displayed. 

 Alt Descend (degs)  
Enter the degrees below the local horizon that the photograph is 
displayed. 

 Shape Static Horizon  
Mark this option to use the selected photograph as a fixed horizon. This 
means that the horizon photograph remains the same regardless of where 
you're looking. Use this option if you have a slower computer and really 
want to see a photographic horizon. 

 Apply and Save  
Click this button to update the Virtual Sky using the selected photograph 
and save these settings. 

 Browse  
Click this button to select a photograph to display for your horizon. 
TheSky6 comes with several different horizons. These are saved in the 
Data\Pictures\Horizons folder. The default extension for TheSky6's 
horizon files is .horizon. 
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Horizon Glow 

 Alt Ascend (degs)  
Enter the height (or altitude ascension) for the horizon glow. This is the 
degrees above the local horizon that the horizon glow is displayed. 

 Alt Descend (degs)  
Enter the degrees below the local horizon that the horizon glow is 
displayed. 

 Apply and Save  
Click this button to update the Virtual Sky and save the current horizon 
glow settings. 

 
Milky Way Picture 

There are no advanced options for the Milky Way picture. 
 
Moon Halo 

 Halo Size (Degs)  
Enter the diameter of the Moon's halo, in degrees. Note that the Moon's 
halo is only displayed during nighttime hours (specifically, after 
astronomical twilight) in TheSky6. 

 
Sky Background 

There are no advanced settings for this option. 
 
Sun Halo 

 Halo Size (Degs)  
Enter the diameter of the Sun's halo, in degrees. 

Optimizing TheSky6’s Drawing Speed 

Drawing the photographic horizon, Milky Way, and the horizon glow can be 
taxing on slower computers. Disabling these features will improve TheSky6’s 
performance. To do so, select the Real Mode Options command on the View 
menu, and then clear the Horizon Image, Horizon Glow, and Milky Way 
Picture options. Click the Close button to apply the changes. 

Display Explorer (View menu) 

The Display Explorer allows you access to virtually every display option in 
TheSky6 via tree-list control. Press CONTROL+SHIFT+D to show or hide the Display 
Explorer window, or click the Display Explorer button on the View toolbar.  
The changes made to options in this window are applied immediately to the 
Virtual Sky. 
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Figure 15 – Display Explorer dialog box. 

 
The Display Explorer’s tree-list contains eight main categories of objects, or 
root objects. Navigate to the category of object you want to show, and then 
expand the tree list to access the desired option. 
 
Keyboard Access to Display Explorer Options 

If you know the name of the option or object you’re after, type it into to the 
Go To text box. For example, suppose you want to access options for 
Satellites. Entering the text sate, for example, jumps to the “Solar System” 
Satellite node. Press the TAB key to access options for displaying Satellites. 
 
− Stellar 

 Star 
 Display Properties Click on the small icon that 

looks like a dialog box to edit the display properties of 
stars using the Display Properties dialog box. 

 Stellar Options Click on the small icon that looks 
like a dialog box to edit stellar options from the 
Stellar Options dialog box. 

 Labels Expand the labels node to show three 
different classifications of star labels: Common Name, 
Bayer and Flamsteed. Click any option to activate it. 

 Variable Star 
 Display Properties Click on the small icon that 

looks like a dialog box to edit the display properties of 
variable stars using the Display Properties dialog box. 

 Suspected Variable 
 Display Properties Click on the small icon that 

looks like a dialog box to edit the display properties of 
suspected variable stars using the Display Properties 
dialog box. 

 Double Star 
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 Display Properties Click on the small icon that 
looks like a dialog box to edit the display properties of 
double stars using the Display Properties dialog box. 

 Non-stellar GSC 
 Display Properties Click on the small icon that 

looks like a dialog box to edit the display properties of 
non-stellar objects in the Guide Star Catalog using 
the Display Properties dialog box. 

− Non-Stellar 
 Galactic 

 Galaxy 
 Display Properties Click on the small icon that 

looks like a dialog box to edit the display properties of 
galaxies using the Display Properties dialog box. 

 Type C Galaxy 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of type C 
galaxies using the Display Properties dialog box. 

 Elliptical Galaxy 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of 
elliptical galaxies using the Display Properties dialog 
box. 

 Lenticular Galaxy 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of 
lenticular (or lens-shaped) galaxies using the Display 
Properties dialog box. 

 Spiral Galaxy 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of spiral 
galaxies using the Display Properties dialog box. 

 Irregular Galaxy 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of spiral 
galaxies using the Display Properties dialog box. 

 Cluster of Galaxies 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of 
Clusters of Galaxies using the Display Properties 
dialog box. 

 Display Properties Click on the small icon that looks like a 
dialog box to edit the display properties of All Galaxies using 
the Display Properties dialog box.  The changes made will 
apply to all of the galaxies 
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 Clusters 
 Open Cluster 

 Display Properties Click on the small icon that looks 
like a dialog box to edit the display properties of Open 
Clusters using the Display Properties dialog box.  

 Globular Cluster 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of 
Globular Clusters using the Display Properties dialog 
box. 

 Cluster + Nebulosity  
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of the 
objects that are clusters and have nebulosity using the 
Display Properties dialog box. 

 Nebulae 
 Nebula 

 Display Properties Click on the small icon that looks 
like a dialog box to edit the display properties of Nebula 
using the Display Properties dialog box.  

 Bright Nebula 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of Bright 
Nebula using the Display Properties dialog box. 

 Dark Nebula 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of Dark 
Nebula using the Display Properties dialog box. 

 Planetary Nebula 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of 
Planetary Nebula using the Display Properties dialog 
box.  

 Other Sources 
 Quasar 

 Display Properties Click on the small icon that looks 
like a dialog box to edit the display properties of Quasar 
using the Display Properties dialog box.  

 X-Ray Source 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of X-Ray 
Source using the Display Properties dialog box.  

 Radio Source 
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 Display Properties Click on the small icon that looks 
like a dialog box to edit the display properties of Radio 
Source using the Display Properties dialog box. 

  NGC Probable Star 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of NGC 
Probable Stars using the Display Properties dialog box. 

 Other NGC 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of other 
NGC using the Display Properties dialog box.  

 Mixed Deep Sky 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of Mixed 
Deep Sky using the Display Properties dialog box. 

 Labels Expand the labels node to show the two different 
classifications of non-stellar object labels: Common Name or 
Messier. Click either option to activate it (page 113). 

− Solar System 
 Planets 

 Mercury 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of 
Mercury using the Display Properties dialog box. 

 Venus 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of Venus 
using the Display Properties dialog box. 

 Earth  
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of Earth 
using the Display Properties dialog box. 

 Mars 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of Mars 
using the Display Properties dialog box.  

 Jupiter 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of Jupiter 
labels using the Display Properties dialog box. 

 Saturn 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of Saturn 
using the Display Properties dialog box. 

 Uranus 
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 Display Properties Click on the small icon that looks 
like a dialog box to edit the display properties of 
Uranus using the Display Properties dialog box. 

 Neptune 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of 
Neptune using the Display Properties dialog box. 

 Pluto 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of Pluto 
using the Display Properties dialog box. 

 Labels Expand the labels node to turn on or off the 
planet labels.  Click the option to activate it.  Planets 
cannot be individually labeled. 

 Sun 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of the sun 
using the Display Properties dialog box. 

 Moon 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of the moon 
using the Display Properties dialog box. 

 Moon Viewer Click on the small icon that looks like a 
dialog box to display or hide the Moon Viewer window. 

 Outline Features Mark this option to show or hide 
circles that show the Moon’s major features. 

 Label Features Mark this option to show or hide labels 
of the Moon’s major features. 

 Show Grid Mark this option to show or hide the moon’s 
grid. 

 Earth’s Shadow The shadow cast by the earth is 
represented as an object on the Virtual Sky and can be most 
easily seen during a lunar eclipse. It consists of two circles – 
called the Umbra and Penumbra. Click this option to show or 
hide this “object.” 

 Comet 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of comets 
using the Display Properties dialog box. (page 117). 

 Comets Click on the small icon that looks like a dialog 
box to show the Comets and Minor Planets dialog box to 
import and display comets (page 117). 

 Common Name Click this option to show or hide the 
common name label for comets (page 117). 



Chapter 6 Display Modes and Options 
 

73 

 Magnitude Click this option to include or remove comet 
magnitudes in the comet label (page 117). 

 Minor Planet 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of comets 
using the Display Properties dialog box. (page 117). 

 Minor Planets Click on the small icon that looks like a 
dialog box to show the Comets and Minor Planets dialog 
box to import and display minor planets (page 117). 

 Labels Expand the minor planet labels node to specify the 
elements of minor planet labels. They can include the 
satellite’s identifier (ID), range, in meters, and 
longitude/latitude.  Click the option to activate it (page 
117). 

 Extended Minor Planet 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of comets 
using the Display Properties dialog box (page 117). 

 Minor Planets dialog box Click on the small icon that 
looks like a dialog box to show the Comets and Minor 
Planets dialog box (page 117). 

 Show 24-hour path Mark this option to draw lines that 
show where the extended minor planet will travel during 
the next 24-hour period. 

 Show All at All Zoom Levels By default, only a limited 
number of extended minor planets are shown on the 
Virtual Sky to avoid screen clutter. This option overrides 
the auto-limiting and shows all extended minor planets at 
all fields. 

 Satellite 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of satellites 
using the Display Properties dialog box (page 117). 

 Satellites Click on the small icon that looks like a dialog 
box to display the Satellites dialog box (page 117). 

 Labels Expand the satellite labels node to specify the 
elements of satellite labels. The can include the minor 
planet’s identifier (ID), equatorial coordinates, magnitude 
and number.  Click the option to activate it.  Planets 
cannot be individually labeled (page 117). 

 Reference Objects 
 Reference Lines 

 Constellation Figures 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of 
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constellation figures using the Display Properties dialog 
box (page 98). 

 Labels Expand the constellation figures node to specify 
the elements of constellation figure labels. The can 
include the constellation’s name, abbreviation, and 
genitive form.  Click the option to activate it.   

 Constellation Boundary  
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of 
constellation boundaries using the Display Properties 
dialog box (page 98). 

 Ecliptic 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of the 
ecliptic using the Display Properties dialog box (page 99). 

 Horizon Grid 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of the 
horizon grid using the Display Properties dialog box (page 
99.) 

 Horizon Lines 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of the 
horizon lines using the Display Properties dialog box. 
(page 99). 

 Meridian 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of the local 
meridian line using the Display Properties dialog box 
(page 99). 

 Equatorial Grid 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of the 
equatorial grid using the Display Properties dialog box. 
(page 98). 

 Galactic Equator 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of the 
galactic equator using the Display Properties dialog box 
(page 98). 

 Milky Way (solid) 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of the Milky 
Way polygon using the Display Properties dialog box 
(page 98). 
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 Reference Line 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of the user-
defined reference lines using the Display Properties 
dialog box (page 135). 

 Telescope Limit 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of telescope 
limit lines using the Display Properties dialog box (page 
101).  

 Field of View Indicator 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of Field of 
View Indicators (FOVIs) using the Display Properties 
dialog box (page 104). 

 North/East Indicator 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of the 
north/east direction indicator using the Display Properties 
dialog box.  

 Pole Up Horizon 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of “Pole Up 
Horizon” option using the Display Properties dialog box 
(page 101). 

 Query Path 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of the Data 
Wizard’s query paths using the Display Properties dialog 
box (page 149). 

 Query Labels 
 Click on the small icon that looks like a dialog box to edit 

the display properties of the Data Wizard’s query labels 
using the Display Properties dialog box (page 149). 

 Object Paths 
 Click on the small icon that looks like a dialog box to edit 

the display properties of the object path lines using the 
Display Properties dialog box (page 197). 

 Mosaic Lines 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of mosaic 
lines using the Display Properties dialog box (page 214). 

 Proper Motion Vectors 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of proper 
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motion vectors using the Display Properties dialog box 
(page 85). 

 Minor Planet Vectors 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of minor 
planet vectors using the Display Properties dialog box 
(page 117). 

 Other Reference 
 Image 

 Display Properties Click on the small icon that looks 
like a dialog box to edit the display properties of the 
“image” symbol using the Display Properties dialog box. 
Image symbols mark objects that have pictures (page 
179). 

 Video 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of the 
“video” symbol using the Display Properties dialog box 
(page 179). 

 Sound 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of the 
“sound” symbol using the Display Properties dialog box. 
(Page 179.) 

 Notes 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of the 
“notes” symbol using the Display Properties dialog box. 
(page 179). 

 Reference Point 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of user-
defined reference points using the Display Properties 
dialog box (page 135). 

 Sky Chart 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of the Sky 
Chart object using the Display Properties dialog box.  

 Chart Legend 
 Display Properties Click on the small icon that looks 

like a dialog box to edit the display properties of the 
printed chart legend using the Display Properties dialog 
box (page 141). 

 User-Defined Object Types TheSky6 uses sixty different object 
types to represent stars, open clusters, variable stars, and so on. 
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There are an additional twenty user-definable object types for which 
you can specify the name, graphical symbol, font, line and fill 
properties for object type that are not included in the default set. 

 Type 1-20 Use these twenty object types to define your own 
celestial object types. 

 Display Properties Click on the small icon that looks like a 
dialog box to edit the display properties of the user-defined 
object types.  

 My Field of View Indicators  
 Field of View Indicators dialog box Click on the small 

icon that looks like a dialog box to display the Field of View 
Indicators dialog box. (page 104). 

 Display Properties Click on the small icon that looks like a 
dialog box to edit the display properties of Field of View 
Indicators using the Display Properties dialog box. 

 This node lists the Field of View Indicators you’ve defined 
(page 104). 

 User-Defined Data 
 User-Defined Data dialog box Click on the small icon that 

looks like a dialog box to display the User-Defined Data 
dialog box (page 135). 

− Real Mode Options 
 Options dialog box Click on the small icon that looks like a 

dialog box to display the Real Mode Options dialog box to 
edit the properties of Real Mode objects (page 65). 

 Constellation Drawings Show or hide constellation 
drawings. 

 Horizon Image Show or hide the horizon photograph. 
 Horizon Glow Show or hide the horizon glow. 
 Milky Way Picture Show or hide the photograph Milky 

Way. 
 Moon Halo Show or hide the Moon’s halo. 
 Sky Background Show or hide the sky background color. 
 Sun Halo Show or hide the Sun’s halo. 

− Sky Databases (SDBs) 
 Add/Remove Click on the small icon that looks like a dialog 

box to display the Sky Database Manager dialog box to add 
or remove Sky Databases (page 159). 

 Anglo Australian Images This Sky Database is 
automatically loaded each time TheSky6 is launched. It 
cannot be removed from the Sky Database Manager. 
 Equatorial Coordinates Mark this option to display a 

label containing the right ascension and declination 
position of pictures from the Anglo Australian 
Observatory. 
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 Database Properties 
 Type Shows the celestial object type displayed in this 
Sky Database. 
 Object Count Displays the number of objects in the 
Sky Database. 
 Class Shows the class of objects (Objects/Points, 
Labels, or Lines/Polygons) displayed in this Sky 
Database. 
 Optimized “Yes” indicates that the plotting speed for 
this Sky Database is optimal. 
 Load to memory “Yes” indicates that this database is 
loaded into the computer’s internal memory, rather 
than being accessed from the disk drive. 
 SDB file Complete file name, including the path, to the 
Sky Database file. 
 Text file Complete file name, including the path, to the 
ASCII text file that contains database-specific 
information. 

 Solar System Pictures This Sky Database is automatically 
loaded each time TheSky6 is launched. It cannot be removed 
from the Sky Database Manager. 
 Equatorial Coordinates Mark this option to display a 

label containing the right ascension and declination 
position of solar system pictures. 

 Database Properties 
 Type Shows the celestial object type displayed in this 
Sky Database. 
 Object Count Displays the number of objects in the 
Sky Database. 
 Class Shows the class of objects (Objects/Points, 
Labels, or Lines/Polygons) displayed in this Sky 
Database. 
 Optimized “Yes” indicates that the plotting speed for 
this Sky Database is optimal. 
 Load to memory “Yes” indicates that this database is 
loaded into the computer’s internal memory, rather 
than being accessed from the disk drive. 
 SDB file Complete file name, including the path, to the 
Sky Database file. 
 Text file Complete file name, including the path, to the 
ASCII text file that contains database-specific 
information. 

 Solar System Notes This Sky Database is automatically 
loaded each time TheSky6 is launched. It cannot be removed 
from the Sky Database Manager.  
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 Equatorial Coordinates Mark this option to display a 
label containing the right ascension and declination 
position of notes on solar system objects. 

 Database Properties 
 Type Shows the celestial object type displayed in this 
Sky Database. 
 Object Count Displays the number of objects in the 
Sky Database. 
 Class Shows the class of objects (Objects/Points, 
Labels, or Lines/Polygons) displayed in this Sky 
Database. 
 Optimized “Yes” indicates that the plotting speed for 
this Sky Database is optimal. 
 Load to memory “Yes” indicates that this database is 
loaded into the computer’s internal memory, rather 
than being accessed from the disk drive. 
 SDB file Complete file name, including the path, to the 
Sky Database file. 
 Text file Complete file name, including the path, to the 
ASCII text file that contains database-specific 
information. 

− Core Databases 
 Stellar 

 GSC Show or hide stars from the Guide Star Catalog. 
 Hipparcos/Tycho Show or hide stars from the Hipparcos 

and Tycho star catalogs. 
 USNO B (subset) Show or hide stars from a subset of 

the USNO B catalog. This catalog fills in missing portions 
of the UCAC2 catalog above about 40 degrees declination. 

 UCAC2 Show or hide stars from the UCAC2 catalog. 
 USNO A2.0/SA2.0 Show or hide stars from the USNO 

A2.0/SA2.0. 
 USNO B (full) Show or hide stars from the complete 

USNO B stellar catalog. 
 Extended Labels This node contains options to format 
extended labels for stars. 
 ID Show or hide the catalog identifier for star’s 

extended label (page 114). 
 Equatorial Coordinates Show or hide the stars’ 

equatorial coordinates on extended labels (page 114). 
 Magnitude Show or hide the stars’ magnitude on 

extended labels (page 114). 
 SAO ID Show or hide the SAO catalog identifier on 

extended labels (SAO catalog stars only, page 114). 
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 Spectral Show or hide spectral class on extended 
labels (page 114). 

 Position Error Show or hide star’s position error on 
extended labels. 

 Distance Show or hide star’s distance from Earth, in 
light years, on extended labels. 

 Proper motion Show or hide star’s proper motion on 
extended labels. 

 B, V magnitude Show or hide star’s B and V 
magnitudes on extended labels. 

 Hipparcos ID Show or hide star’s Hipparcos identifier 
on extended labels. 

 Non-stellar 
 PGC This option shows or hides galaxies from the 

Principle Catalog of Galaxies. 
 Extended Labels Lists the extended labeling options 
for this catalog. 
 DB Information Shows the properties of this catalog. 

 NGC This option shows or hides objects from the 
Revised New General Catalog. 

 Extended Labels Lists the extended labeling options 
for this catalog. 
 DB Information Shows the properties of this catalog. 

 IC This option shows or hides objects from the Index 
Catalog. 

 Extended Labels Lists the extended labeling options 
for this catalog. 
 DB Information Shows the properties of this catalog. 

 PLN This option shows or hides objects from the 
Planetary Nebulae catalog. 

 Extended Labels Lists the extended labeling options 
for this catalog. 
 DB Information Shows the properties of this catalog. 

 Lorenzin This option shows or hides objects from the 
Tomm Lorenzin catalog. 

 Extended Labels Lists the extended labeling options 
for this catalog. 
 DB Information Shows the properties of this catalog. 

 SAC This option shows or hides objects from the Saguaro 
Astronomy Club Deep Space Object catalog. 

 Extended Labels Lists the extended labeling options 
for this catalog. 
 DB Information Shows the properties of this catalog. 

 Herschell This option shows or hides objects from the 
Herschel 400 catalog. 
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 Extended Labels Lists the extended labeling options 
for this catalog. 
 DB Information Shows the properties of this catalog. 

 Caldwell This option shows or hides objects from the 
Caldwell catalog. 

 Extended Labels Lists the extended labeling options 
for this catalog. 
 DB Information Shows the properties of this catalog. 

 Messier (M) This option shows or hides objects from the 
Messier catalog. 

 Extended Labels Lists the extended labeling options 
for this catalog. 
 DB Information Shows the properties of this catalog. 

− Image Groups  
 Constellation Drawings Turn on or off the pictures of 

constellations (page 182). 
 Andromeda-Vulpecula Lists the 88 constellations. 

 Non-stellar color pictures Turn or off pictures from the 
non-stellar color pictures image group (page 182). 

Full Screen (View menu) 

 
The Full Screen command maximizes the Virtual Sky, and hides the title bar, 
the menus, the window frame, the Status Bar and optionally the toolbars. 
(You can also click the Full Screen button on the View toolbar, or press 
SPACE.)  
 
The Full Screen button remains, floating in a toolbar at the upper left. To 
remove this toolbar, click the X button. 
 
If you want the toolbars to remain, mark the “Show in Full Screen Mode” 
checkbox in the Toolbars dialog box. To access the menus in Full Screen, 
press ALT, then the accelerator key for the desired menu. Press RIGHT or LEFT 

to move to a different menu. 
 
To return to the regular display, click the floating Full Screen button. Or 
select the Full screen command from the View menu. (Press ALT, V to display 
the View menu.) Or press SPACE a second time. (Whew!) 

Chart Mode (View menu) 

Chart Mode formats the display to look more like what you would see in a 
book of star charts (such as Wil Tirion’s Sky Atlas 2000.0™), or how a printed 
sky chart from TheSky6 is going to look.  
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Figure 16 – Chart Mode screen. 

 
 The sky is white, not black. 
 The Sun, Moon, and planets are marked with their astrological signs. 
 Stars are colored circles showing the star’s spectral class). 
 Nebulae have irregular black outlines. 
 The Milky Way is gray. 
 The Real Mode photographs (horizon, Milky Way, etc.) are not shown. 
 Sun, Moon and horizon glow are turned off. 
 
Chart Mode uses the same symbol set TheSky6 uses for printing. You can 
change the colors of these symbols – and substitute new symbols, in many 
cases – in the Display Properties dialog box. 

Projections (View menu) 

The Projections dialog box selects the projection used by the Virtual Sky. Six 
projections are available. They are described starting on page 21. 
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All projections are available at field widths greater than 50°. At field widths of 
50° or less, orthographic is the only projection available. It is used with the 
Image Link function (page 189) to match the projection of photographic and 
CCD images, which are inherently orthographic. 

Mirror Image / Inverting the Display (View menu) 

The Mirror Image command reverses the Virtual Sky, left-to-right. This 
shows the sky as you would see it through a telescope with an erect but 
laterally reversed image. The Virtual Sky scrolls in the opposite direction 
when you press the LEFT and RIGHT arrow keys. There is no specific command 
to invert the display. However, the Rotate Tool (page 24) can be used to turn 
it upside-down (which also flips it left-for-right). 

Stellar Options (View menu) 

The Stellar Options dialog box can be selected from the View menu, or by 
clicking the Stellar Options button in the View toolbar. It has two tabbed 
sheets. The Stellar Appearance sheet controls the size, color, contrast, density, 
and gradient of the Virtual Sky’s stars. The Catalogs/Astrometry sheet 
controls which databases to use and proper motion computations.  

Stellar Appearance 

Star brightness is shown by size – brighter stars are larger. This is the way 
stars look on photographic plates – brighter stars produce larger images. But 
a computer monitor – unlike a photograph – can display only a finite number 
of star sizes. Each size has to represent a range of magnitudes.  
 
For example, the largest star image might represent magnitudes of 1.0 and 
brighter, the second largest image magnitudes of 1.0 to 2.0, and so on. The 
Brightness & Contrast settings control the way star magnitudes are mapped 
into the size of star images. 
 
The Fainter/Brighter slider controls which star size each magnitude is 
mapped into. 
 
 Increasing the brightness setting moves each star (except the brightest) 

into the next-higher star size. All but the brightest stars get larger. 
 Decreasing the brightness setting moves each star (except the dimmest) 

into the next-lower star size. All but the dimmest stars get smaller. Very 
high or very low Brightness settings reduce the range of star sizes. The 
stars vary less in size, and look more like what you see in the real sky. 
Contrast sets the range of magnitudes mapped into each star size.  
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The More/Less Contrast slider controls the relative sizes of stars. 
 
 A low Contrast setting maps a wide range of magnitudes into each star 

size, producing little variation in star size. You might find this looks more 
like the “real” sky and less like a photograph.  

 A high Contrast setting maps a narrow range of magnitudes into each star 
size. This produces a wide variation in star size. 

 
The More/Fewer Stars slider controls the number of stars that appear. You 
may want to decrease the number of stars in crowded star fields or increase 
the density when looking for a suitable guide star in more sparse star fields. 
 
The More/Less Spectral Color slider adjusts the intensity of the stars’ 
spectral color. Drag the slider to the left to fill stars white.  
 
The More Gradient/More Solid slider adjusts how stars’ are drawn. More 
gradient draws the stars with a bright central region, with a “soft” outer edge.  
 
The Narrow Field Adjustments provide better control of the stars’ brightness 
and contrast settings when the field width is less than ten degrees. The 
relative brightness and contrast can be set to any value between –10 and +10. 
 
It’s easy to experiment with these settings. As you drag the sliders, the stars 
in the sample box are immediately redrawn. 
 
When you find settings you like, click Apply to preview the display without 
exiting. Click OK to close the dialog box and keep the new settings. Click 
Cancel to discard the changes, even if you previewed them with Apply. 
Brightness and contrast changes last through the current session. To make 
the changes permanent, save the current Sky Document. 

Catalogs/Astrometry 

The Catalogs/Astrometry sheet controls the display of the core stellar 
catalogs proper motion calculations. TheSky6 can display objects from 
standard star charting databases, including the Hubble Guide Star Catalog and 
the Hipparcos-Tycho catalogs. 
 

Charting Databases  

The Hipparcos-Tycho or Guide Star catalogs can be turned off at fields of 
view below 50° by clearing the corresponding checkbox. 
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Astrometry Databases 

CCD imagers use the UCAC, and USNO stellar databases for accurate 
astrometric measurements. The UCAC is an extremely accurate catalog that 
permits the calculation of astrometric positions of well under one arcsecond. 
At the current time, it contains stars for the entire celestial sphere up to 
about 40 degrees declination.  
 
In its raw format, the USNO B1.0 includes positional information on about 1 
billion stars. It occupies about 80 GB (yes, gigabytes!) of disc space and is 
distributed separately. TheSky6 Professional Edition uses an optimized subset 
of this database to cover the mission regions of the UCAC2 stellar catalog. 
 
The USNO A 2.0 10 CD-ROM set and the USNO SA 2.0 single CD-ROM 
database are also supported. These databases are available for download on 
the Internet and are not provided with TheSky6. 
 

Proper Motion 

The Hipparcos-Tycho catalogs contain information about the proper motion of 
stars – their absolute motion in the sky, independent of precession. Most 
objects with a non-zero proper motion are stars within a few hundred light 
years whose movement has a significant component at right angles to the line 
connecting them with our Solar System.  
 

 
Figure 17 – Proper motion vectors. 
 
When the Compute checkbox is marked, proper motion is computed and 
applied to the Virtual Sky. The stars appear at their correct positions 
(including precession) for the current date.  
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Entering a non-zero time interval between -10,000 and 10,000 years in the 
Vector Length box computes the proper motion for that interval and displays 
it as a red line pointing from the star in the appropriate direction. 
 
To determine the angular displacement of a star’s proper motion, click on the 
star, and then click on the end of the displacement vector. The Angular 
Separation value in the Object Information dialog box is the magnitude of the 
proper motion. 

Hint 

TheSky6 uses the “Line” display properties for Star’s for the color of the 
proper motion vectors. Make sure that the color of the line is something 
other than “black” or the vectors will be really hard to see! 

Halos on Bright Stars 

Mark the “Halos on Bright Stars” option to show a brighter “halo” region 
surrounding bright stars (approximately magnitude 4 and brighter).  

Red in Night Vision Mode 

When Night Vision mode is selected, the stars normally remain white (or 
keep their spectral colors). Marking this checkbox turns the stars red in 
Night Vision mode. All non-stellar objects keep their original colors. 

Preview  

Changes to options in the Stellar Appearance sheet can be applied to the 
Virtual Sky by marking the Preview option. 
 

Non-Stellar Options (View Menu) 

The Non-Stellar Options dialog box can be selected from the View menu. It 
controls how non-stellar objects are filled, and displayed on the Virtual Sky. 
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Non-Stellar Fill 

The Style list box controls the fill style for non-stellar objects. Extended 
objects such as galaxies can be filled using the object’s fill color, or as an 
outlined, transparent ellipse, or an outlined ellipse when a photograph has 
been overlaid on the Virtual Sky for an Image Link (page 189). The More 
Gradient/Solid slider settings apply to filled ellipses only. The higher the 
gradient setting, the softer the edges of the filled ellipse. 
 
Style 

This setting controls the way galaxies and most nebulae are drawn. 
 
 Filled Both the object’s Line and Fill color are drawn. 
 Outline only Only the object’s Line color is drawn. The object is not 

filled. This setting produces a slightly less-cluttered display. It allows 
objects that would otherwise be hidden to be visible. 

 Outline when Image Link image is present When an Image Link 
image overlays the object, and Image Link Display is set to Opaque, the 
Fill is not drawn, so it doesn’t hide the image. Removing the image 
restores the Fill color. 

In-Place Images 

Mark the “Plot Digitized Sky Survey thumbnail images of NGC, IC, PGC, and 
PLN objects” to display “in-place” thumbnail photographs from the Digitized 
Sky Survey for objects in the New General Catalog, Index Catalog and the 
Planetary Nebula catalog.  
 



TheSky6 
 

88 

The “Clip images to catalog shape” option uses the size and orientation of 
cataloged objects to mask the in place photograph. The “Draw Image 
Borders” option draws an outline around the edge of the photograph.  
 
Click the “Update image files” button if you wish to replace the existing 
thumbnail image with your own. See “Creating Your Own Image Databases” 
for more information (page 182). 

Translucent Sun and Moon 

When this checkbox is marked, objects behind the Sun, Moon, and planets 
become visible. You can identify them by clicking on them.  

Plot Overlapping Catalog Entries  

The IC and NGC catalogs are subsets of the PGC catalog. If this checkbox is 
clear, only one image is plotted for each object, using the PGC coordinates. 
 
If you want to compare the data from both the PGC and the NGC or IC 
catalogs, mark the “Plot overlapping catalog entries with NGC and IC 
catalogs” checkbox. 

Night Vision Mode (View menu) 

Selecting Night Vision Mode command from the View menu (or clicking the 
Night Vision button) redraws the display in red, to minimize loss of dark 
adaptation. 
 
The title bar, toolbars, menus, icons and Status Bar all turn red. To make the 
stars red, mark the “Red in Night Vision Mode” checkbox on the Stellar 
Appearance sheet of the View menu’s Stellar Options dialog box. All non-
stellar objects keep their original colors.  

Windows XP Users 

Windows XP controls system-wide screen colors through the Control Panel 
application and Themes. When the Night Vision Mode command is enabled 
under Windows XP, and the computer is currently using a theme, TheSky6 
saves the current theme and automatically loads the “TheSky6 Night Vision 
Mode” theme. This operation normally requires about 10-15 seconds. Some 
XP users report much longer Theme changing times (around 1 minute).  
 
 The time required to switch between themes is a function of the XP 

operating system and the speed of your computer, not TheSky6.  (Change 
the current theme from using the Display application in the Control Panel 
to verify the time required for XP to switch themes.) 
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 TheSky6 must reload the previous theme file when exiting Night Vision 
Mode. If the text “(Modified)” appears next to a theme in the Theme tab 
of the Display Properties window, the theme has not been saved, and 
TheSky6 therefore cannot restore it (see Figure 18). Click Save As button 
and then click Save to write these changes to disk before continuing. 

 

 
Figure 18 – The Theme tab in the Control Panel's Display Properties window. 

 
If you’re using a non-XP operating system, switching to and from Night 
Vision Mode changes Windows’ default system colors. Make sure that you 
configure your default system colors using the Start | Settings | Control 
Panel | Display application. 

Halt Update (ESC) 

TheSky6 computes the position of objects on the Virtual Sky before redrawing 
it. Press ESC at any time to halt the calculations. Only those objects for which 
TheSky6 has computed positions are displayed, and program control is 
returned to you. 
 
“Why would I want to use this feature?” Well, you might not like a change 
you made, and don’t want to wait for the screen to be fully redrawn. You can 
also use it to speed up a sequence of display changes. You don’t have to wait 
for one change to be completed before selecting the next. 
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Redraw Screen (View menu) 

The Redraw Screen command can be used at any time to force TheSky6 to 
update the screen. It’s useful if you interrupt a screen update. You can also 
press F5 (F5 or SHIFT+R). 

Update Solar System (Tools menu) 

If the “Use computer’s clock” button on the Time dialog box is pressed, 
TheSky6 periodically updates the positions of the objects in the Virtual Sky. 
The Screen Update Frequency controls the interval between updates on 
the Time Options dialog box (page 19).  
 
The default frequency is every 15 minutes, for both deep space and solar 
system objects. There are several ways to force TheSky6 to re-compute the 
planets’ positions without waiting for an automatic update. 
 
 Select the Update Solar System command from the Tools menu or press 

F5. 
 Change the date or time. 
 Change the Location. 
 Add comets, minor planets or satellites. 

Options (Tools menu) 

The Options dialog box controls whether or not you’ll be prompted to save a 
Sky Document when exiting TheSky6 and controls the display of the 
hourglass (or “wait”) cursor during screen refreshes.  
 

 
Figure 19 – Options dialog box. 

 
Clear the “Prompt to Save Modified Documents” option so that TheSky6 does 
not ask you to save changes when exiting. 
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Figure 20 – Exit prompt dialog box. 

Precessing Equatorial Coordinates 

Because the Earth wobbles on its axis (“precesses”), the celestial coordinates 
(RA-Dec coordinates) of all sky objects change slowly with time. The 
coordinates in most of TheSky6’s databases are for Epoch 2000.0 – the 
position of objects at 12:00 hours UTC on January 1, 2000. The exact position 
of objects is significant when predicting eclipses and conjunctions, and when 
using TheSky6’s telescope-control software to locate faint objects. The 
database coordinates are therefore recomputed for the time and date shown in 
the Time dialog box. (These – and the Epoch 2000.0 coordinates – are shown 
in the Object Information box.) Precession corrections are always applied for 
maximum plotting and slewing accuracy. The approximate precession 
correction () is given by the following equations. 
 
RA is in seconds of time per year. Dec is in arcseconds per year. 
 
RA = 3.075 + 1.366 sin tan  (Epoch 2000.0)
Dec = 20.041 cos 
 
Although a full cycle takes about 25,000 years, even a few decades can 
introduce significant shift. Try placing Polaris at the center of the display, 
with the Equatorial Grid displayed and a field of view of 10°. Then change the 
date by 50 years. You might be surprised at how much Polaris moves.  

Computer Time (Tools menu) 

The Computer Time command opens a window showing the date, time, local 
sidereal time (LST), universal time (UT), and the Julian date (JD). 
 
When the “Use Computer’s Clock” button (page 15) is pressed, these values 
are updated in real time. 

Toolbars (View menu) 

TheSky6 has seven toolbars. By default they’re “docked” against the top of 
the Virtual Sky, but you can reposition them. If the toolbar is docked, click on 
the vertical “gripper” bar on the left side of the toolbar and drag the toolbar to 
its new position.  Otherwise, click and drag the caption or non-button region 
to move it. 
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Once a toolbar is dragged away from a border, it floats as an independent 
window, with its name in the title bar. You can even drag the toolbar outside 
the Virtual Sky and onto the desktop.   
 

 
 
Floating toolbars are not sizeable, but you can change their shape by dragging 
their side. The toolbar remembers its new shape when you move it between 
docked and floating. (The Time Skip toolbar has a fixed shape, to keep the 
control buttons in a straight line.)  
 
A floating toolbar can be docked against any of the main window’s four 
borders. Drag the toolbar towards the border as far as you can, until its 
outline changes shape. Release the mouse button when the toolbar is where 
you want it. Toolbars always dock against the horizontal borders with the 
buttons arranged horizontally (and vertically against the vertical), regardless 
of the shape they had when they were floating.  
 
Use the Save Toolbar Positions command from the Toolbars fly out menu on 
the Toolbars menu to save changes you’ve made to the position of the 
toolbars. TheSky6 uses the saved toolbar positions to restore the toolbars 
when the main window is sized from small to large. 

Showing and Hiding Toolbars 

The Toolbar Setup command from the Toolbars fly out menu on the View 
menu displays the Toolbars Setup dialog box shown below. Mark the 
checkboxes of the toolbars you want to display, clear the checkboxes of those 
you want to hide, then click OK. Toolbar settings are automatically saved 
when you quit TheSky6.  Right-clicking a toolbar displays the Toolbar popup 
menu; use this to show or hide toolbars individually. 
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Another way to hide or display toolbars is to right-click anywhere in the non-
button area of a toolbar, or in the “gray” space behind the toolbars. This 
displays the toolbars pop-up menu. The Toolbars and Status Bar dialog boxes 
can also be accessed from this menu.  
 
Another way to hide a floating toolbar is to click the X button. 

Show in Full Screen Mode 

Switching to Full Screen automatically hides the toolbars. If you want the 
toolbars in Full Screen, mark the “Show in Full Screen Mode” checkbox.  

Show Tool Tips 

When you hold the mouse pointer over a toolbar button, without clicking, a 
pale-yellow caption appears below the button, describing its use. These tool 
tips (sometimes called “balloon help”) are displayed by default. If you don’t 
want to see them, clear the “Show ToolTips” checkbox in the Toolbars dialog 
box.  
 
Changes to tool -tip status are saved when you save the current Sky 
Document. 

Show Object Tips 

 
 
When you hold the mouse pointer without clicking over an object in the 
Virtual Sky, a pale-yellow caption appears below the object, with either its 
common name or catalog number.  
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If you don’t move the mouse, this object tip disappears after about 30 seconds. 
If the Virtual Sky symbol represents a multimedia object, the object tip 
indicates the multimedia type – image, video, sound, or notes. 
 
Object tips are displayed by default. If you don’t want to see them, clear the 
“Show Object Tips” checkbox in the Toolbars dialog box. 
 
Configuring Object Tips 

 
TheSky6 allows you to specify what information appears in Object Tips. Each 
time an Object Tip appears, the information in the text file named Tooltip 
Format.txt is used to format the contents of the tip. Below is a sample format 
of this text file:  
 
""|Object name| 
"Mag"|Magnitude| 
"HA"|Hour angle| 
Air mass|Air mass| 
RA rate (arcsecs/sec)|RA rate (arcsecs/sec)| 
DB field 1|DB field 1| 

 
Edit the contents of this text file to modify what information appears in the 
Object Tip. See the “Customizing the Object Information Report” (page 49) 
for details about what other information can appear in the Object Tip. 
 
Object Tip Hints 

 Object Tips are limited to 80 characters and less. 
 Any object attribute can be included in this text file. 

Status Bar (View menu) 

The Status Bar at the bottom of the screen displays useful information. The 
Status Bar dialog box (in the View menu) controls what is displayed.  
 

 
 
 screen position (equatorial or horizon coordinates) 
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 cursor position (equatorial or horizon coordinates)  
 Earth location (the current city and state/country) 
 local sidereal time (When skipping time, shows the time of each “frame.”) 
 field width  
 telescope position  
 date (of the current display)  
 time (of the current display)  
 angular dimensions of the zoom box (when a zoom box is drawn)    
 
Mark or clear the checkboxes to select or deselect items. You can choose any 
combination. (The zoom box dimensions are automatically shown at the left 
side when you draw a zoom box, so there is no checkbox for them.) To hide 
the Status Bar, clear the “Visible” checkbox. The greater the horizontal 
resolution of your display driver, the more items can be shown. Once you 
reach the limit, the remaining items are dimmed. 
 

Scroll Bars (View menu) 

Use scroll bars on the Virtual Sky to adjust center of the field of view. The 
horizontal scroll bar adjusts right ascension or azimuth and the vertical scroll 
bar adjusts declination or altitude (depending upon the current projection).  
  
Click the Scroll Bar command on the View menu to turn on and off the scroll 
bars.  These settings are saved and restored each time the application is 
started.  
   
When dragging the scroll bar “thumb” (the rectangular button in the scroll 
bar) the status bar displays the destination coordinates in both right 
ascension/azimuth and declination/altitude.    
  
Hold down the Control key to disable “dynamic” scrolling (that is, redrawing 
the screen after each move) when dragging the scroll bar's thumb. 

Undo (Edit menu) 

TheSky6 keeps track of each change you make to the Virtual Sky’s 
orientation, field of view, and center coordinates. If you have second thoughts 
about a change, use the Undo command (from the Edit menu) to return to the 
previous settings. Or press CONTROL+Z.  
 
TheSky6 remembers the last 15 changes in the current session (including 
changes that occur when the Virtual Sky is automatically updated). As long as 
the Undo command is not dimmed, there is at least one more Virtual Sky 
change that can be reversed.  
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The list of changes is discarded when you exit TheSky6. If there’s a group of 
settings you want to keep, use the Save As command to create a Sky 
Document (.SKY file).  
 
You can also undo changes that have not yet been saved in the current Sky 
Document. Select the New command from the File menu (or press CONTROL+N, 
or click the New button in the Standard toolbar). You are prompted to save 
changes to the current Sky Document. Click No to discard the changes. The 
last saved version will then be reloaded.  
 
Other changes – such as turning on the Equatorial Grid, or switching to Night 
Vision mode – are not tracked, and can’t be reversed with the Undo 
command. They must be undone manually. 
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Chapter 7 Reference Lines 

Adding Reference Lines to the Display 

The Virtual Sky can include reference lines that display coordinates, help you 
visualize your orientation, or indicate what part of the sky you’re looking. 
There are four principal sets of reference lines. Click the corresponding 
button in the View toolbar to hide or display them. 
 
 Equatorial Grid The equatorial grid marks the celestial sphere, in 

coordinates of right ascension and declination. 
 Horizon Grid The horizon grid shows azimuth and altitude coordinates 

with respect to the local horizon.  
 Constellation Figures These lines connect the principal stars of each 

constellation, giving a rough idea of its astrological or mythological shape. 
For example, the lines in Leo suggest a reclining lion. 

 Constellation Boundaries These lines mark the borders of each 
constellation, which often extend well beyond the familiar stars that make 
up the constellation. The 88 boundaries fully cover the sky; every object 
falls within a constellation. The Constellation Boundaries include labels 
naming the constellations. To see the labels, the orientation must be set 
to Pole Up, the field of view must be less than 60°, and the Constellations 
checkbox on the Common Names sheet of the Labels Setup dialog box 
must be marked. 

 

 
Figure 21 – Reference Lines dialog box. 

 



TheSky6 
 

98 

General Lines  

There are checkboxes for the Ecliptic, Galactic Equator, Milky Way (picture), 
and Milky Way (solid). These options have no matching toolbar buttons. 
 
 Ecliptic – This line shows the daily path of the Sun through the sky. 

Because the Sun’s apparent motion is caused by the Earth’s rotation 
around the Sun, the Ecliptic also marks the plane of the Earth’s orbit.  

 Milky Way (picture) The Milky Way – our home galaxy – is displayed as a 
high-resolution photograph. See the Real Mode Option command (page 
65) for details about adjusting the brightness of the Milky Way picture. 

 Milky Way (solid) The Milky Way can also be displayed as a gray filled 
polygon. The inner, brighter region is represented with a lighter color 
gray.  

 Galactic Equator This line marks the central plane of the Milky Way. The 
North (NGP) and South Galactic Pole (SGP) are also marked. 

Constellation Lines  

The Constellation Figures and Constellation Boundaries checkboxes have the 
same function as the corresponding buttons on the toolbar. Mark or clear 
them to display or hide these lines. 
 
 Boundaries In 1930 astronomer Eugene Delporte proposed a set of 

boundaries for each constellation and the IAU has since adopted them as a 
standard way to break up the celestial sphere. Mark this option to show 
these boundaries. At narrow fields, TheSky6 labels the names of the 
constellations near each boundary. 

 Lines Mark this option to turn on the lines that connect stars of each 
constellation, giving a rough trace of its mythological shape. 

 Drawings High-resolution Bevis drawings of the constellations can be 
shown on the Virtual Sky. 

 Only near screen center Rendering multiple high-resolution constellation 
drawings can be taxing on the computer, so you can mark this option to 
display photographs of the constellations that are near the center of the 
Virtual Sky. 

Equatorial Lines 

Mark or clear the Grid checkbox in the Equatorial Lines section to turn the 
RA-Dec lines on or off. 
 
Grid 
A coordinate grid, much like the longitude and latitude lines on a world map, 
can be displayed on the Virtual Sky.  This equatorial grid displays lines of 
right ascension and declination for the current field. 
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There are three Equatorial Lines Spacing options. Automatic – Wide and 
Automatic – Narrow let TheSky6 control the lines’ spacing. Automatic – 
Narrow displays about twice as many lines as Automatic – Wide. As the field 
of view changes, TheSky6 adjusts the number of lines to provide useful 
resolution, without cluttering the display. When User-Defined is selected, you 
can specify the spacing. Enter it as degrees and fractions of degrees. (Don’t 
enter hours instead of degrees, and don’t use the minutes/seconds format—
DD.MMSS—by mistake.) There are separate settings for right ascension and 
declination. 
 
To avoid cluttering the display, the number of grid lines is limited. If the 
User-Defined setting is so small that “too many” equatorial lines would be 
shown at the current field of view, TheSky6 overrides the spacing you 
selected and switches to the Automatic – Wide setting.  
 

North/East Indicator 

Marking this box displays a “quarter compass” that indicates the directions of 
North and East. Although they are displayed for all orientations, they are 
meaningful only for horizon-based orientations – Zenith, North, South, East, 
and West. 

Horizon-based Lines 

Mark or clear the Grid checkbox in the Horizon-based Lines section to turn 
the Alt-Az lines on and off. The Meridian checkbox displays or hides the local 
meridian line – 0°/180° azimuth. The meridian is (by default) a dashed line, so 
it’s easy to distinguish from other lines.   
 
Local 

Marking the Local checkbox displays a line that represents the local horizon. 
The default local horizon is drawn as a featureless line at 0° altitude. You can 
redefine the line so it represents the horizon at your viewing site. Adding 
natural objects and obstructions to the horizon gives a better idea of what is 
and isn’t visible, and the approximate times at which objects rise or set.  
 
1 Select the Reference Lines command from the View menu. The 

Reference Lines dialog box appears.  
2 Click the Edit Local Horizon button. The Horizon Line Editor dialog 

box appears.  
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Figure 22 – Horizon Editor dialog box. 

3 Drag the mouse to change the line’s shape.  Hold down the right 
mouse button as you drag to draw a straight line, at any angle. You can 
start or end a straight line anywhere within the editing area – the straight 
line and the existing curve are connected when you release the mouse 
button. 

4 Type a description in the Description edit box. The description isn’t 
required, but it’s a convenient reminder.  

5 Click Save to store the Horizon file under its default name.  The 
default Local Horizon file is normal.hrz and is saved to the <My 
Documents>\Software Bisque\TheSky6\Horizons folder. The default extension is 
.HRZ. If you don’t supply an extension, .HRZ is automatically added. 

6 Click Save As to create a new Horizon file. The file can have any 
name and be stored in any folder. The recommended folder is <My 
Documents>\Software Bisque\TheSky6\Horizons. 

 
Match Horizon Image 

When the orientation of the Virtual Sky is not amenable to showing the 
photographic horizon, the photographic horizon is hidden automatically and 
the local horizon is drawn. If you want the shape of the local horizon to match 
the shape of the photographic horizon when this occurs, click the “Match 
Horizon Image” button.  The Line Editor computes the altitude of the 
photographic horizon at one-degree increments of azimuth, and draws the 
local horizon line accordingly. 
 
Copy and Paste Buttons 

The Copy and Paste buttons copy the current horizon line to the Clipboard, or 
paste the horizon line on the Clipboard to the Horizon Editor. The horizon 
line is represented as a 360-row by 1-column Excel spreadsheet. You can 
paste the horizon line into an Excel™ page, modify it, then copy it and paste it 
back into the Horizon Editor.  
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If you observe from more than one site you’ll probably want to create a 
Horizon file for each. Use the Open command to load a different Horizon file. 
TheSky6 remembers the last Horizon file you loaded, and automatically 
reloads it the next time you run TheSky6.  
 
The Horizon-based Lines section of the Reference Lines dialog box controls 
the display of the Local Horizon. Mark or clear the Local checkbox to show or 
hide the Local Horizon. The Local Horizon Fill radio buttons of the Reference 
Lines dialog box determine how the area “below” the Local Horizon is 
treated.  
 
 If Transparent is selected, the local horizon is “see through” so that 

objects below the horizon remain visible.  
 If Opaque is selected, objects below the horizon line are masked with the 

Horizon Line fill color. (Horizon Lines Fill in the Display Properties dialog 
box sets this color.)  

 
TheSky6 can help you draw the Horizon line. See the section “Limit Line and 
Horizon Line Assistance” for details. The Local Horizon line is a limit line. 
When limit lines are active (see “Telescope Limit Lines,” below), you cannot 
slew a computer-controlled telescope below the Local Horizon. 
 
Refracted 

Near the horizon, the atmosphere refracts (bends) the light so much that 
objects below the “physical” horizon are visible. Marking the Refracted 
checkbox displays a line that outlines the “refracted” horizon. The refracted 
horizon is the same color (by default) as other horizon-based lines. It’s not 
marked in any special way. 
 
Show in Pole Up Orientation 

The local horizon is normally only shown when the Orientation menu’s Zenith 
Up command is selected. Mark the “Show in Pole Up Orientation” option to 
always show the local horizon, regardless of the current display orientation. 
 
Telescope Limit Lines 

Few telescopes have an unrestricted range of movement. Their construction, 
or the use of a particular eyepiece or accessory, limits how far they can move 
in particular directions. You don’t want to accidentally “bang into” one of 
these limits.  
 
To reduce the chance of this happening, TheSky6 lets you define limit curves. 
When a limit curve is active, TheSky6 will not slew the telescope to any point 
or object within the region bounded by the curve. If you’re slewing to an 
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object outside this region, but the slew requires the telescope to cross the 
boundary, TheSky6 attempts to stop the slew when it reaches the boundary.  
 
Creating a limit line is relatively simple. Set up the telescope as you would 
normally use it. Use its setting circles (or electronic readout) to determine 
which parts of the sky it can’t be pointed to. (TheSky6 has a “digital setting 
circles” feature that can help. See page 233.) Then transfer the coordinates to 
the limit line, as explained below.  
 
You can define limit curves in equatorial or horizon coordinates. It makes 
sense to use coordinates that match your telescope’s mounting (equatorial or 
alt-az), since these relate directly to the mount’s movements.  
 
There are two default limit-line files, declimit.hrz and altlimit.hrz. Both 
are stored in the <My Documents>\Software Bisque\TheSky6\Horizons folder. The 
following description assumes you’re modifying the default files (but you can 
create additional files with different names). To create a custom limit line: 
 
1 Select the Reference Lines command from the View menu. The 

Reference Lines dialog box appears. 
2 Click Edit Dec Limit or Edit Alt Limit. Choose Edit Dec Limit for 

equatorial telescopes. 
3 Choose Edit Alt Limit for telescopes with alt-az mounting. The 

Horizon Editor dialog box – the same dialog box used to create the Local 
Horizon line – is displayed (page 55). A default limit line has already been 
drawn.  

4 Drag the mouse to change the line’s shape. Hold down the right 
mouse button as you drag to draw a straight line, at any angle. You can 
start or end a straight line anywhere within the editing area – the straight 
line and any existing curve are connected when you release the mouse 
button 

5 Type a description in the Description edit box. You might want to 
indicate the telescope model, or which accessories this limit setting is for. 
The Description is optional. 

6 Click Save to store the Limit file under its default name. The default 
files are declimit.hrz and altlimit.hrz. By default, Limit files have the 
extension .HRZ and are stored in TheSky6’s user subfolder. If you don’t 
supply an extension, .HRZ is automatically added. 

7 Click Save As to create a new Limit file. The file can have any name 
and be stored in any folder. If you use the default extension and folder, you 
won’t have any trouble finding it.  

 
If you have accessories that further limit the movement of your telescope, 
you’ll want to mount them and create additional limit-line files.  
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Once you’ve created a limit line, you might want to connect the telescope to 
your computer and move it – cautiously! – to see if you supplied the correct 
coordinates. If there’s any doubt, be conservative. If the limit line is too 
“tight,” TheSky6 might not be able to stop a slew in time.  
 
To load a limit line file, open the Reference Lines dialog box by pressing 
CONTROL+SHIFT+R and click either Edit Declination Limit or Edit Altitude 
Limit. Then click Open. In the Open dialog box, select the file and click Open. 
 
To display the Limit Line, mark the Visible checkbox in the Telescope Limits 
section of the Reference Lines dialog box. 
 
Limit Line and Horizon Line Assistance 

TheSky6 can help you draw limit lines or local horizon lines. After establishing 
a link with your telescope (see “Chapter 20 Controlling Your Telescope”), 
you can position the telescope at its limits (or near the horizon) and let 
TheSky6 add points to the curve for you. 
 
1 Create a rough approximation of the desired horizon or limit line. 

You don’t even need a rough line – TheSky6 can draw the complete line 
from scratch, if you move the telescope through every point on the line.  

2 Connect your telescope to the computer and establish a link. 
3 Display the Limit Line or Horizon Line. 
4 Move the telescope so it’s pointing near the limit or the horizon. 

The Virtual Sky’s cross hairs should be near the Limit Line or Local 
Horizon. 

5 Select Line Editor from the Telescope menu. The Telescope Line 
Editor dialog box appears. 

6 Click the radio button of the line you’re editing (Horizon, Altitude 
Limit, or Declination Limit).  

7 Mark the “Continuously follow telescope” checkbox if you want 
TheSky6 to automatically add or modify points as the telescope 
moves.  

8 Move the telescope so that it’s at a limit or horizon-line 
obstruction point. If you’re setting a limit, watch the telescope as you 
move it. If you’re outlining the horizon, look through the telescope. 

9 Click Connect. You’ll see the limit line redrawn to include the point. 
(This step isn’t needed if you marked “Continuously follow telescope” – 
TheSky6 automatically modifies the line.)  

10 Repeat Steps 8 and 9 to add additional points. Pick points that 
represent extreme positions. For example, if your horizon includes a high-
rise apartment, pick the left and right edges of the top of the building. 
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Activating the Limit Line 

Displaying a limit line does not automatically activate it. To do so, select the 
Setup command from the Telescope menu. Confirm that the “Impose Slew 
Limits” checkbox is marked, then click OK. (It is marked by default.)  
 
If you try to move the telescope into a “forbidden” region, you are prompted 
twice to confirm that you really want to override the limit, and warned that 
damage might occur. Be cautious.  
 
If your telescope has a computer-controlled drive (e.g., Celestron NexStar, or 
Software Bisque Paramount ME), open the Telescope Setup dialog box and 
mark the “Attempt to stop slews in progress through slew limits” checkbox. 
TheSky6 will then monitor the telescope’s motion. If you use the drive’s 
controller to try to slew through the forbidden region, TheSky6 will try to stop 
the slew when the boundary is reached.  
 
The telescope link Simulator provides a convenient way to check operation of 
the limit lines before connecting a telescope. See page 221.  
 
Disclaimer 
Any motor-driven telescope can – through accident, carelessness, or 
component failure – be run into its mechanical limits. Software Bisque 
provides the limit line feature as a convenience – not as a guaranteed cure for 
the problem. You are responsible for the safe use of your instrument. 

Field of View Indicator (View menu) 

A Field of View Indicator (or FOVI for short) is a screen element that 
represents the field of view of an eyepiece, CCD sensor, camera body, 
Telrad™ finder or multi-optic system. As you zoom the display, this FOVI 
shrinks or expands in proportion to the field of view. 
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Figure 23 – Multiple Field of View Indicators on the Virtual Sky. 

 
TheSky6 incorporates an “equipment-centric” method for setting up and 
defining your Field of View Indicators. You specify your telescopes, 
eyepieces, CCD, video or traditional film cameras, and TheSky6 can 
automatically generate the FOVIs for one, any or all combinations. TheSky6 
also allows you to define custom FOVI’s that have up to 20 distinct 
components. 
 
TheSky6's on screen FOVI’s are configurable and customizable. They can be: 
 
 Moved to any part of the screen. 
 Copied then pasted and “pinned” to a specific equatorial coordinate. 
 Rotated to any angle. This angle is maintained from session to session. 
 Used as the telescope cross hairs. 
 Used to create a telescope mask. 
 
Using TheSky6 FOVIs are described below. 
 
 Moving a FOVI Select an individual FOVI by clicking on one of the lines 

that make up the FOVI, or click on the center marker. Two small squares 
appear when the FOVI is selected.  Click and drag the square in the center 
of the FOVI to move it. Release the mouse button when the FOVI is in 
place.  
 
Copying a FOVI Right-click on one of the lines that make up the FOVI, or 
right-click on the center marker. Two small squares appear when the 
FOVI is selected. On the pop up menu, click Copy. A duplicate copy of the 
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selected FOVI is created and "pinned" at the current equatorial 
coordinates. See Moving a FOVI above for details about positioning the 
new FOVI. 

 
 Rotating a FOVI Select an individual FOVI by clicking on one of the 

lines that make up the FOVI, or click on the center marker. Two small 
squares appear when the FOVI is selected. Click and drag the outer 
square to rotate the entire FOVI. Release the mouse button when the 
FOVI has been rotated the desired amount. Note that the description text 
is not rotated. 

 
 Using FOVI for the Telescope Cross Hair The telescope cross hair by 

default consist of small circle. You can specify any FOVI to be used as the 
cross hair instead. 

 
1 Click Telescope | Field of View Indicators command.  
2 Click on the My FOVIs tab.  
3 Select the FOVI to use as for the telescope cross hair.  
4 Click Edit.  
5 On the Create/Edit Detector Geometry dialog box, select Telescope 

from the Reference Frame list. Click OK twice. 
 
 Creating a Telescope Mask When a FOVI is defined as type Telescope 

Mask the Virtual Sky simulates the view through a telescope.  
 

1 Click Telescope | Field of View Indicators command.   
2 Click on the My FOVIs tab.  
3 Select the FOVI to use as for the telescope cross hair.  
4 Click Edit. On the Create/Edit Detector Geometry dialog box, select 

Telescope from the Reference Frame list.  
5 Click OK twice. 

 
FOVIs in earlier versions of TheSky6 were displayed at a “fixed” orientation 
relative to the screen. When the screen was rotated, the FOVI did not rotate. 
FOVIs in TheSky6 are much more flexible. A FOVIs orientation is 
independent of the screen, and can be rotated at any angle. This information is 
preserved from session to session.  

Creating FOVIs for Your Equipment 

Generating a complete set of Field of View Indicators is easy. All you need to 
do is specify your equipment; TheSky6 does the rest for you. 
 
1 Click View | Field of View Indicators. 

Or click the Field of View Indicators button in the View toolbar, or press CONTROL+SHIFT+F. 
The Field of View Indicators dialog box is displayed. 
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2 Click the Telescopes tab. 
 

 
 
On the Telescopes tab, add your telescopes to the My Telescopes list. The easiest way to 
do this is to select them from the Add from Telescope Database list. If your telescope is 
not listed, you can define its optical characteristics by clicking the Create button. 
 

 
 
On the Create/Edit Telescope dialog box, enter its description, the aperture in millimeters and 
the focal ratio and then click OK. Repeat this procedure for each telescope you own. 
 

3 Click the Eyepieces tab. 
 

 
 
On the Eyepieces tab, add your eyepieces to the My Eyepieces list. The easiest way to do 
this is to select them from the Add from Eyepiece Database list. If your eyepiece is not 
listed, you can define its optical characteristics by clicking the Create button.  
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On the Create/Edit Eyepiece dialog box, enter its description, the apparent field width, in 
degrees, and the focal length, in millimeters and then click OK. Repeat this procedure for 
each eyepiece you own. 
 

4 Click the Detectors tab. 
 

 
 
On the Detectors tab, add your detectors to the My Detectors list. The easiest way to do 
this is to select them from the Add from Detector Database list. If your detector is not 
listed, you can define its geometry by clicking the Create button.  
 

 
 
On the Create/Edit Detector Geometry dialog box, first enter the description, and select the 
units of measure (either millimeters or arcminutes). Detectors can include up to 20 different 
“screen elements.” For each element in the detector, enter a description (such as SBIG ST-
99999 imaging detector), select the shape of the screen element (circular, rectangular, 
screen marker, or Telrad™ finder) and then specify the x and y dimensions, the offset of the 
element from the center of the screen (based on the unit of measure you’ve selected above) 
and the number of pixels in the detector, where applicable. TheSky6 can use this information 
to compute image scale. Finally, select the frame of reference for the detector. It can be 
based upon a fixed screen position (Screen), specific right ascension and declination 
coordinates (Equatorial), used the telescope cross hairs (Telescope), or as a telescope. 
Repeat this procedure for each eyepiece you own.  
 

5 Click the Create FOVIs tab. 
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If you want to create a single FOVI, click either the My Eyepiece or My Detector option, then 
select the appropriate one from the list. Select the telescope from the My Telescope list and 
then click Add My FOVI. The new FOVI is added to the FOVI report in the My FOVIs tab 
(whew!). 
 
To create FOVIs for every combination of telescope, eyepiece or detector, click Add All 
Detectors + All Telescopes or Add All Eyepieces + All Telescopes.  
 
If you want to create a FOVI based on a photograph or CCD image, first perform an Image 
Link on the image (page 189). When there’s an Image Linked image, the Add FOVI from 
Image Link is undimmed. Click it to add the FOVI to My FOVIs.  
 
Mark the “Rotate FOVIs To Computed Position Angle” option to have TheSky6 automatically 
rotate the field of view indicator based upon the position angle of the Image Link image. 
 

6 Click the My FOVIs tab. 
 

 
 
FOVIs are displayed in columns. Click on the column header to sort them by description, 
visibility (on or off), size (arcminutes), scale/magnitude, type, or reference frame. 
 
Select one or more FOVIs and then click On to display them. Click Preview to center and 
frame the Virtual Sky based on the dimensions of the indicator. The Center button adjusts the 
position of the Virtual Sky to center on the FOVI. FOVIs can be “pinned” to any right 
ascension/declination coordinate or screen coordinate. 
 
The Edit button allows you to change the properties of the selected FOVI. Click the Remove 
button to permanently delete the indicator. 
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Telescope Mask Opacity 

When a FOVI is defined as type Telescope Mask the Virtual Sky is drawn to 
simulate the view through a telescope. Adjust the transparency of the mask 
using the Telescope Mask Opacity option on the Create FOVIs tab. 
 

 
Figure 24 – FOVI using the Telescope Mask property. 

Telrad™ Finder 

 
Figure 25 – Telrad finder. 

 
A Telrad Finder is a unique Field of View Indicator because its field of view is 
not dependent upon a telescope optical system. However, TheSky6's FOVIs 
require that you define a telescope and eyepiece or detector to create a FOVI.  
So, in order to define a Telrad FOVI, you must create a "dummy" FOVI (based 
on a telescope/eyepiece combination) and then modify its geometry.  
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1 Select the Field of View Indicators command from the View menu to 

display the Field of View Indicators dialog box. 
2 Click the Telescopes tab and then click the Create button.  
3 On the Create/Edit Telescope dialog box, enter Telrad Telescope in the 

description text box and then click the OK button.  
4 Click the Eyepieces tab and then click Create.  
5 On the Create/Edit Eyepiece dialog box, enter Telrad Eyepiece in the 

description text box and then click the OK button.  
6 Click the Create FOVIs tab.  
7 Click the My Eyepiece option and then select Telrad Eyepiece from the 

list.  
8 Select Telrad Telescope from the list and then click Add My FOVI.  
9 Click the My FOVIs tab. 
10 Select “Telrad Telescope + Telrad Eyepiece” from the list and then click 

Edit to display the Create/Edit Detector Geometry dialog box.  
11 Click Telrad from the Shape group. Change the Description to just Telrad 

and then click the OK button.  
12 Select the Telrad FOVI from the My FOVI list and then mark the “On” 

option. Click the Preview button to automatically center the Telrad on the 
Virtual Sky. 
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Chapter 8 Labels 

The first time TheSky6 runs, the common names for the following items are 
displayed. (Objects that don’t have common names aren’t labeled.)  
 
 Messier objects  
 Planets, Sun, Moon 
 
To hide these labels, select the Labels command from the View menu and 
choose Common Names in the fly out menu. Or click the Common Names 
button in the View toolbar.  
 
Extended labels are customizable, database-specific labels for stellar and non-
stellar objects.  See “Extended Labels” on page 114 for details. 

Label Setup 

The Labels Setup dialog box controls what types of objects are labeled. 
Choose the Labels command from the View menu, and then select Setup from 
the fly out menu. (Or press ALT+L to open the Labels Setup dialog box 
directly.) 
 

 
Figure 26 – Labels Setup dialog box. 

 
The Common Name Labels setup is self-explanatory. Mark the checkboxes of 
the labels you want, clear those you don’t want, then click OK.  
 
The number of labels displayed is limited to about 150, to avoid cluttering the 
Virtual Sky. 
 
If an object is dimmer than the value in the Magnitude Limit edit box, its 
extended data are not displayed. You can enter values from 30.0 to -6.0. 



TheSky6 
 

114 

The default magnitude is zero (0.00). It does not, however, set a limit of zero, 
but tells TheSky6 to show as many extended labels as possible, without 
cluttering the display. Entering a value other than zero sets an actual limit. 
Fractional values are okay. 
 
For Common Name labels, click Apply to preview the effects of your changes, 
without exiting. Click OK to accept the changes. Click Cancel to discard your 
changes – even if you used Apply to preview them.  

Extended Labels 

Extended labeling is available only when the field of view is 50° or less.  
They’re most useful when studying a limited number of objects at field angles 
of 1° or less.  
 
To show or hide all extended labels, select the Labels command in the View 
menu, and then select the Extended Labels option in the fly out menu. 
 
Extended Labels are somewhat customizable in that you can specify what 
catalog-specific data is shown. To define the label, select Display Explorer 
command from the View menu. Navigate to “Core Databases” and open the 
“Stellar” or “Non-Stellar” nodes.  Click on the “Extended Labels” node, and 
then click on the small yellow label icon to show the labeling options. 
 
Extended labels for stars can include any of the following. 
 
 Star identifier (ID) 
 Equatorial coordinates (current epoch right ascension and declination) 
 Magnitude 
 Smithsonian Astrophysical Observatory catalog identifier (SAO ID) 
 Spectral class 
 Position error 
 Distance 
 Proper motion 
 B and V magnitudes 
 Hipparcos identifier (ID) 
 
Use the Display Explorer to view the labeling parameters for other catalogs 
since they are too numerous to outline here. 
 
Extended labels appear to the left of an object, common names appear to the 
right. This allows both labels to be read at the same time. 
 
Labeling, labeling format and extended label selections last through the 
current session. 
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To make any changes permanent, save the current Sky Document. 
 
User-Defined Data in User-Created Databases 

If you create your own databases and add user-specified data to each record, 
the labels of these items will appear on the Extended Labels sheet for that 
database. Mark the checkboxes of the data items you want displayed. 
 
 

Figure 27 – Common name labels (right) and extended label (left). 
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Chapter 9 Comets, Minor Planets, and Satellites 

TheSky6 can display up to 1000 comets, 10,000 satellites and virtually an 
unlimited number of minor planets. You can also enter orbital elements 
directly into a dialog box, or download them from the Internet.  
 
Satellites are plotted in real time, using two-line orbital elements (TLEs). 
Continually updated elements for all satellites can easily be downloaded from 
the Internet.  

Entering Orbital Elements 

Comet and minor planet data are entered the same way. 
 
1 Select the Comets and Minor Planets command from the Data menu. The 

Comets and The Comets and Minor Planets dialog box appears.  
 

 
 
2 Select the Comets or Minor Planets tab.  
3 Click Add. The Comet Input or Minor Planets Input dialog box appears.  
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4 Enter a name for the object in the Name edit box. This name appears next to the 
object when Common Name labels are displayed. 

5 Enter all the required values.  
6 Change the Epoch, if necessary. Epoch 2000.0 is the default. You can also specify a 

month and date.  
7 Click OK to accept the entry and close the dialog box. If any entry has the wrong 

format, or is outside its acceptable range, you are prompted to change it. You can’t close the 
dialog box until all entries are “correct.” The Comets and Minor Planets dialog box returns.  

8 If you do not want the object displayed, highlight its name in the Name list. 
Then clear its checkbox. Newly added comets and minor planets are automatically 
active. For any comets or minor planets to be displayed, the Comet or Minor Planet checkbox 
in the Display Explorer dialog box must also be marked. 

 

Newly added comets and minor planets are automatically active. For any 
comets or minor planets to be displayed, the Comet or Minor Planet checkbox 
in the Display Explorer dialog box must also be marked. 
 
To change the orbital elements for an object, highlight its name in the Name 
list. Then click Edit to display the Input dialog box.  
 
To delete an object, highlight its name in the Name list. Then click Remove. 
You are prompted to confirm the removal. Even if you respond Yes, you can 
still override the deletion by clicking Cancel.  
 
To remove a comet or minor planet from the display without deleting it, 
highlight it in the Name list, and then clear its checkbox.  
 
Comets and minor planets can be used with Time Skip animation, like any 
other Solar System object. You can follow the path of a comet, or predict 
when a minor planet will occult a deep-space object. See Chapter 18 Object 
Paths and Time Skips .” 
 
Comet and Minor Planet Data Storage 

“Local” comet and minor planet data are stored in comet.dat and minorpl.dat. 
These files are limited to 1000 objects each. To display additional minor 
planets, see “Extended Minor Planet Data” below. 

Adding Orbital Elements from Databases 

TheSky6 comes with text-format databases for comets and minor planets. You 
can import individual objects, or load the entire database.  
 
There is a single comet database, called comets.cmt. It’s in the <My 
Documents\Software Bisque\TheSky6\Comets folder.  
 
Minor planet databases are stored in the <My Documents\Software 
Bisque\TheSky6\Minor Planets folder. The minor planet number indicates 
order of designation by the IAU (1 = Ceres, 2 = Pallas, and so on). The file 
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named Astorb.dat includes the about 230,000 named minor planets, and is 
updated regularly.  
 
You can import objects from the Comets and Minor Planets sheets, or from 
the Comet Input and Minor Input dialog boxes. 
 
1 Click Import.  

The Import Comet Data or Import Minor Planet Data dialog box appears. The default 
subfolders are <My Documents\Software Bisque\TheSky6\Comets and <My 
Documents\Software Bisque\TheSky6\Minor Planets. If the file you want isn’t in 
these folders, use the browsing controls to find it. 

2 Highlight the name of the file you want, then click Open. Or just double-click the 
name. The Select list box appears. (Large databases might take a few seconds to load.) 

 

  
 
3 Highlight the object you want to add. You can select more than one object. To select a 

range of objects, click on the first, then press SHIFT when you click on the last. To select (or 
deselect) single objects, press CONTROL  when you click. 

4 Click OK. If you’re importing from Comet Input or Minor Input dialog box, the object’s orbital 
coordinates are written into the edit boxes. If you’re importing from the Comets or Minor 
Planets sheet, the new object now appears in the Name list. It is automatically made active. 

5 Click OK again (if you’re still in the Comet Input or Minor Planets Input box). 
The new object now appears in the Name list. It is automatically made active. 

 

The comets and minor planets listed in the Name boxes are called the local 
lists. The local lists are limited to 100 objects each. In addition to the Import 
feature described above, there is another way to add minor planets to the local 
lists. It’s explained in the “Extended Minor Planet Data” section, below.  
 
Comets and minor planets are Solar System objects. They appear in the Solar 
System node of the Find dialog box. Their positions are updated whenever 
the other Solar System objects are. When a large number are displayed, the 
updating might take a long time. You can either hide some (by clearing their 
checkboxes), or you can lengthen the time between updates. 
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 Obtaining Orbital Elements from the Internet 

You can directly access comet and minor planet orbital elements over the 
Internet. Or, download them at: 
 
www.harvard.edu/iau/Ephemerides. 
 
1 Establish a connection with the Internet. 
2 From the Comets sheet, click Observable. 

From the Minor Planets sheet, click Distant, Critical, or Unusual. A select dialog 
box (like the one in Step 2 of the previous section) appears. 

3 Highlight the object you want to add. 
You can select more than one object. To select a range of objects, click on the first, then 
press SHIFT when you click on the last. To select (or deselect) single objects, press CONTROL 

when you click.  
4 Click OK. 

The object is added to the Name list and automatically made active.  
 
Repeat Steps 2 and 3 to add more objects from different groups to the Name lists.  

Extended Minor Planet Data 

TheSky6 can display hundreds of thousands of minor planets at one time. You 
can see which minor planets might show up in a photograph, or might be part 
of an interesting occultation. 
 
The data for these minor planets are in the <My Documents\Software 
Bisque\TheSky6\Minor Planets folder. 
 
1 Select the Extended Minor Planets command from the Data menu. 

The Select Minor Planet File dialog box appears. 
2 Choose the .MPL file you want. Click Open (or double-click the name). TheSky6 

loads all the objects in the file and computes their current positions.  
3 Select the Display Explorer command from the View menu. The Display Explorer 

dialog box appears. 
4 Highlight Extended Minors Planets. Mark its checkbox. 
5 Click OK The minor planets you loaded are displayed. 
 

When you click on an extended minor planet to identify it, its elements are 
numerically integrated to update them to the current epoch. The coordinates 
reported in the Object Information dialog box are computed to an accuracy of 
±1 arcsecond. Extended minor planets keep their originally plotted positions; 
they are not updated. Therefore, they cannot be used with time-skip 
animation. To update their positions, reload their .MPL file.  
 
To hide extended minor planets, open the Display Explorer dialog box and 
clear the Extended Minor Planet checkbox in the Solar System objects node.  

Adding Extended Minor Planets to the Minor Planets Local List 

Extended minor planets can easily be added to the local minor planets list. 
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1 Click on the minor planet you want to add. The Object Information dialog box 
appears. 

2 Highlight the minor planet in the Object List (if necessary). 
3 Select the Utility tab. 
4 Click Copy to Local. The minor planet is added to the list in the Comets and Minor Planets 

dialog box. You can confirm this by opening the dialog box. The local minor planets list is 
limited to 100 objects. You will be prompted if you try to add more.  

 
The newly added minor planets are automatically saved when you exit 
TheSky6. 
 
1 Select the Extended Minor Planets command from the Data menu. The Select 

Minor Planet File dialog box appears. 
2 Choose the .MPL file you want. Click Open (or double-click the name). TheSky6 

loads all the objects in the file and computes their current positions. High accuracy plotting of 
a large file can take up to 10 minutes on a slower computer.  

3 Select the Display Explorer command from the View menu. The Display Explorer 
dialog box appears. 

4 Highlight Extended Minor Planets. Mark its checkbox. 
5 Click OK The extended minor planets you loaded are displayed. 

Adding Extended Minor Planets to the Minor Planets Local List 

 
1 Click on the minor planet you want to add. The Object Information dialog box 

appears.  
2 Highlight the minor planet in the Object List (if necessary).  
3 Select the Utility tab. 
4 Click Copy to Local. The minor planet is added to the list in the Comets and Minor Planets 

dialog box. You can confirm this by opening the dialog box. The local minor planets list is 
limited to 1000 objects. You will be prompted if you try to add more. 

Satellites 

TheSky6 can plot satellite orbits using two-line-element (TLE) sets published 
by Space Command Center. Because these data go out-of-date after about 
forty-five days, no TLE data are supplied.  
 

 
Figure 28 – International Space Station. 

 
The latest TLE data can be obtained from the Satellites dialog box (by clicking 
the Satellites command from the Data menu) or directly from the Space Track 
web site at http://www.space-track.com. Note: You must be a registered user 
to access this site.  Click on the “Create New Account” link on the above site 
to do so. 
 

http://www.space-track.com


TheSky6 
 

122 

The TLE data at this site are grouped into subsets of related satellites, such 
as weather, spy, communications, and “100 brightest.” There is also a master 
list of all currently orbiting satellites.  
 
The Satellite dialog box can automatically download any of these by clicking 
the “Import from Web” button and then selecting the desired category. 
 

To save TLE data as a text file: 

1 From your web browser, visit Space Track web site and log on.  
Click the “Create New Account” link if you do not already have an account. 

2 Click the Bulk Data Downloads link to view to retrieve a list of all satellites. 
3 Click on the TLE data set you wish to view. For example, Weather 

Satellites. 
4 From your browser, click Open.  

If you have suitable decompression software installed on your computer (such as WinZip 
or PKUnzip), the TLE text file should appear in unzip software for extraction. Consult your 
zip software documentation for details.  

5 Extract and save the text file to the <My Documents>\Software 
Bisque\Satellites folder. 

6 From TheSky6, click Data | Satellites.  
7 Click Import From File, and then select the text file from step 4. 

Plotting Satellite Orbits 

Plotting satellite orbits requires little more than loading a TLE file.  
 
1 Select the Satellites command from the Data menu.   

The Satellites dialog box appears. 
 

 
 

2 In the Satellites dialog box, set the following parameters.  
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Update Frequency (Fast, Medium, Slow, Very Slow, Never) sets the relative rate at which 
satellite positions in the Virtual Sky are updated. Updating a large number of satellites at a 
high rate might cause the computer to slow down.  
Compute On Startup automatically loads the TLE file when TheSky6 is launched.  

3 Click the Import From Web button. 
The “Import Satellites from www.Space-Track.org” dialog box appears. Note that this requires 
an Internet connection.  

 
 
Enter your user name and password to access the Space Track web site. If you do not have a 
connection to the Internet, click the Import from File button and select a previously 
downloaded TLE file on your hard disk instead. 
 

4 Highlight the category you want. Click OK. Or simply double-click the category. If the 
file is not in the <My Documents>\Software Bisque\TheSky6\User\Satellites folder, use 
the controls to browse for it. The TLEs are loaded and you are returned to the Satellites dialog 
box. Note that only one category can be selected at a time. 

 

The satellites should now be visible in the Virtual Sky, even if you haven’t 
exited the Satellites dialog box. If the “date-rejected” message indicates that 
one or more satellites’ TLEs are out-of-date, check the Time dialog box for 
the correct time. If the satellites do not move, it’s probably because the “Use 
computer’s clock” button is not pressed (page 15).  
 
If “Number of increments” text box shows a number greater than zero, you 
will see a line showing the calculated future path of the satellite. The length of 
this line is the distance traveled by the satellite in the “Compute frequency” 
interval, multiplied by the “Number of increments.”  
 
In the off chance you’ve written your own satellite orbital propagator, 
Software Bisque can provide a “hook” to access the propagator when the 
“Use custom propagator” checkbox is marked. Contact Software Bisque for 
more information. 
 
Mark the "Frame Object” option on the Find dialog box (page 49) to locate any 
satellite by name. 
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Figure 29 – Satellites listed in the Find dialog box. 
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Chapter 10 Configuring TheSky6 with Sky Documents 

What is a Sky Document? 

A Sky Document (.SKY file) is a record of the configuration of the Virtual Sky. 
Loading a Sky Document restores the configuration stored in that document. 
Sky Documents keep track of the following items. 
 
 Location settings 
 Time settings 
 Orientation settings 
 Field width 
 all Display Explorer settings (object labeling, lines and labels, magnitude 

limits, active/inactive databases, etc.) 
 the Display Properties file currently loaded 
 stellar brightness and contrast 
 stars/planets recomputation intervals 
 Status Bar configuration 
 Printing and page Setup options 
 User-defined data 
 Embedded TPoint Models 
 
When you change any item listed above, you change the Sky Document. 
That’s why the Undo command is in the Edit menu, not the View menu. 

Default Configuration 

The first time TheSky6 runs, the Virtual Sky has the following default 
configuration, stored in the default Sky Document, normal.sky.  
 
 Zenith Up mode with the South viewing direction is selected. 
 The viewing angle is set to 100°. 
 The Milky Way and most deep-space objects are visible. 
 The Common Name labels for comets and Messier objects are displayed. 
 The, Local Horizon is shown. 
 The Status Bar and all toolbars are visible. 

Selecting a Sky Document at Startup 

When TheSky6 first runs, it loads Normal.sky from the <My 
Documents>\Software Bisque\TheSky6\User\Documents folder. Every time after, 
it loads the previously saved Sky Document. 
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If you want TheSky6 to start up with a different Sky Document, double-click 
the Document’s name in the Windows Explorer. This runs TheSky6 and loads 
the selected Sky Document. 

Loading a Different Sky Document 

Use the Open command from the File menu to load a different Sky Document. 
Scroll the list box to find the file you want, then highlight it and click Open. 
(Or just double-click on the name.)  
 
Sky Documents can have any extension and be in any folder. However, the 
Open command assumes these files have the .SKY extension and are in the 
<My Documents>\Software Bisque\TheSky6\User\Documents folder. Using the 
standard extension and the default folder makes it easier to find your Sky 
Documents.  
 
The most-recently loaded Sky Documents are listed at the bottom of the File 
menu. You can also load a Sky Document by dragging it from the Explorer and 
dropping it anywhere in TheSky6’s window. (If you often use a particular Sky 
Document, you might want to add it to your desktop.)  

Creating Multiple Sky Documents 

Selecting Save from the File menu (or pressing CONTROL+S – or clicking the 
Save button in the Standard toolbar) saves the current configuration. When 
you exit TheSky6, you’re prompted to save any unsaved configuration 
changes.  
 
If you often set up specific configurations, it might be useful to create a 
different Sky Document for each one. Select the Save As command from the 
File menu and enter a new name. You might also want to create a Sky 
Document named (say) bookmark.sky. You can then save your current 
configuration to it without overwriting any other Sky Document.  
 
The New command (from either the File menu or the toolbar) does not create 
a new Sky Document. (Use the Save As command to do that.) Instead, it 
reloads the current document. You are first prompted to save it. Click Yes to 
keep any changes made since it was last saved, No to discard them.   

Sky Documents Supplied with TheSky6 

Besides Normal.sky, TheSky6 includes several Sky Documents that configure 
TheSky6 for specific uses. These are in the user\documents subfolder.  
 
One of them (Classic.sky) reconfigures the Virtual Sky so that it resembles 
version 2.x (yes, version 2). The others set up TheSky6 for simulating 
celestial events.  
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Sending a Sky Document as an Email Attachment 

TheSky6 can use your default email software to automatically create a new 
email message with an attached Sky Document. Use the Send As Attachment 
command from the File menu if you’re, for example, collaborating with other 
astronomers taking a mosaic image of M31 and want to use the same mosaic 
data, or you’ve setup an interesting simulation that you want to share with a 
friend. 
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Chapter 11 Customizing with Display Properties  

TheSky6 allows an almost unlimited degree of customization. Virtually every 
aspect of the Virtual Sky’s appearance can be modified. Star Charts can be 
modified, too, and have a completely different set of customizations.  

The Display Properties Dialog Box 

The Display Properties  dialog box controls how objects are displayed in the 
Virtual Sky or printed in Sky Charts. 
 
1 Select the Display Explorer command from the View menu, navigate to the 

object you wish to modify, and then click the Display Properties icon. The 
Properties dialog box appears.  
 

 
 
Right clicking on an object on the Virtual Sky and selecting the “Display Properties of” 
command can also open the Properties dialog box. Or, click on the object and then click the 
Display Properties button on Utility tab of the Object Information dialog box.  

2 Click the button of the characteristic you want to modify – Font, Line, Fill, or 
Symbol. The Sample boxes show the current setting or symbol.  

3 The appropriate dialog box appears. The following four sections explain the ways in 
which each characteristic can be modified. 

 

Font 

The Font dialog box lets you select any font currently installed (including 
TrueType™ fonts, and PostScript™ Type 1 fonts managed by Adobe Type 
Manager™). The font’s size, style, and treatment can be chosen. The font and 
its treatment are previewed in the Sample box.  
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Windows system fonts also appear in the Font list. Unlike TrueType and 
PostScript fonts, which scale smoothly to any size, system fonts are bitmaps, 
and can produce “blocky” or hard-to-read text. They can’t be rotated, either. 
Don’t use a system font unless no other font meets your need. 
 

 
Figure 30 – Font dialog box. 

Line 

The Line is (usually) the outline of the object. Most objects have a black 
outline, so the line is not visible in the Virtual Sky. These objects have a 
white outline when printed in a Sky Chart, for the same reason.  
 
You can choose the line’s color, style, and weight (width).  
 

 
Figure 31 – Line dialog box. 

 
In some cases the Line is not the object’s outline, but a related property. For 
example, the Line color for Spacecraft objects controls the color of the orbit 
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line drawn in the Virtual Sky. The Sky Chart Line color controls the color of 
zoom boxes. The Virtual Sky Line color sets the color of the bull’s eye. 

Fill 

The Fill is the color of the object. You can select from predefined colors or 
define a new color. The color depth of your graphics adapter determines the 
available color range. TheSky6 can support depths up to 32 bits. 
 

 
Figure 32 – Windows standard Color dialog box. 

 
You can choose from 48 Basic colors, or click Define Custom Colors and 
create one to your taste. There are three ways to define a custom color.  
 
 Drag the cursor over the color palette to set the hue and saturation. Then 

drag the arrow in the narrow adjacent “strip” to set the color’s luminance 
(lightness).  

 Enter Hue (0-239), Saturation (0-240), and Luminance (0-240) values.  
 Enter Red, Green, and Blue component values (0-255).  
 
The three selection methods interact. Changing any one of them causes the 
other two to show corresponding changes. For example, increasing Sat causes 
the cursor in the color palette to move upward. Moving the cursor over the 
palette changes Hue and Sat. 
 
If you want a shade of gray – without any color – type 0 (zero) in the Sat box. 
Then drag the arrow in the luminance strip to select the shade of gray.  
 
The mixing system in this dialog box can produce over 16 million colors. If 
your graphics system does not support this many colors, some colors might 
not be displayable as “solid,” but must be created by “dithering” (mixing 
discrete samples of) those colors that can be rendered as solid hues. 
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The “Color|Solid” box shows the dithered version of the color you mixed, 
and the “solid” color closest to it. The dithered color is used by default. If you 
want to use the solid color, press ALT+O. 

Color Selection Tips 

Everyone adjusts his or her monitor differently. The author, for example, 
keeps the brightness low to maximize sharpness. This can cause darker hues 
to appear dark gray, or even black. If a particular color does not show up on 
the Virtual Sky, try adjusting the monitor’s brightness or selecting a lighter 
color. 
 
Color printers vary in their capabilities. Some dithered colors may not print 
the way you expect them to – or even print at all. You should experiment 
before changing to the Sky Chart colors. 

Symbol 

The symbols used to represent celestial objects on the Virtual Sky are 9x9 
bitmaps. The Symbol Editor dialog box shows an enlarged view of the symbol 
on the left, and an “actual size” Preview on the right. 
 

 
Figure 33 – Symbol Editor dialog box. 

 
To edit the symbol, click on one of the 16 color boxes at the bottom to select a 
color, and then click on the pixel you want to change. Drag the mouse to 
change a row or column of pixels. 
 
To speed up editing, you can select different colors for the left and right 
mouse buttons. These selections are shown in the L and R boxes. 
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The Copy button copies the current symbol to the Clipboard. You can then 
pick a different symbol to edit and click Paste to transfer the first symbol. 
This is a convenient way to make symbol A a variation of symbol B.  
 
To start from scratch, click Clear to erase the symbol.  
 
When you’re satisfied with your changes, click OK to save them. To discard 
them, click Cancel. 
 
The symbols shown in Sky Charts are Windows metafiles. If you have one of 
the popular “draw” programs (CorelDRAW!, Micrografx Designer, FreeHand, 
Claris Works), you can create your own images and export them as metafiles 
or PICT files. Or you can load images from these programs’ clip-art 
collections and convert them.  
 
The default printing size of symbols is 3.0 mm square. Changing the Height 
or Width changes the size of the printed symbol. If the Height and Width are 
not the same, the symbol will be distorted. 

Creating Display Properties Files 

The default Display Properties file is Normal.sdp. You can create any number 
of additional Display Properties files to customize the appearance of the 
Virtual Sky or the Sky Charts. To create a new Display Properties file, use 
the Save As command to save the current Display Properties file under a new 
name. (The current Display Properties file is not deleted.) You can then 
modify the newly named file as you like.  
 
Display Properties files have the default .SDP extension. If you don’t supply 
an extension, .SDP is added automatically. A Display Properties file can have 
any name, but it must be stored in <My Documents>\Software 
Bisque\TheSky6\User\Sky Display Properties.  
 
TheSky6 assumes all Display Properties files are stored there. The name of 
the current Display Properties file – but not its path – is stored in the current 
Sky Document. 

To load a different Display Properties file: 

1 Open the Properties dialog box. 
2 Click the Properties File tab. 

The list box shows the .SDP files (and .SVP for backward compatibility with earlier versions)  
in  the <My Documents>\Software Bisque\TheSky6\User\Sky Display Properties folder. 

3 Highlight the desired file and click Open. (Or double-click the file’s name.) 
The name of the file appears in the title bar of the Display Properties dialog box. 

4 Click Close to exit. 
 
You can load a Display Properties file from any folder. However, if it’s not in 
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<My Documents>\Software Bisque\TheSky6\User\Sky Display Properties, 
TheSky6 will not be able to find it the next time it runs. In such cases, 
TheSky6 defaults to Normal.sdp. 
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Chapter 12 User-Defined Data 
 
Every observer has different needs. For example… 
 
 You want to label often-viewed objects. 
 You want to mark the boundaries of particular areas (for example, the 

Virgo Cluster) 
 You want to add an area of nebulosity not currently shown. 
 You want to add a new type of object type (for example, a gamma-ray 

burst, or supernova) that is not included by default. 
 
TheSky6 lets you customize the Virtual Sky by adding four types of user-
defined data. 
 
 Labels 
 Objects/Points 
 Lines/Polygons 
 Ellipses representing extended deep-sky objects 
 
These user-created data are saved with the currently loaded Sky Document. 
Each Sky Document has its own data set, so it’s easy to create unique data 
sets, or put together customized Sky Documents for each observing site. On 
the other hand, you might want user-created data to be available at all times. 
Exporting user data to a compiled database can do this. (See “More About the 
User-Defined Data Dialog Box” on page 138.) 

Basics of Adding User-Defined Data 

Pressing CONTROL and then clicking in the Virtual Sky adds user-defined data 
points. Repeated clicks add additional points, objects, labels, or line segments. 
The default data point is a small red plus sign (+). Instead of clicking, you can 
use the User-Defined Data dialog box add new points (by selecting a data type 
and entering coordinates), or modify data points that were created by clicking 
in the Virtual Sky. To open the User-Defined Data dialog box, select the 
User-Defined Data command from the Data menu. 

Changing the Default Data Type 

The Data Class box selects the data object to be added – reference 
points/objects, labels, or lines/polygons. The data type of the last item in the 
Entry Number list is the default type when you CONTROL+Click in the 
Virtual Sky. (If the Entry Number list is empty, the selections in the Data 
Class and Object Type boxes are the defaults.) 
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If this isn’t the type you want to add when you click, you need to change it.  
 
The “catch” is that you probably don’t want to change the type of the last 
entry. The solution is simple: CONTROL+click where you want the next 
data point to go, then open the User-Defined Data dialog box and change the 
new entry’s data type to the type you want. Subsequent data points will be of 
that type. 

Adding Reference Points/Objects 

The Reference Point is the default data type. To add an object instead of a 
point, select one of the types listed in the Object Type list box. If you select 
Comet (for example), each mouse click adds a comet symbol to the Virtual 
Sky.  
 
If the object type is a star (or other object) for which a magnitude is valid, 
enter a value in the Magnitude box. TheSky6 can then display the object with 
the correct size. The default magnitude is 30 – a very dim object.  
 
A reference point or object can be labeled. Type the label in the Label box. 
For example, if you put a reference point at the South Celestial Pole, you 
might label it “South Pole.”  

Adding Labels 

Like Post-It® notes, labels can be stuck anywhere. They don’t have to be 
associated with objects or data points. A label can have up to 50 characters, 
including spaces and punctuation. 
 
To add labels, select Labels from the Data Class box. (The Object Type 
doesn’t matter.) Each time you click in the display, a dialog box prompts you 
for the label. Or you can add labels and their coordinates from within the User 
Data dialog box. 
 
The label is displayed to the right of the point where you click, so that it 
doesn’t overlap any object at that point. 

Adding Lines/Polygons 

A line (or polygon) isn’t an object, but a set of commands. The first segment 
of a line requires two commands. 
 
Move To moves to the starting point of the line. 
Line To draws a line to the second set of coordinates. 
 
Each following (connected) segment requires just one command. 
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Line To draws a line to the next set of coordinates. 
 
The End Line command terminates a line. 

Lines 

To draw a line from within the User-Defined Data dialog box, select the 
Lines/ Polygons Data Class and the Reference Lines Object Type. Then enter 
the sequence of commands and coordinates needed to draw the line. Be sure 
to apply the End Line command to the last coordinates of the current line 
before starting another line. 
 
You can also draw the line directly in the Virtual Sky. 
 
1 Select Lines/Polygons in the Data Class box. 
2 Select Reference Line in the Object Type box. 
3 Click Close. 
4 CONTROL+click at the point you want to start the first line segment. 

Nothing appears in the display, but the starting point is recorded. 
5 CONTROL+click at the end of the first line segment.  

The second point is recorded and the first line segment is drawn.  
6 CONTROL+click to add additional line segments.  
7 To terminate one line sequence and start another, press SHIFT+CONTROL as you 

click on the first point in the new line.  
TheSky6 automatically adds the required End Line command to the first line. 

 
When the line is completed, you can open the User-Defined Data dialog box 
and verify that the line-segment coordinates fell exactly where you wanted 
(or change them if they didn’t).  
 
Every point in a line segment can have its own label. The label is placed next 
to the point. If you’d rather have the labels elsewhere, you can add them as 
separate objects. 

Polygons 

You can’t draw a polygon directly on the screen, or enter polygon points in 
the User-Defined Data dialog box. You must draw a closed shape, and export 
it to a Sky Database as a polygon. (See “More About the User-Defined Data 
Dialog Box” on page 138.) You don’t have to close the polygon precisely. 
When the lines are exported as a polygon, the coordinates of the last point are 
automatically changed to the same coordinates as the first point.   

Controlling What You Click On 

A data point can be placed anywhere in the Virtual Sky. However, if you’re 
drawing constellation lines or attaching labels, you probably want to click 
precisely on a star or deep-space object.  
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To do this, select either “Nearest star” or “Nearest non-stellar” from the 
Snap To box. When you click, the selected point “snaps” to the nearest star 
or non-stellar object within a few pixels of the point you clicked. If no object is 
close enough, the computer beeps. Try moving the cursor closer.  
When snapping is active, TheSky6 has to search its databases for the nearest 
object. It may take several seconds for the point to be marked.  
 
If an object has been selected by snapping, the object’s catalog name appears 
in the Snap To Object section of the User-Defined Data dialog box. 

More About the User-Defined Data Dialog Box 

The User-Defined Data dialog box has the following additional features. 


 The Delete Entry button removes the data item currently highlighted in 
the Contents list. Deletions cannot be undone. 

 The Remove All button erases the entire Contents list. Remove All 
cannot be undone. 

 The Add Entry button inserts a new data point at the end of the list. It has 
the Data Class, Object Type, Label, Command, and/or Magnitude 
currently specified. The default coordinates are 00.00.00, 00.00.00. After 
clicking Add, enter the correct coordinates. (Don’t forget to click the 
North or South radio button, depending on the hemisphere.) 

 All coordinates are assumed to be Epoch 2000.0. If your coordinates are 
for another epoch (1950, say), enter them as given, then click the Precess 
button. Type the epoch’s year in the From box, then click OK. TheSky6 
recomputes them for Epoch 2000.0. 

 The Precess dialog box provides a convenient way to convert coordinates 
from one epoch to another. Type the From coordinates in the 2000.0  

 Coordinates edit boxes. Click Precess, and then enter the appropriate 
From and To dates. Click OK, then read the converted values in the edit 
boxes.  

 Clicking the Center button immediately centers the Virtual Sky at the 
coordinates of the currently selected data point. You don’t have to exit the 
dialog box for this change to take effect. 

 Export To Text File is used when creating a compiled database. It’s 
explained in “Chapter 15 Custom Databases” 

Adding Ellipses 

TheSky6 lets you add elliptical user-defined data objects that represent non-
stellar deep-sky objects. 
 
1 Zoom to an angle of view of 10° or less. Ellipses cannot be added at fields 

wider than 10°. Choose a field of view that’s a little wider than the ellipse 
you intend to draw. 
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2 Center the display at the coordinates you want to be the center of the 
ellipse. You don't have to be exact. You can reposition the ellipse later.  

3 Press CONTROL+F7. An ellipse appears in the Virtual Sky. 
4 Drag the ellipse’s control points to alter its size, shape, angle, and 

position. The control points along the width adjust the minor axis. The 
control points along the length adjust the major axis and the angle of 
rotation. The central control point repositions the ellipse. 

5 When the ellipse has the shape and position you want, press CONTROL+F7 

(CONTROL+F7) again. The ellipse turns a solid color that hides the objects 
behind it. (If Transparent Non-Stellar Fill is currently selected, the objects 
remain visible.) 

 
To change the ellipse’s Object Type or adjust its position, open the User-
Defined Data dialog box and highlight the ellipse in the Contents box. You can 
then select a different Object Type, or alter the coordinates.  
 
To delete an ellipse, highlight it in the Contents box, and then click Delete 
Entry. (You cannot delete an ellipse while the control points are visible. You 
must press CONTROL+F7 a second time to convert the ellipse to a user-defined 
data object, then open the User-Defined Data dialog box and delete it.) 
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Chapter 13 Star Charts and Tables 

 
TheSky6 can create star charts and tables for personalized study, or as a 
reference during observation. Charts can be sent to a printer, or copied to the 
Windows Clipboard and then pasted into other applications. Tables are saved 
as text files. This chapter describes the available chart and table formats.  

Printed Charts 

The Virtual Sky can be printed at any time with the Print command from the 
File menu (or the Print button from the Standard toolbar). 
 
The Print Setup dialog box controls most printing options. You can select the 
printer, paper size, paper source, and orientation. Click Properties to view or 
change the printer’s other settings. 
 
The Page Setup dialog box (don’t confuse it with Print Setup) controls the 
format of the star chart. Its functions are explained later in this section. 

Star Chart Format 

The section of the sky currently shown in the Virtual Sky is copied to the 
printer, using the same format as Chart Mode. (The exact area might vary 
slightly, due to the different aspect ratios of the display and the printer.) The 
main difference between the Virtual Sky and Chart Mode is that black and 
white are reversed – the sky is white, lines and objects are black. Objects are 
printed in color on color printers. If you mark the Spectral checkbox on the 
Options sheet of the Stellar Options dialog box, the stars are printed in those 
colors.  
 
See page 81 for a description of Chart mode, or select Chart Mode from the 
Options menu to see what it looks like.  
 
To see what will actually be printed, select Print Preview from the File menu. 
Click Zoom In for a more-detailed view. Click Close (or press ESC) to return to 
the Virtual Sky. 

Orientation 

The default orientation is Portrait. The image is oriented vertically (that is, 
with the short side of the Virtual Sky running along the long edge of the 
paper). Since Portrait orientation does not match the Virtual Sky’s format, 
part of the image has to be cut off. As shown below, Portrait orientation prints 
only the central ¾ of the screen. 
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Landscape orientation prints all of the Virtual Sky that’s currently visible, 
with its long side running along the long edge of the paper. To print in 
landscape, select Print Setup from the File menu, and then click the 
Landscape button. 

Changing the Printing Options 

The Page Setup command (Document Setup from the File menu controls the 
contents and format of a star chart. 

Title 

The text in the Title box is printed at the top of the chart. You’ll probably 
want to change the default (“TheSky6 © Astronomy Software”) to something 
that describes your chart. 

Format 

The format box selects the chart format. There are four choices. 

Standard 

The chart is a direct printout of the Virtual Sky. A optional legend – 
describing the symbols – can appear below the chart. 

Feature Object 

The same format as Standard, but the legend is replaced with data for 
a specific object. The default object is the last object you centered in the 
Virtual Sky. (See “Feature Object Information” below.) 
 
AAVSO 

American Association of Variable Star Observers standard format. 
 
List of Objects 

Not a star chart, but a list of all the chart objects, their symbols, visibility, 
magnitude limit, line and fill properties, and the filename of the symbol. (On a 
color printer, the line and fill properties are printed in their assigned 
colors.) The Title is not printed. The List of Objects works best with Portrait 
orientation. It might not print fully in Landscape. 
 
Chart Legend 

The Type box in the Legend section controls how much is printed. 
 
 None 

Nothing – other than the chart – is printed. Without the legend, the chart 
sometimes covers a larger area than shown in the Virtual Sky. 

 Small 
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Prints the time and date, display orientation and magnification, and a 
symbol key for all objects shown in the chart. 

 Detailed  
Prints the same items as Small Legend, plus a symbol key for star 
magnitudes  

 
The height of the legend box (in inches) can be changed by entering a new 
value in the Height edit box. The height is fixed. If the box is too small to hold 
the complete legend, the box is not enlarged to show any extra symbols.  
 
The Chart Legend setting in the Display Properties dialog box controls the 
font used in the Legend box. 

Margins 

Most printers can’t print to the edge of the paper. TheSky6 interrogates the 
printer driver to find the width of the printer’s physical margins. It formats 
the image so that it falls wholly within the margins. This keeps the chart from 
being cut off on one or more sides.  
 
You can set wider margins by entering values in the Margins edit boxes. 
Setting the Right margin to (say) 3" leaves a space suitable for notes. Or you 
can place a wide margin at the top, so that punching loose-leaf holes doesn’t 
remove a useful part of the chart. The margin you select is in addition to the 
printer’s margins. If your printer has an unprintable border of 0.2", and you 
set a margin of 1.3", the total margin is 1.5". A 0" margin prints right up to the 
printer’s limits.  

Using the Chart Space Efficiently 

To leave more room for the chart, the Small and Detailed legends show only 
the symbols that actually appear in the chart. You can take advantage of this 
by adjusting the height of the legend box so it’s no bigger than it has to be.  
(Use Print Preview to confirm its size.) The smaller the legend, the bigger 
the chart. The default orientation is portrait. Landscape might work better, 
depending on which objects are in the chart and the way they’re oriented in 
the sky. 
 
Star Chart Prefixes 

These prefixes are attached to catalog numbers printed with extended 
labeling. The New General Catalog is the lingua franca of astronomical 
catalogs, so no prefix is used. Variable stars have a unique symbol, so General 
Catalog of Variable Stars objects don’t need a prefix, either. The prefixes 
shown are the ones commonly used. You can change or delete them, if you 
wish. 
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Feature Object Information 

The data in this box come from the last object you centered. Any centering 
method works. 
 
 Clicking Center & Frame in the Find dialog box. 
 Clicking Center in the Object Information dialog box. 
 Using the Center command from the Virtual Sky’s pop-up menu. 
 
You can, of course, edit the Feature Object Information, or replace it with 
anything else. The Height setting controls the size of this box. 

Fonts 

Printer fonts are controlled by the Sky Chart Font settings in the Display 
Properties dialog box. 

How Much of the Virtual Sky is Printed? 

The printed chart is equivalent to a Full Screen view of the current display. If 
a legend is added to the printout, the image is slightly reduced in size, but still 
shows everything seen in Full Screen view. The full display is printed only in 
Landscape mode. Printing in Portrait mode cuts off the sides of the display – 
only the central ¾ is printed. However, if a group of objects or a constellation 
(such as Orion) is vertically oriented, Portrait mode makes better use of the 
chart space.  

Adding an Insert to the Star Chart 

Your star chart can include a more-detailed view of one section of the sky. 
Draw a zoom box around the desired area before using the Print command. 
 
The zoom box can have any aspect ratio. (If you want the zoom box to have 
the same aspect ratio as the display driver, press CONTROL as you drag.) If the 
zoom box doesn’t have the size, shape, or position you want, delete the box by 
clicking outside it anywhere in the Virtual Sky. Once you’ve drawn a zoom 
box, the Selected Area section of the Page Setup (Document Setup dialog box 
becomes active. There are three ways to plot the selected area.  
 
 Selected Small – The full Virtual Sky is printed, with the inset positioned 

so it doesn’t overlap the zoom-box area. 
 Selected Large – The area in the zoom box fills the entire chart. What 

would have been the full chart is reduced to fit the insert. 
 Selected Only – Only the area inside the zoom box is printed. 

Show Inset Origin 

When the “Show Inset Origin” checkbox is marked, the star chart includes a 
gray rectangle marking the area from which the inset was taken. The 
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rectangle does not hide the objects within it. (The example above shows this 
format.) 

The Chart Legend 

TheSky6’s logo is printed in the lower-right corner of the legend. There’s no 
direct way not to print it (other than not printing the legend at all). However, 
you can change it. Go to the Display Properties dialog box. Highlight Chart 
Legend and click Symbol. Click Edit, then Select. In the Select Metafile dialog 
box, pick the graphic you want to be the Chart Legend.  
 
The metafiles listed are in the symbols folder. The Select Metafile dialog box 
has no Browse control – if the symbol you want isn’t there, you have to copy 
it to the symbols folder. Most drawing programs include a selection of clip art. 
Simply load an image you like, and export it in Windows Metafile format. Or, 
if you can draw, create your own design.   

Printing Problems? 

“I clicked OK in the Page Setup or Document Setup dialog box, but the chart 
didn’t print.” 
The Setup commands only sets up the page format – you still have to select 
the Print command!  
 
“The inset didn’t print.” 
The inset’s zoom box must be displayed when you select the Print 
command. Did you accidentally remove it before printing? 
 
“The object label fonts printed are not the fonts shown on the display.” 
There are separate settings for Virtual Sky fonts and Sky Chart fonts. 
Check the Display Properties dialog box to see if the fonts you want are 
selected. 
 
“The chart prints, but it overflows the printable area.” 
The margins might be too narrow. Try setting wider margins. 
 
“The chart prints, but it doesn’t have as much detail as the Virtual Sky.” 
The margins might be too wide. Try setting narrower margins. 
 
“The printer reports a Memory Overflow error.” 
Some printers have special settings to prevent overflow. (Check your 
printer’s manual.) If your printer has variable resolution, lowering the 
resolution (for example, going from 1200 dpi to 600 dpi) might solve the 
problem. The ideal solution, of course, is to increase the printer’s memory. 
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“The chart takes a long time to print.” 
A detailed star chart requires a lot of information to be sent to the printer.  
Don’t be surprised if a chart takes several minutes to be printed. 

Adding Star Charts to Other Documents 

A star chart can be copied to the Clipboard as a vector-based metafile or a 
graphical bitmap, and then pasted into another application. A chart can also be 
exported as a disk file. You should be able to paste or import them into any 
program that recognizes these formats. Metafile charts are always created in 
“chart mode” – black lines against a white background – regardless of the 
current mode of the Virtual Sky.  

Copying a Star Chart to the Clipboard (Bitmap)  

1 Draw a zoom box if you want the chart to include an inset.  
If no zoom box is present, the entire Virtual Sky is copied. 

2 Select the Page Setup command from the File menu.  
The Page Setup or Document Setup dialog box appears. 

3 Select the formatting and features in you want. Click OK.  
4 Select the Copy As Bitmap command from the Edit menu, or press 

CONTROL+C. The star chart is now on the Clipboard as a bitmap. 

Copying a Star Chart to the Clipboard (Metafile) 

1 Draw a zoom box if you want the chart to include an inset.  
If no zoom box is present, the entire Virtual Sky is copied. 

2 Select the Page Setup command from the File menu.  
The Page Setup or Document Setup dialog box appears. 

3 Select the formatting and features in you want. Click OK.  
4 Select the Copy As Metafile command from the Edit menu.  

The star chart is now on the Clipboard as a metafile. 

Creating a Disk File of a Star Chart 

1 Draw a zoom box if you want the chart to include an inset. 
If no zoom box is present, the entire Virtual Sky is copied. 

2 Select the Page Setup command from the File menu.   
The Page Setup or Document Setup dialog box appears. 

3 Select the Export Star Chart command from the File menu.  
The Export Star Chart dialog box is displayed.  

4 Specify the type of chart to create in the Save as Type list box.  
 Placeable metafiles – Windows vector-based file format. 
 Bitmap – Device Independent Bitmap file format. 

5 Type the name you want for the file. Click Save.  
The .WMF or .BMP extension is added automatically. Unless you select a different folder, 
the file is written into the <My Documents>\Software Bisque\TheSky6\User\Exported 
Data folder. 

Displaying and Printing Uranometria 2000.0™ Charts 

 
The Find command can display the equivalent sky area of any Uranometria 
chart. Type URA nnn in the Find edit box, where nnn is the chart number. If 
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you’re printing a Uranometria-equivalent chart, additional information – such 
as coordinates and labels – must also be shown. This requires a plus sign (+) 
after the Uranometria chart number.  
 
URA nnn+ 
 

The following options are set or enabled for Uranometria charts. 
 
 Sky Orientation is set to Pole Up (Horizon coordinates). 
 The Equatorial Grid and Ecliptic lines are turned on. 
 Grid Spacing is set to High Density. 
 All catalogs are displayed. 
 The non-existent class of NGCs is turned off. 
 The magnitude limit is set to 10 for stars and to 15 for non-stellar objects. 
 Star, NGC, and IC labels are turned on. All others are turned off. 
 Extended labels for NGC, IC, PGC, GCVS, and PLN catalogs turned on. 
 Page orientation is set to Portrait. 
 Detailed legend is selected. 
 Vertical field height is set to 13°. 
 
Despite the “Uranometria 2000.0” designation, the current epoch is used – 
not Epoch 2000.0.  
 
Use the Print Preview command from the File menu to see what the chart 
will look like. To print the chart, select the Print command from the File 
menu, or click the Printer button in the Standard toolbar. 
 
The Virtual Sky settings for Uranometria simulation are retained until you 
manually change them, load a different Sky Document, or quit TheSky6. 

Exporting Star Charts (Professional Edition only)  

TheSky6 can be used to generate publication-quality star charts in magazines, 
bulletins, and web sites. Typically, publishers generate a star chart from 
TheSky6 to show a particular astronomical event, and then customize the star 
chart in image processing such as Photoshop™.  
 
The Export Star Chart Layers command allows you to output the Virtual 
Sky's screen elements (such as fonts, lines, or stars) to separate files (using 
the Windows Bitmap file format). These different “layers” can be imported 
into image processing software and manipulated to create completely 
customized stars charts that are suitable for publication.  
 
To export star charts in different layers, choose the Export Star Chart Layers 
command from the Print menu. In the “Screen Elements” list, define the 
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layer that you want the element to appear and then click the Export button to 
generate bitmap files of each layer.   
 
Bitmap files are saved to the <My Documents>\Software 
Bisque\TheSky6\Expored Data folder, using the prefix defined in the “File 
name” text box. The default file name is “Layer,” so exported bitmaps are 
named Layer01.bmp, Layer02.bmp, and so on. 

Screen Size 

It is often desirable to generate bitmaps of a particular resolution. Using the 
options in this group box, TheSky6’s screen size can be adjusted before each 
of the layer bitmaps are generated. 

Reset on Export 

Mark this option to have the screen size altered to the resolution entered 
under Width/Height when the layers are exported.  

Width/Height  

Enter the desired width and height of the window here. The maximum 
dimension that is allowed is the resolution of the current display. Setting the 
Width and Height to the same as the screen (such as 1024x768 or 1280x1024) 
causes TheSky6 to go into Full Screen. All of the menus and toolbars will 
disappear. The scroll bars must be turned off manually.  
 
All of the settings on the Export Star Chart Layers dialog box are saved in the 
Sky Document (page 125). This permits the user to save a separate document 
for each graphic they are working on with the preferred resolution and 
layering stored while the graphic is fine tuned for publication.  Another 
application is to have the parameters stored for a recurring graphic that will 
be updated monthly.   
 
A detailed description of each screen element is available in TheSky6’s Help 
file. Select the Contents and Index command from the Help menu, click in the 
Search button and enter “screen elements” to view this help topic. 

Software Bisque’s Copyright  

You may use star charts or generated by TheSky6 provided a suitable 
copyright statement accompanies the chart(s). 
 
Sample copyright statement  

“Star charts generated by TheSky6 copyright © Software Bisque, Inc. All 
rights reserved. www.bisque.com.” 
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Data Wizard – Exporting Data 

TheSky6’s Data Wizard is a powerful tool for working with the numerous data 
types present in TheSky6. With the Data Wizard, you can perform many 
different tasks such as:  
 
 Create custom reports of various celestial objects properties. Examples 

include creating a list of all large and bright galaxies and nebula currently 
above the horizon, or show me all NGC objects in the constellation Orion, 
sorted by size.   

 Create ephemeredes of solar system objects such as “show me the rise 
and set times of all planets for each day of the month,” or “what 
interesting objects are out tonight?” 

 Scroll through data lists and display pictures of objects as they are 
highlighted. For example you could create a list of all galaxies larger than 
10 arcminutes in size, then sort them by size. Using the Frame Object 
option, show a picture of each one as the list is scrolled.  

 Generate Observatory Scripts for use with Orchestrate such as extracting 
the coordinate data from the Mosaic tool and creating a script that will 
take a CCD Image at each position.  

 Export data to a text file or to the clipboard.  
 Draw paths between the objects in a data list.   
 Label objects in a data list.  

Data Queries 

A data query is a set of instructions that direct TheSky6 to search selected 
databases for the requested information. Each query consists of a number of 
parameters that will determine the output.   
 
These parameters include the following. 
 
 Where to search for the data? Searches can be confined to only objects 

currently on the display or to entire catalogs of objects.   
 What object types should be included in the search (for example, nebula, 

galaxies, open clusters)?  
 What attributes must the objects have to be included in the report 

(magnitudes, angular sizes, etc.)?  
 What attributes should be included in the report? (For example, show 

magnitude, size and equatorial or horizon-based coordinates)  

Object Attributes 

Each celestial object type has some number of attributes that are available for 
reporting. Some attributes such as coordinates and magnitude are common to 
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many object types, while other attributes such as “Satellite range” are 
applicable only to a single object type.   

Creating a New Query 

One way to learn about Data Queries and Reports is to start with queries 
supplied with TheSky6 and make incremental changes to them, each time 
running the query to see how the changes effects the report. 
 
The Data Wizard command provides options for defining custom database 
queries.  
 
TheSky6 comes with several predefined database queries in the My 
Documents\Software Bisque\Database Queries folder. 

Running a Query 

To run a database query, select the Run command from the Query menu, 
click the Run button.  The time required to complete a query depends on the 
size of the selected databases and the complexity of the query. While the 
query is running, a progress indicator appears at the bottom of the Query 
Results dialog box.   
 
The Run button text changes to Abort while the query is running to allow the 
termination of the query. If the attribute filters include items that must be 
computed or items that are in external databases, the query run time is 
greatly increased.   
 
For example, a query on the 7,840 objects included in the NGC catalog based 
on the size (major axis) of the objects will be completed very quickly, but if 
the attribute filters include a text comparison of the constellations, more disk 
access is required and the query will take considerably longer. On larger 
databases such as the entire PGC catalog of nearly one million objects, 
queries can take several minutes to complete and longer on slower 
computers.  

Time and Database Queries 

The Data Wizard contains a vast number of options, so the results of a query 
may seem incorrect until you examine the interaction of the various filters.  
 
This is especially true when the filters are time dependent, like Altitude and 
Azimuth and Transit time. If you run a query that passes only those object 
times with a Transit time greater than 20 hours (8:00 p.m.) or a Transit time 
less than 2 hours (2:00 a.m.) then you would expect a list of objects centered 
near the Meridian. If you add the filter “Altitude greater than 25 degrees”, the 
results may be confusing if the query is run with the current time set to 10:00 
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a.m. At 10:00 a.m., none or very few of the objects that transit between 10:00 
and 2:00 a.m. will be above 25 degrees, and the list may be empty. 
 
Therefore it is a good idea to place the Time dialog box (page 15) on screen 
when running a query so that you can select the desired time.  

Frame Object 

Mark this option to center the selected objects (in the Object Name report) 
on the Virtual Sky.  

Show Information 

Mark this option to show the Object Information dialog box for the selected 
objects. 

Objects Found 

Lists the number of objects located by running the current database query.  

Run/Abort 

Click this button to execute the current database query. The button's text 
changes to Abort while queries are in progress. Click Abort to end the query. 

Example Data Wizard Query  

Before using the Data Wizard, you need to ask yourself, “What information do 
I need?” The answer to this question will help you define your query and get 
what you want.  
 
As an example, suppose your research project tonight is to search for 
supernovae in spiral galaxies in the NGC catalog that are fainter than 16th 
magnitude. You live in a light polluted area, so you know that an altitude limit 
of 45º is required to reach fainter objects. You need to setup a script that 
slews a telescope to each of these objects tonight so that you can take a CCD 
image of each galaxy.  
 
Here’s how to use the Data Wizard to create this query. 
 
1 Select the Time command from the Data menu.  

Set TheSky6’s time to the time you’ll be observing. (You’re hoping to start 
imaging tonight at 11:00 p.m., so set the time for then.) 

2 Select the Data Wizard command from the Tools menu.  
The default Data Wizard dialog box shows Untitled.ddq (the .DBQ 
extension is short for database query file) in the caption indicating that 
there are no queries currently loaded. If a query is loaded previously, 
select the New command from the Data Wizard dialog box File menu to 
start a query from scratch. 
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3 Select the Edit Parameters command from the Query menu. 

The Editing: Untitled.dbq dialog box appears.  
 

 
 

 In the Query Description text box, enter the text “NGC Spiral Galaxy 
Search.” 

 Click “Limit Only By Attribute Filter” option. This forces TheSky6 to 
search in all of the selected databases. The “Only on the Virtual Sky” 
option searches only the objects on the Virtual Sky. 

 Clear the “Run Query Multiple Times” option. This option applies 
when you’re generating an ephemeris-type query (such as the Moon’s 
rise time for a month). 

 Enter 0.0 in the “Maximum (arcminutes)” text box to include all 
objects found. Entering 15, for example, if the field of view of your 
instrument is 15 arcminutes and you want to only locate those objects 
that are greater than 15 arcminutes apart. 
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 Specify the desired format for the output report, as degrees or hours, 
minutes, seconds or decimal degrees. 

4 Click the Object Types and Databases tab.  
 

 
 
Set the following options on the Object Types and Databases tab. 
 Mark the Spiral Galaxy option from the Select Object Types section. 
 Mark the NGC option from the Non-Stellar section. 
TheSky6 will now search for spiral galaxies in the NGC catalog. 

5 Click the Attribute Filter tab. 
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For this example, we want to limit the magnitude of the spiral galaxies to 
greater than 15 and limit the altitude (a time-dependent parameter) to 
greater than or equal to 45º. These are both “floating point” type values. 

a Select Altitude from the Floating Point Values node in the 
Attribute List. 

b In the Current Filter group, select Greater Than Or Equal To from 
the Compare list. 

c Enter 45 in the Value text box. This is for the 45º-altitude limit 
we’ve defined. You can enter any value here. 

d Click the Add Filter button. 
1. The text “(Altitude >= 45)” in the Existing Filters 

should appear. 
e Select Magnitude Floating Point node in the Attribute List. 
f In the Current Filter group, select Greater Than from the Compare 

list.  
g Enter 16 in the Value text box. This is for the 16th magnitude limit. 
h Click the Add Filter button. 

The text “(Magnitude > 16) and (Altitude >= 45)” in the Existing 
Filters should appear. 

 
Use the Combine list box to specify how to logically combine different 
filter attributes. 

6 Click the Report Columns tab. 
 

 
 
The Report Columns tab lets you specify what information appears in the 
query report. (The Object’s Name is always included and cannot be 
removed from the list.)  
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a Open the Floating Point Values node in the Attribute list. 
b Mark the RA (current epoch), Dec (current epoch, Altitude and 

Magnitude options. 
Click OK to close the Editing dialog box.  
 
It’s always a good idea to save your query before running it, so select the 
Save As command from the File menu on the Data Wizard dialog box, enter 
“NGC Spiral Galaxy Search” and then click OK. 
 
Now comes the payoff. Click Run to start the query. 
 

 
 
The above report shows the 35 spiral galaxies from the NGC catalog at or 
above 45 degrees altitude for a specific date and time.  
 
Frame Object 

To view any object in a Data Wizard report, click the Frame Object option and 
then select the desired object name in the list.  
 
Show Information 

To view detailed information for any object in a Data Wizard report, click the 
Show Information option and then select the desired object name in the list. 
 
Sorting Report 

Click on the column header to sort the data by that parameter. 
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We can now export this data in a format that can be used by Orchestrate (or 
other automation software) to slew the telescope to these objects.  
 
1 On the Data Wizard dialog box, select the Export command from the Data 

menu. 
 

 
 
a Mark the Text File option, then click the Browse button to specify the 

name of the text file to store the data. 
b Mark the Export As a Script option to export the data in a format that 

is compatible with Orchestrate. 
c Click the Export button. 

 
The following shows the first few lines of the Orchestrate script. 
 
SlewToObject, NGC 3975,  11.93595  60.50588 
SlewToObject, NGC 5503,  14.16214  60.38612 
SlewToObject, NGC 5502,  14.16214  60.38612 
SlewToObject, NGC 2473,   7.93224  56.72965 
SlewToObject, NGC 2472,   7.98409  56.69405 
SlewToObject, NGC 2457,   7.91844  55.54048 
SlewToObject, NGC 2603,   8.58689  52.79331 
SlewToObject, NGC 2762,   9.17028  50.40415 
SlewToObject, NGC 4549,  12.59312  58.92473 
 
Better get to work! 

Sun and Moon Report 

The Sun and Moon Report command from the Tools menu displays a scrolling 
text window with the following data for each day of the current month.  
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 Moonrise, Moonset times (for the current horizon) 
 Sunrise, Sunset times (for the current horizon) 
 Beginning twilight time 
 Ending twilight time 
 
These data are discarded when you click Close. However, you can select any 
or all of the text in the window, copy it to the Clipboard, then paste it into a 
text editor or word processor. 
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Chapter 14 The Sky Database Manager 

 

Several Sky Databases are supplied with TheSky6, and you can create any 
number of your own. Of course, you wouldn’t normally load every available 
database at the same time – the more databases in use, the longer TheSky6 
takes to search for objects and redraw the screen. 
 
The Sky Database Manager controls which databases (.SDB files) are loaded 
when TheSky6 runs, and which of the loaded databases are actively searched. 
You can enable or disable databases, and load or unload them, even while 
TheSky6 is running. 
 
1 Select Sky Database Manager from the Data menu. 

The Sky Database Manager dialog box appears. 
 

 
 
2 To unload a database, highlight its name in the File List box and click Remove. 

The database is either removed from memory, or its file is closed. It is not deleted from the 
hard disk. Click OK to return to the Sky Database Manager dialog box. You can select more 
than one database. To select a range, click on the first, then press SHIFT as you click on the 
last. To select (or deselect) individual databases, press CONTROL as you click on their names. 

3 To load a database, highlight its name in the upper list box. 
If the database does not appear in the box, use the browse controls to locate it. You can 
select more than one database. To select a range, click on the first, and then press SHIFT as 
you click on the last. To select (or deselect) individual databases, press CONTROL as you click 
on their names. 

4 Click Add to add the database to the File List box. 
Repeat Steps 2 and 3 to load additional databases. 

5 Click OK. 
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Loading a database automatically activates it. Its checkbox will be marked. 
 
To enable or disable databases that are already loaded: 
 
1 Select Display Explorer from the View menu. 

The Sky Databases box shows which databases are currently loaded or open. Each database 
has a checkbox. Active databases are marked, inactive databases are clear. The name of a 
database is the Identifier you supply when you compile a database –  not the file name of the 
database.  

2 Navigate to the Sky Databases node. 
3 Mark the checkboxes of those databases you want to activate. 
4 Clear the checkboxes of those databases you want to deactivate. 

Inactive databases remain open, or loaded in memory, but are not displayed or searched.  

Searchable Databases 

A database is searchable only if one of the fields in its records is marked as a 
Find field. If a searchable database is loaded and active, its Identifier is listed 
in the Databases section of the Find dialog box. See “Chapter 15 Custom 
Databases,” for a description of database Identifiers and the Find field. 
 

Specialized Databases 

TheSky6 comes with an interesting selection of specialized databases. 
 
Abell Galaxy Clusters 

A catalog of over 2700 clusters of galaxies commonly used in astronomical 
research. 
 
Arp Peculiar Galaxies 

Dr. Halton C. Arp’s catalog of 330+ peculiar or interesting galaxies, such as 
groups or interacting pairs of galaxies. It was compiled from the Palomar 
Sky Survey photos. 
 
Binocular Asterism 

Small asterisms best seen with binoculars or low-power telescopes. Displayed 
at field widths of 50° or less. 
 
Bright Nebula 

A detailed isophote drawing of the region around the Eagle nebula. Displayed 
at field widths of 50° or less. 
 
Covington Databases 

Database of miscellaneous objects compiled by astronomer/author Michael 
Covington. 
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Galactic Globule (“Galactiglob”) 
Clusters of 10 or more galaxies, brighter than magnitude 16, within a 50' field. 
Nearly 3000 previously uncatalogued galaxies are included. 
 
Meade Alignment Star 

Thirty-three alignment stars used with Meade LX200 telescopes. 
 
Navigational Star 

The names of 58 stars commonly used in navigation. 
 
Palomar Globulars 

A database of 15 globular clusters from the Palomar Sky Survey photos. 
 
Celestial Pole Indicators 

Indicate positions of true celestial poles (north and south). 
 
Popular Asterism 

Constellation lines for the most-popular constellations. 
 
RealSky North 
RealSky South 
RealSky North & South 

The center coordinates of the plates used to create the RealSky CD ROMs. 
When you click on one of these points, the Object Information dialog box 
displays the year in which the plate was taken, the plate identifier, and the 
source of the image. 
 
Shower Radiants 

Coordinates of the radiant for 64 annual meteor showers. The peak date and 
zenith hourly rate are also supplied in the Object Information dialog box. 
 
Supernova 

The positions of all supernovas discovered to date. 
 
Terzian Globulars 

11 globular clusters compiled by astronomer Yervant Terzian. 
 
Trapezium 

Adds additional stars to the Trapezium in the Great Nebula of Orion. 
 
Zwicky 

The Zwicky Catalog of Galaxy Clusters contains 9134 clusters of galaxies 
from the Palomar Sky Survey, compiled by Fritz Zwicky. 
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Chapter 15 Custom Databases 

Astronomical software usually comes with just one set of databases, and the 
software can access only that data. Databases in different formats can’t be 
read, and there’s no easy way to create custom databases. 
 
TheSky6 is different. It can read and display almost any text database, 
regardless of its source. You can also design custom databases to meet your 
own observational needs, or to add objects not in TheSky6’s databases. And 
you can create your own symbols to associate with these objects. 

Database Requirements 

An astronomical database must meet several requirements. The most 
important of these is that it’s written in plain text. That is, you can print 
it out and read it directly – as in the example below.  

 
Algol   SAO 38592  3.135833  40.955556 
Betelgeuse  SAO 113271  5.919519  7.406944 
Castor  SAO 60198  7.576389  31.888056 
Deneb   SAO 49941  20.690000  45.280000 
Fomalhaut  SAO 191524  22.960833  -29.622222 
Mizar   SAO 28737  13.398333  54.925278 
Peacock  SAO 246574  20.427222  -56.734722 
Rigel   SAO 131907  5.241944  -08.201389 
Sirius  SAO 151881  6.752222  -16.716111 
Thuban  SAO 16273  14.072778  64.375556 
Vega   SAO 67174  18.615556  38.783611 

 
Celestial data are usually distributed as plain-text (ASCII or ANSI) files, as 
these can easily be read or modified with any text editor. The NASA CD ROM 
of selected astronomical catalogs and the IAU listings of minor planet  
ephemeridae are examples of such databases. TheSky6 includes over 40 
catalogs of database text files, along with their compiled Sky Databases. 
There are several other “common-sense” format requirements. Almost every 
text database meets them. 
 
 Each data record must be on a separate line. 
 Lines must be separated by “hard” carriage returns. (A hard return is 

created when you press ENTER or RETURN.) 
 The data in each record must have a consistent format – each field must 

be in the same position on each line. (Lines can vary in length, though.) 
 Each object must have equatorial or horizon coordinates. (Otherwise, 

TheSky6 won’t know where to plot it.) 
 
Since there is no standard database format, TheSky6 needs to know what type 
of information the database contains, and where it appears in each record. 
The Import dialog box is a convenient interface for entering this information. 
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Or you can supply format information in a “header” section of the file. 
 
Importing Databases 
 
You should be able to import any text-format astronomical database that 
meets the requirements listed above and then compile it to a Sky Database 
(.SDB) file. (The only “practical” requirement is that each record be limited to 
1500 characters.) Follow the steps below. 
 
1 Select the Import command from the Data menu.  

 
Or press ALT+C. The Import dialog box appears. 
 

 
 

2 Click Browse.  
The Open dialog box appears.  

3 Highlight the name of the file you want and click Open.  
Or just double-click its name. TheSky6 has several text databases in the 
user\SDBs subfolder. You can load one of these to see how database 
compilation works. 

4 In the Identifier edit box, enter a unique name for the database.  
The name can be up to 50 characters, including spaces and punctuation. 
This name will appear in the Sky Database Manager dialog box. Duplicate 
Identifiers cause no harm – but you’ll have to study their descriptions in 
the Display Explorer to tell them apart.  

5 Select the Data Class of the objects in the file.  
6 Select the Object Type.  
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If you select Objects/Points, you must also select an Object Type. This 
type becomes the default type for the database. If the text database 
includes the Software Bisque header data, the Data Class and Object Type 
are read from the header and automatically selected. (The header format 
is described later in this chapter.) If you selected Labels or 
Lines/Polygons, the Object Type doesn’t matter.  

7 If the coordinates are not Epoch 2000.0, enter the correct epoch.  
Epoch 1950.0 or 2000.0 can be selected by clicking the spin button. You 
can also manually enter any year between 1000 CE and 3000 CE. 

8 Mark the “Horizon-based coordinates” checkbox if the data file 
does not use equatorial coordinates.  
Astronomical databases are of celestial objects, and therefore use 
equatorial coordinates. Horizon coordinates are normally used only when 
adding reference lines or labels keyed to a specific observation site (for 
example, a reference point that marks the coordinates of an annoying 
street light).  

9 Mark or clear the “Load to memory” checkbox, as required.  
If you want the SDB to be loaded into computer memory (RAM), mark this 
checkbox. This setting should be used for small databases – those with 
less than 4,000 or 5,000 objects. It gives the fastest searching and plotting, 
but places the greatest demand on system resources. If you want the SDB 
to be an optimized disk file which TheSky6 can access (but isn’t loaded 
into memory), clear this checkbox. This format is best for large databases 
(those over 5000 objects) that require too much RAM to load. 
 

You’re now ready to tell TheSky6 how to interpret the data in the text file. 
 

1 Click Define Fields.  
The Field Definition dialog box appears. The first 80 database entries are 
displayed in the bottom window. The columns are numbered across the 
top. 
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2 Highlight the columns with the RA coordinates.  
There are three ways to do this. 
 Drag the mouse from the first (left-most) column to the last (right-

most) column. 
 Click on the first column. Then press SHIFT and click on the last column. 
 Click within the Columns edit box. Enter the numbers of the first and 

last columns, separated by a dash (–). 
3 Click RA Hours.  

This defines the field that will be read as right-ascension hours.  
4 Repeat Steps 2 and 3 for RA Mins and RA Secs.  

If the right ascension is given as a single decimal value, you don’t need to 
define RA Mins and RA Secs.  

5 Repeat Steps 2 and 3 for the Dec Sign, Dec Degs, Dec Mins, and 
Dec Secs.  
If the declination is given as a single decimal value, you don’t need to 
define Dec Mins and Dec Secs. The Dec Sign can be plus or minus signs 
(+ or –), or the letters N or S. 

 
 Alias The common name or database identifier of a sky object that 

the multimedia file in this record is to be associated with. (See 
Chapter 16, “Image and Multimedia Databases.”)  

 File Name The name of a text, image, audio, or video file, for 
databases of text, pictures, sounds, or movies. The full path is not 
needed, because TheSky6 assumes the file is in the same folder as 
the .SDB database file. (If TheSky6 can’t find the file there, it looks 
in the pictures folder.)  

 Find The search index. This field must be included if the database 
is to be searchable, and appear in the Databases list of the Find 
dialog box.  
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 Magnitude The magnitude of a star (or any object for which a 
magnitude is appropriate).  

 Maj[or] Axis The major axis of an extended object, in arcminutes. 
 Min[or] Axis The minor axis of an extended object, in arcminutes.  
 Obj[ect] Type Databases normally have a single predefined type, 

which is the default. However, a database can include objects of up 
to nine types. This column defines the eight non-default types. 

 Pos[ition] Angle The angle of the major axis of an extended object. 
It is measured counter-clockwise from the North Celestial Pole. 

 
These optional fields are associated with a range of columns in the same way 
the required coordinate fields are. You highlight the columns with the data, 
and then click the corresponding button. There are also eight user-defined 
User Fields, which can be associated with user-supplied data. Their data 
appear in the Object Information dialog box.  
 
They also appear in the Virtual Sky when Extended Labeling is turned on. To 
see which columns are associated with a field, press SHIFT and click that field’s 
button (Required, Optional, or User). The Columns edit box shows the 
columns (0-0 means there is no association), and the data columns are 
highlighted in the display.  
 
To remove an association, make sure no columns are selected. (Click in an 
“empty” area of the dialog box. The columns edit box should read 0-0.) Then 
click the button for that field. The Verify dialog box asks if you want to “Clear 
column information?” Click Yes to remove the association. You’re now ready 
to compile the database. 
 
1 Click OK to exit the Field Definition dialog box.  
2 Click Compile.  

The compilation time depends on the file size and your computer’s speed.  
3 When compilation is complete, a dialog box prompts, “Add to Auto 

Load Database List?”  
Clicking Yes adds the new database to the list that appears in the Sky 
Database Manager, and makes it active. You can use it immediately, 
without restarting TheSky6. It will be automatically loaded the next time 
you run TheSky6. Clicking No does not add the new database to the list. 
The database is available during the current session, but it is not loaded 
the next time you run TheSky6. 

Sky Database Limitations 

An individual Sky Database (SDB) can hold over 100,000 objects. TheSky6 can 
accommodate up to 200 SDBs at a time. How closely you can approach both 
these limits depends on your computer’s resources (principally, the amount of 
free RAM). 
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Creating Custom Databases 

An amateur pursuing the 400 Herschel objects has different requirements 
from a comet hunter trying to identify every faint, fuzzy patch. Sky Databases 
(.SDB files) provide an elegant way to meet the varying needs of the 
computer-aided astronomer. Custom-database objects can be plotted, printed, 
searched for, and identified, just like the objects in the databases supplied 
with TheSky6. 
 
Although hundreds of SDBs can be open at one time, and an SDB can contain 
over 100,000 objects, SDBs are for customizing TheSky6, and intended to be 
relatively small. 
 
The following suggestions should help in designing a database that’s easy to 
set up and maintain. 
 Think about what you want to put in the database – and what you want to 

leave out. Don’t include data you’re not likely to use.  
 Every record must have the same format – but records don’t have to be 

the same length. Comments should be placed at the end of each record, 
where they can be of any length (within the 1500-character limit).  

 Databases with a single type are usually easier to set up and maintain. If 
you include more than one type, remember that the limit is nine types. 

 

Optional Header 

In addition to the data records, the text file from which a Sky Database is 
compiled can contain an optional header that specifies the database format. 
 
>IDENTIFIER Common Star Names 
>CATALOG CLASS = LABELS 
 
>OBJECT TYPE 0 
>LOADMEMORY 
>LABEL 1,20 
>ALIAS 22,33 
>RAHOURS 35,43 
>DECDEGREES 44,54 
Acamar SAO 216112 2.970556 -40.304167 
 
The header is the set of lines starting with right angle brackets (>). Lines 
starting with semicolons (;) are comments. The compiler ignores them.  
 
The header information can be entered in the Import and Field Definitions 
dialog boxes, of course. However, the header format is worth learning and 
using, for these reasons: 
 
 A text file with a header is immediately ready to compile.  
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 You can create or edit a database on any computer with a text editor –  you 
don’t need TheSky6 to set up the formatting.  

 
The header commands must come before the data, but they can appear in any 
order. However, you’ll probably want to order them as shown in the example, 
with the “general” commands first. The field definitions follow, in the same 
order they appear in each record. 
 
The header commands are listed in the table below, with examples. 
 

Header Command Parameter Example 
>ALIAS starting and ending columns of common name or database 

identifier a multimedia object is associated with 
 

44,55 

>BRUSH COLOR 
 
 

the fill color of an object R=000 G=099 B=128 

>CATALOG CLASS  the type class of the database  LABELS 
>DECDEGREES  
 
 

starting / ending columns of declination degrees  1,2 

>DEC X  
 

declination degrees multiplier  1.0 

>DECMINUTES  
 

starting / ending columns of declination minutes  4,5 

>DECSECONDS  
 

starting / ending columns of declination seconds  7,8 

>DECSIGN  
 

starting / ending columns of declination sign  3,3 

>HORIZON 
COORDINATES  
 

No parameter required. Indicates coordinates are Alt-Az.  

>IDENTIFIER  
 

text description of the data  Herschel Objects 

>LABEL  
 

starting / ending columns of data labels  50,70 

>LOADMEMORY 
 

No parameter required. Indicates file should be loaded to 
memory. If not present, file is read from disk.  

 

>MAGNITUDE  
 

starting / ending columns of object magnitude 20,25 

>MAGNITUDE  X magnitude multiplier  10.0 

 
Header Command Parameter Example 
>MAJOR AXIS 5 starting / ending columns of object major axis  30,3 
>MAJOR AXIS X  major axis multiplier  10.0 
>MAX PLOT ANGLE  
 

the widest angle at which objects can be displayed 50 

>MIN PLOT  ANGLE the narrowest angle at which objects can be displayed  42 
>MINOR  AXIS starting / ending columns of object minor axis  40,45 
>MINOR AXIS X  minor axis multiplier  1.0 
>OBJECT TYPE  Index number of object type  1=variable star, etc. 
>PARSE  Up to 8 additional data fields can be added.  PARSE “Color” 1,7 

PARSE “Name” 14,24 
>PEN COLOR  the outline color of an object  R=256 G=064 B=110 
>POSITION ANGLE  starting / ending columns of object position angle 50,55 
>POSITION ANGLE X  position angle multiplier 1.0 1.0 
>RAHOURS  starting / ending columns of right ascension hours 1,2 
>RA X  right ascension hours multiplier 0.0666667 
>RAMINUTES  starting / ending columns of right ascension minutes  3,4 
>RASECONDS  starting / ending columns of right ascension seconds  5,6 
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>SEARCH starting / ending columns that Find command can 
search for information 
 

1,108 

>XREF DATABASE Cross reference to an object in an existing database.  
Information is displayed from that database, not the Sky 
Database one.  

SIRIUS 
SA01024 

>XREF PURE cross-reference of one object to a multimedia object without 
reference to coordinates 

MARS mars_1.gif 
NGC2231 ngc2231.txt 

 
The header commands are largely self-explanatory. A few need a bit more 
explanation. 
 
 >DECMINUTES, >DECSECONDS, >RAMINUTES, >RASECONDS –  If right 

ascension or declination is given as a single decimal value the 
corresponding entries are not needed.  >DEC X, >RA X – If right 
ascension or declination is given as a single decimal value, the multiplier 
applies to the full value – not just the integer part. 

 >DECSIGN The sign of the declination does not have to be separate entry 
– it can be part of >DECDEGREES. However, for ease of reading and 
editing, some users reserve a separate column for the sign. The 
declination sign is usually a plus or minus sign (+ or –). It can also be the 
letters N or S.  

 >HORIZON COORDINATES – Astronomical databases are of sky objects, 
and therefore use equatorial coordinates. This command lets you create a 
database of site-specific reference points or lines. Altitude values are 
entered as if they were right ascension, azimuth values as if they were 
declination. 

 >LOADMEMORY – A compiled Sky Database can be either a disk file that 
TheSky6 opens and reads as required, or a binary file that is loaded into 
RAM for immediate access. The disk file is the default. The  
>LOADMEMORY – command tells TheSky6 to create a memory-resident 
binary file.  

 >OBJECT TYPE – This number corresponds to the position of the object 
type in the Display Explorer dialog box. Please refer to page 246 for a list. 

 >PARSE – The >PARSE command creates user-defined data entries by 
defining their names and fields. These appear in the Object Information 
dialog box. 

 >SEARCH – Specifies the range of columns that can be searched by the 
Find command. Data outside these columns cannot be located with the 
Find command.  

 >XREF DIRECT – References an object (by name or catalog number) that 
already exists in another catalog. The data for that object are taken from 
the other catalog or database, not the current database.  

 >XREF PURE – Associates an object (by name or catalog number) that 
already exists in another catalog, with another object (star, text file, 
picture, sound, movie). Because the first object is already defined, 
coordinates are not needed. 
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There is no header command to specify the epoch. Therefore, all coordinates 
in a given SDB must be from the same epoch. Before compiling, be sure the 
correct epoch (1950.0 or 2000.0) is selected in the Import dialog box. The 
Precess button in the User-Defined Data dialog box (page 135) can perform 
the conversion for you.

Database Types 

In general, a Sky Database (SDB) contains objects of only one type. The type 
classes are: 
 
 Objects/Points  
 Labels  
 Lines/Polygons 
 
Each class has its own characteristics, described in the following sections. 
 
Objects/Points Class 

The Objects/Points class is primarily used to add celestial objects – stars, 
galaxies, clusters, comets, nebulae, special symbols, and so forth. It’s also 
used to place reference points.  
 
You can select any object type that appears in the Display Properties dialog 
box, including user-defined types. (These are described later in this chapter.) 
 
Clicking on an Object/Point symbol displays the Object Information dialog 
box. The usual data are displayed for objects. Reference points are called user-
defined points and are numbered: user-defined point #1, user-defined point #2, and so 
on. Possible uses for an Objects/Points SDB include 


 images not supplied with TheSky6.  
 new coordinates for objects that are not positioned correctly in any of 

TheSky6’s databases.  
 reference points for useful coordinates (such as the Celestial Poles), or 

objects you often observe. 
 
Labels Class 

The Labels class adds descriptions, titles, or labels to the display. No symbol 
is shown in the display, other than the label itself. Clicking a label displays the 
Object Information dialog box, but nothing about the label is listed – the label 
itself is the information.  
 
A Labels database is most-often used to label objects that aren’t already 
labeled. It can also be used to rename objects, or provide captions in a 
different language. 
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When a Label database is loaded and active, its contents are automatically 
displayed when Common Names labels are turned on. If labels are displayed 
that you don’t want to see, use the Sky Database Manager to deactivate (or 
unload) their database. 
 
Lines/Polygons Class 

The Lines/Polygons class adds reference lines and colored areas (“filled 
polygons”) to the display. Unlike the Objects/Points and Labels classes, lines 
and polygons are not objects as such, but instructions that specify where lines 
and polygons are drawn. 
 
As with labels, clicking on a line or polygon displays the Object Information 
dialog box, but nothing about the line or label is listed – the line or polygon 
itself is the information. If you need to display information, add an object near 
the line or within the polygon. 
 
Possible uses for a Lines/Polygons SDB include: 
 reference lines, such as site obstructions. 
 new constellation outlines. 
 nebulae not currently in TheSky6’s SDBs. 
 
There are three line commands and three polygon commands. 
 
 Move To – Terminates any preceding line and specifies the starting point of 

a new line. All lines begin with a Move To command. 
 Line To – Draws a line from the preceding Move To or Line To coordinates 

to the coordinates given in this Line To command.  
 End Line – Draws a line from the preceding Move To or Line To 

coordinates to the coordinates given. The line terminates at this point. 
 Poly Beg – Specifies the starting point of a new polygon.  
 Poly Point  – Draws a line from the preceding Poly Beg or Poly Point 

coordinates to the coordinates given in this Poly Point command. 
 Poly End - Specifies the end point of a polygon. If the Poly End coordinates 

do not match the Poly Beg coordinates, the database compiler forces them 
to match, so that the polygon closes.  

 
Here are two examples of the line and polygon commands. The first draws 
the familiar “Big Dipper” asterism. (The SAO star numbers are included for 
reference but aren’t needed to draw the lines.) 
 
1 MOVE TO SAO44752 13.79233333 49.31305556 
2 LINE TO SAO28738 13.39877778 54.92138889 
3 LINE TO SAO28553 12.90046389 55.95944444 
4 LINE TO SAO28315 12.25707500 57.03222222 
5 LINE TO SAO15384 11.06209167 61.75055556 
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6 LINE TO SAO27876 11.03068611 56.38194444 
7 LINE TO SAO28179 11.89714722 53.69444444 
8 LINE TO SAO28315 12.25707500 57.03222222 

 
The second uses polygon commands to fill the “ladle” of the Big Dipper. 
 
9  POLY BEG   SAO28315 12.25707500 57.03222222 
10 POLY POINT SAO15384 11.06209167 61.75055556 
11 POLY POINT SAO27876 11.03068611 56.38194444 
12 POLY POINT SAO28179 11.89714722 53.69444444 
13 POLY END   SAO28315 12.25707500 57.03222222 
 

Line color is controlled by the Line color of Reference Lines. Fill color is 
controlled by the Fill color of Reference Lines. Use the Display Properties 
dialog box to change them. 

Format Restriction 

Don’t enter a coordinate pair where both coordinates are zero (0.00000000 or 
00 00 00). The record with those coordinates is ignored, and won’t appear in 
the compiled database.  
 
The reason for this has to do with the way the Sky Database compiler handles 
comment lines. It assumes lines starting with a semicolon ( ; ) are comments, 
and ignores them. Of course, the semicolon isn't universal – other databases 
might very well use different characters to designate comment lines. The 
compiler parses records by calling a function that converts text to numbers. If 
this function doesn’t recognize text as a number, it returns a value of zero. If 
both coordinates in a pair are read as zero, the compiler assumes it’s reading 
text on a comment line (even if the line doesn’t start with a semicolon), and 
skips over that record. So – if you want to enter a zero-zero coordinate pair, 
make one of them zero, and the other “vanishingly small” (such as 1 
arcsecond or 0.00000001). 

Defining Database Indexes 

An index makes it easy to find a particular entry in a database. If every 
database record includes an index value, and its field is defined as a Find field, 
the database becomes searchable. You enter the index value in the Find edit 
box and TheSky6 locates the record. 
 
An index can be any combination of letters and numbers. Indexes don’t have 
to appear in alphabetic or numeric order, nor must they have a consistent 
format. For example, one record can have the index JP502H, while the next 
could be 794Z68PF. They only have to be unique within a given database. In 
practice, some index formats work better than others. The following two 
formats are recommended.  
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 If a database comprises objects of a single type, it usually makes sense to 
number the entries in order – 1, 2, 3, 4, and so on. You don’t need to 
specify the type, because the Identifier does that for you. You choose an 
Identifier from the Databases list box, then type just the index number. 

 If a database includes objects of multiple types, you’d probably use an 
alphabetic prefix that indicates the type, followed by a number. Each type 
can use the same numbering sequence, since the alpha prefix makes each 
entry unique. With this format, you don’t need to pick an Identifier from 
the Databases list box – you just enter the full index. 

 
The Field Definition dialog box is used to add a search index to the database. 
Highlight the columns that contain the index, and then click Find. For the 
Find command to actually search this database, it must be loaded and active. 
 
Multiple Finds when Searching Sky Databases 

The search engine looks for all records starting with the same letters or 
numbers you entered. If you search for catalog number 25 (say), the search 
also finds catalog numbers 251, 252, 2503 (and so on), if they exist. The 
search stops after the first 10 matches. 
 
Adding User-Defined Fields to the Database 

Each database record can include up to eight user-defined fields. These fields 
can include anything you want, and have any label you like. The labels and 
their associated data are displayed in the Object Information dialog box when 
you click on the object or locate it with the Find command box. 
 
These labels are also listed on the Extended sheet of the Labels Setup dialog 
box, when the database is loaded and active. Mark the checkboxes of those 
labels you want to add to extended labeling. 
 
These fields can be defined with the >PARSE command in the header. You 
can also use the Field Definition dialog box to define them, just as you did 
with the predefined database fields.  
 
1 Drag the mouse cursor across the columns that represent a user field.  
2 Click one of the numbered buttons in the User Fields box. Once you’ve 

defined the columns, pressing SHIFT when you click these buttons displays 
the column numbers in the Column Selection box.  

3 Enter a label for the field in the edit box. This label (and related data) will 
appear in the Object Information dialog box and can be added to extended 
labeling. 
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Databases with Multiple Object Types 

Databases are normally created for only one object type – elliptical galaxies, 
X-ray sources, and so on. This is not a limitation, because you can create and 
load as many databases as you want. However, you might need to assemble a 
database with multiple object types (such as the Herschel objects). This is 
done by adding a data column that specifies the object type. 
 
A file with multiple object types must meet the following requirements. 
 
 The file can include no more than nine different object types. 
 Each entry for an object with a non-default data type must include a field 

with an identifier indicating its type. 
 
Once you've created the text file for such a database, go through the steps 
described in “Importing Databases.” When you’ve finished defining the 
required/optional fields, and any user-defined fields, do the following.  
 
1 Drag the mouse cursor across the columns that represent the object type.  
2 Click the Obj. Type button. The Sky Database compiler now knows 

where to find the Object Type for objects that aren’t the default type.  
3 Click Advanced. The Advanced Compile Options dialog box appears.  
4 In the Object Type boxes, select the non-default data types you want. If 

you’ve defined new object types, they are also available.  
5 Enter the Object Type Identifier in the corresponding edit box. For 

example, if variable-star entries use ‘VS’ as their identifier, enter VS in the 
adjacent edit box.  

6 Click OK. You’ve now told TheSky6 which symbol to display for each of 
these objects. If a record doesn’t include one of the Object Type 
Identifiers listed in the Advanced Compile Options dialog box, the 
compiler assumes it’s the default Object Type. 

Multipliers 

The Advanced Compile Options dialog box includes multipliers for the 
following data items. 
 
 RA  
 Dec  
 Mag[nitude] 
 Major Axis 
 Minor Axis 
 Position angle 
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These normally need no adjustment. However, if a text database does not use 
the “standard” units for these items, you’ll need to change the multiplier to 
compensate. Multipliers can be greater than 1 or less than 1.  
 
A multiplier is most-often used to correct the RA value. The default unit for 
RA is hours. If the database expresses RA in degrees, the RA multiplier must 
be set to 115 (0.06666667). 
 
Exporting User-Defined Data to a Database 

Chapter 12 explains how to add User-Defined Data to the Virtual Sky. User-
Defined Data is stored in Sky Documents, and is unique to each document. If 
you wanted the same User-Defined Data to appear in more than one 
Document, you’d have to manually add it to each one. This is inconvenient 
and time-consuming. 
 
The solution is to export User-Defined Data as a text database file, then 
compile it. It can then be displayed (or hidden) as you like, regardless of 
which Sky Document is loaded. 
 
1 Add whatever User-Defined Data you want to the Virtual Sky. You can 

only export data of a single type. However, there is no preset limit to how 
many databases can be loaded and displayed at one time.  

2 Save the current Sky Document under a new name. This prevents loss of 
your work and lets you modify the user data without having to reenter it.  

3 Select the User-Defined Data command from the Data menu. Or press 
ALT+U. The User-Defined Data dialog box appears.  

4 Click Browse. The Save As dialog box appears. The default folder is 
user\exported user data.  

5 Type a name for the database file. Click Save As. If the file already exists, 
the User-Defined Data is appended to the file. You can use this feature to 
quickly combine existing User-Defined Data from several Sky Documents.  

6 Type an (optional) comment in the Comment edit box. If you create more 
than one User-Defined Data database, the comment helps identify them.  

7 If the User-Defined Data contains multi-segment lines, and you want them 
converted to polygon fills, mark the “As Polygons” checkbox. 
If the start and end points of a multi-segment line don’t match, the 
compiler silently changes the end coordinates of the last segment to the 
start coordinates of the first.  

8 Click Export. The Verify dialog box prompts, “Remove the Data?” Click 
No to keep the User-Defined Data in the current Sky Document. This is 
the safe response, since you can always go back and remove it manually. 
Click Yes to delete the User-Defined Data in the current Sky Document. 
This is the usual response, because you don’t want the data displayed 
twice. 

9 Click OK to exit. 
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The database text file you’ve just created has a default Identifier of “User-
Defined Data,” which is displayed in the Sky Databases list. If you create only 
one user-defined data database, this isn’t a problem. But if you create more 
than one database, they’ll all have the same name, making it difficult to tell 
which is which. You might, therefore, want to edit the database text file and 
change the >IDENTIFIER entry to something more descriptive than “User-
Defined Data.” 
 
Now you can compile the database. 
 
1 Select the Import command from the Data menu. Or press ALT+C. The 

Import dialog box appears.  
2 Click Browse. The Open dialog box appears.  
3 Find and highlight the database file you just created. Click Open. Or just 

double-click on the name. You’re returned to the Import dialog box.  
4 Mark or clear “Horizon-based coordinates” and “Load to memory” as 

required.  
5 Click Compile. Because TheSky6 created the database file for you, it 

includes a header that defines the correct format. You don’t have to define 
the fields or do anything else.  

6 When compilation ends, you are prompted “Add to Auto Load Database 
List?” Since you usually want this User-Defined Data to be immediately 
available when TheSky6 runs, select Yes. If not, select No.  

7 Click OK to exit. 
 
The objects in the new SDB should be displayed immediately. If not, check 
that the database appears in the Sky Databases list (of the Sky Database 
Manager dialog box) and is active (its checkbox is marked).  
 
The Reference Point and Reference Line checkboxes of in the Display 
Explorer dialog box must be marked, as must those of any other object types 
in the SDB. 

Export Restrictions 

Exported User-Defined Data can be of only one type (Objects/Points, Labels, 
or Reference Lines). If your Sky Document includes more than one type, the 
exported text database will specify the data type of the first item in the User-
Defined Data dialog box list. Objects of other types will not be displayed.  

Editing Object Symbols 

TheSky6 contains twenty user-definable object types. The default symbol for 
each is a cyan-colored plus sign (+).  You can edit the symbol for each type 
from the Display Explorer. 
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1 Click View | Display Explorer. 
2 Navigate to the Reference Objects | User-Defined Object Types 

node. 
3 Expand the “Type N” node (where N is the number for the user-defined 

object type), or expand the node that shows the name of a user-defined 
object type you created. 

4 Click the icon next to the Display Properties text. The Display Properties 
tab of the Properties dialog box appears. 

5 Click the Symbol button.  The Symbol Editor dialog box appears. 
6 Use the Symbol Editor to draw the symbol for this object. (Page 132)  
 
 



  

179  

Chapter 16 Picture and Multimedia Databases 

TheSky6 includes photographs of thousands celestial objects. You can also 
create databases for your own photos or images, and TheSky6 will display 
them, too. 
 
TheSky6 recognizes more than 30 image formats, so you can display almost 
any kind of picture. You can also assemble your own multimedia databases of 
text, images, sounds, and movies. 

Displaying Pictures 

There are several ways to display pictures. 
 
 Zoom to view “in-place” images from the Digitized Sky Survey and Image 

Groups. 
 Enable the Image object type in the Display Explorer and then click on an 

Image symbol in the Virtual Sky. 
 Select the Multimedia tab in the Object Information dialog box.  
 Use the Show Picture command from the Tools menu.  
 Use the Slide Show command from the Tools menu. 
 Use the Paste command from the Edit menu to overlay an image on the 

Virtual Sky (for an Image Links). 

Image Symbols 

Image symbols (35mm SLRs) in the Virtual Sky mark objects that have items 
in a picture database. TheSky6 is shipped with these symbols turned off. If 
they aren’t visible, open the Display Explorer on the View menu and mark the 
Images checkbox in the References Objects, Other Reference node.  
 
TheSky6 comes with two Sky Databases or SDBs (see page 159) that show 
image symbols for selected objects. These databases are named “Anglo 
Australian Images” and the “Hubble Images.” The Anglo Australian SDB is 
loaded into TheSky6 automatically. To load the Hubble Images SDB, select 
the Sky Database Manager command from the Data menu, and then select the 
file named All Hubble Images.sdb in TheSky6’s 
Data\Pictures\Hubble Space Telescope folder.  
 
These two databases will appear in the Display Explorer window under the 
Sky Databases node. To make them active, mark the check box next to the 
database name. 
 
Clicking on an image symbol displays the image associated with it. (Press 
SHIFT when you click to display the Object Information dialog box instead.) The 
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image appears in a separate window, scaled to the image’s native resolution. 
Drag the borders of the window to make the image larger or smaller. 
Bitmapped images are made of discrete pixels, so they’ll look “blocky” if 
they’re enlarged too much.  
 
To hide the Image symbols, select the Display Explorer command from the 
View menu and clear the Image checkbox. To disable a database that 
references image symbols, open the Sky Database Manager dialog box and 
clear that database’s checkbox. 
 
Multimedia Tab 

You can always view the images associated with an object, whether or not the 
Image symbol is displayed. When you click on an object for which there is at 
least one image in an active image database, the image is displayed on the 
Multimedia sheet of the Object Information dialog box. If more than one 
image is available, select the one you want from the list box. 

Show Picture Command (Tools menu)  

Select the Show Picture command from the Tools menu. In the Open dialog 
box, select the image type (most popular – and even some not-so-popular – 
formats are available). Use the browsing controls to find the file you want. 
 
Highlight the filename, then click Open. (Or just double-click on the name.) 
The picture appears in a separate window, scaled to the image’s native 
resolution. Drag the borders of the window to make the image larger or 
smaller. Bitmapped images are made of discrete pixels, so they’ll look 
“blocky” if they’re enlarged too much. 

Slide Show Command (Tools menu) 

You can create a “slide show” of images, and run the show automatically or 
manually. You can choose which images are shown and the order in which 
they’re presented. 
 
1 Select the Slide Show command from the Tools menu. 

Select Create List from the fly out menu. 
Or press SHIFT+C. The Create Slide Show List dialog box appears. 
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2 Use the browse controls to find the image file you want. Highlight it.  
You can select more than one file. To select a range of files, click on the first, then press 
SHIFT as you click on the last. To select (or deselect) specific files, press CONTROL as you 
click. 

3 Click the Add button to add the file to the Slide Show List box. 
Or double-click on the file. As images are selected, they are added at the end of the Slide 
Show List. They are displayed in the order they appear in the List. An image can appear in the 
Slide Show List as many times as you like.  

4 Repeat Steps 2 and 3 to add more image files.  
To remove an image from the Slide Show List, highlight it, then click Remove. If no files are 
highlighted, clicking Remove deletes all of them. If you change your mind about the deletions, 
click Cancel to exit without removing the images from the list.  

5 When the Slide Show List is complete, click OK. 
 

You can open the Create Slide Show List dialog box at any time to modify the 
Slide Show List. The list is automatically saved between sessions, in the 
file browse.lst.  
The default operation of the slide show is manual – select Forward or 
Backward from the fly out menu to show the next or the previous image. 
 
For automatic display, click Options and mark the “Automatic Browse” 
checkbox in the Slide Show Options dialog. In the “Seconds image is 
displayed” edit box, enter a value from 1 to 120 seconds (or click the spin 
buttons). The display time does not include the time it takes to load the file. 
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To start the slide show, select the Slide Show command and choose Forward 
or Backward from the fly out menu. (When Automatic Browse is selected, the 
Slide Show can only run Forward.) When the bottom (top) of the Slide 
Show List is reached, the show starts over from the top (bottom). 
 
The picture appears in a window scaled to the image’s native resolution. Drag 
the borders of the window to make the image larger or smaller. Bitmapped 
images are made of discrete pixels, so they’ll look “blocky” if they’re enlarged 
too much. To stop the slide show, press ESC. You are prompted to quit or 
continue. 

Creating Your Own Image Databases 

Creating your own image database is not difficult. TheSky6 offers two different 
methods for doing so. Image Groups allow you to specify the exact orientation 
of a set of photographs on the Virtual Sky.  Sky Databases allow you to  

Image Manager and Image Groups 

The Image Manager command lets you create and manage groups of CCD 
images or other photographs and provides tools to precisely position 
individual images on the Virtual Sky at their correct orientation. As you zoom, 
TheSky6 shows the images “in-place.”  
 
The Bevis constellation drawings are one example of an Image Group that is 
copied to your hard drive when TheSky6 is installed. The non-stellar color 
photographs are another. 
 
Image Groups can be turned on an off using the Display Explorer command, 
in the Image Groups node (see Figure 34). Click the Image Group heading to 
turn on and off all the images in the group, or expand the list to access 
individual images. 
 

 
Figure 34 – Image Groups in the Display Explorer dialog box. 
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If you’re a color CCD imager, you might want to replace TheSky6’s default 
color photographs with your own.  
 

1 Select the Image Manager command from the Data menu to display the 
Image Manager dialog box.  

 

 
Figure 35 – Image Groups dialog box. 

The Image Groups tab has options to add and remove Image Groups and images to 
Image Groups. Click the Add Group button and enter the name for your image group, 
such as “My Image Group.” Image Groups use the extension “ImgGrp” and are saved by 
default in the <My Documents>\Software Bisque\TheSky6\User\Image Groups folder. 
Click the Remove button to remove the selected group. The “Properties” text box shows 
the number of images, the location of the ImgGrp text file and the name of the group. 
Selecting an image displays the file name, alias, size of the image in arcminutes, scale in 
arcseconds per pixel, position angle, and the minimum and maximum field width that the 
image is displayed. 

2 Click Add New Image.  
The Add New Image dialog box appears. 

 

 
Figure 36 – Add New Image dialog box. 

The Add New Image dialog box lets you tell TheSky6 about the image. 
 

 Cross Reference – Enter the catalog number or alias for the image. For 
NGC1976, enter the text “Great Nebula in Orion,” “M42,” or “NGC1976.” 
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 Scale – Enter the scale of the image, in arcseconds per pixel. Enter 
zero if you don’t know the image scale. TheSky6 uses this information 
when positioning the image. 

 Position Angle – Enter the angle, measured counterclockwise from 
North, of the image. Enter zero if you don’t know the position angle. 
TheSky6 uses this information when positioning the image. 

 Minimum – Enter the minimum field of view that the image is displayed. 
If your image covers a large region, you might want to hide it at narrow 
fields so that the image will not appear blocky. 

 Maximum – Enter the maximum field of view that the image is 
displayed. If your image covers a small region, you might want to hide it 
at wide fields.  

 Select Picture File and Close – Click this button to display the Open 
dialog box. Navigate to the location of the image file, select it and then 
click OK. You’re returned to the Image Manager dialog box. 

3 Click the Place Image tab. 
 

 
Figure 37 – Place Image tab. 

The Place Image tab lets you adjust the orientation of the image to match the 
Virtual Sky. TheSky6 automatically zooms the Virtual Sky based on the values 
you entered for your image scale. The blue line surrounding the image indicates 
that it can be adjusted using the Place Image controls. 
 Move N/S/E/W and Center – These buttons adjust the position of the image 

on the Virtual Sky. 
 Size – Shows the size of the image, in arcseconds per pixel. 
 Position Angle – Shows the position angle of the image. 
 Course – Very Fine – Select the angular distance the image is moved 

when the N/S/E/W buttons are clicked. 
 Image/Virtual Sky – The Image option adjusts to position of the image, 

keeping the Virtual Sky at fixed coordinates, the Virtual Sky option adjusts 
the background stars and fixes the position of the image. 

 Transparency – Use this slider to change the transparency of the image. 
 Aspect Ratio – 1:1 resets the size of the image to its original dimensions. 

<> increases the size of the image, >< decreases the size of the image. 
 Save – Saves these settings to the Image Group file. 

 
Repeat this process for each image in your group. 
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Images and Sky Databases 

You create a text file that gives the filenames of the images, and the sky 
coordinates at which you want the Image symbol to appear. You then compile 
the text file and put the resulting Sky Database (.SDB) file in the same 
directory as the pictures.  
 
If the database is then loaded and made active, and the Image checkbox in the 
Display Explorer dialog box is marked, image symbols (cameras) will appear 
in the Virtual Sky at the coordinates given in the database. When you click on 
a symbol, the associated image is displayed.  
 
The following is a brief overview of the process. Chapter 15, “Custom 
Databases,” has a complete explanation of how to create Sky Databases. The 
text file needed to create the database has a simple format. Here’s a sample. 
(It’s the first 10 lines from the Anglo-Australian database.) 
 
0.40167h 00m 00s 72.08333d 00m 00s S NGC0104.GIF 
0.79333h 00m 00s 25.28333d 00m 00s S NGC0253.GIF 
0.91500h 00m 00s 37.68333d 00m 00s S NGC0300.GIF 
0.91500h 00m 00s 37.68333d 00m 00s S NGC0300.GIF 
3.30500h 00m 00s 66.50000d 00m 00s S NGC1313.GIF 
3.56000h 00m 00s 36.13333d 00m 00s S NGC1365.GIF 
3.76333h 00m 00s 24.36667d 00m 00s N NGC1432.GIF 
3.76833h 00m 00s 23.78333d 00m 00s N NGC1435.GIF 
4.33333h 00m 00s 54.93333d 00m 00s S NGC1566.GIF 
5.59000h 00m 00s 5.45000d 00m 00s S NGC1976.GIF 

 
Each record in an image database needs only four entries – right ascension, 
declination, declination hemisphere, and the name of the image file. When an 
image database is loaded and made active, the Image symbol (the 35mm 
SLR) is displayed in the Virtual Sky at the RA-Dec coordinates given. 
 
You can add a fifth entry that specifies the common name or catalog number 
of the sky object the image file is to be associated with. (The number must 
appear in a loaded, active catalog, or the association will fail.) 
 
 If you do not specify a sky object, the image file can be accessed only when 

the Image symbol is displayed (that is, the Image checkbox in the Filters 
list is marked).  If you do specify a sky object, the image file is listed on 
the Multimedia sheet of the Object Information dialog box – whether or not 
the Image symbol is enabled – and can be viewed by clicking on its name. 

 
You’ll probably want to specify the object, since it lets you access the image 
(or other multimedia file) without having to clutter to the Virtual Sky with 
additional symbols.  
 
To use this feature: 
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1 Add the objects’ names or catalog numbers to the text database. 
2 In the Field Definition dialog box, select the columns with the catalog 

number. 
3 Click the Alias button. 
 
That’s it. 
 
No path is given for the image file, because TheSky6 assumes the file is in the 
same folder as the database (.SDB) file. If it can’t find the image file there, it 
looks in the pictures folder. This search is intended only as a “fail-safe.” 
 
You should try to keep images and their database file in the same folder. Once 
the database text file is complete, you can select Import from the Data menu, 
then load and compile it, as you would any other database. 
 
The new images are now part of TheSky6’s database. If you open the Sky 
Database Manager, you should see the database’s Identifier in the Sky 
Databases list box. 

Creating Other Types of Databases 

TheSky6 supports other multimedia types. You can create databases of the 
following multimedia object, in exactly the same way you create them for 
images. 
 
 Notes (.TXT text files)  
 Sound (.WAV sound files)  
 Video (.AVI or .MOV files) 
 
For example, a notes database can contain observational notes for planets or 
variable stars. A sound database might include radio noises from the Sun.  
 
A video database might have videos of Shoemaker-Levy impacting Jupiter. 
These databases have the same format as Image databases. If you insert a 
Header in the database text file, remember that the Object Type is 41 for 
Image, 42 for Video, 43 for Sound, and 44 for Notes. 
 
When the corresponding checkbox in the Display Explorer dialog box is 
marked, the icon for each object type appears at the specified coordinates. 
Clicking the icon presents the object (as text, sound, or video). If you want 
the database objects to be available even when the symbols aren’t displayed, 
include an “alias” specifying the name or catalog number of the associated sky 
object.  
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If you don’t want these icons to clutter the Virtual Sky, hide them by clearing 
their checkboxes in the Display Explorer dialog box. Or use the Sky Database 
manager to deactivate those databases you don’t want to use. 
 
Using TheSky6 to Help You Create Image, Notes, Sound, or Video Databases 
When creating your own Image, Notes, Sound or Video database, you might 
not look forward to typing in a lot of data. Fortunately, TheSky6’s Export User 
Data feature can do most of the work of creating the text data file. 
 
1 Decide what type of database you want to create. An exported user-

defined data file can be of only one object type.  
2 Create a new Sky Document without any user data.  
3 Select User-Defined Data from the Data menu. Or press ALT+U. The 

User-Defined Data dialog box appears.  
4 Select the Objects/Points data class.  
5 Select the Image, Video, Sound, or Notes object type.  
6 If you want to place points exactly on stars or deep-sky objects, select 

Snap To Nearest Star or Snap To Nearest Non-Stellar.  
7 Click Close.  
8 CONTROL+click in the Virtual Sky where you want to place the database 

objects.  
9 Open the User-Defined Data dialog box again.  
10 For each point, enter the associated file name in the Label edit box. For 

example, saturn.gif, apollo.avi, marceau.wav, or r.txt.  
11 Click Browse. Enter a name for the file the user data will be exported to.  
12 Click Save.  
13 Click Export.  
14 Click Close.  You should see the points and their labels in the Virtual Sky.  
15 Save the current Sky Document under a new name. Saving the user data 

lets you can modify it later without having to reenter it.  
16 Select Import from the Data menu. Or click ALT+C . The Import dialog box 

appears.  
17 Click Browse and load the text database file you just created.  
18 Click Define Fields.  
19 Highlight the field with the file names, then click File Name. This is the 

“trick” – you enter the file name as a Label (where it’s placed at the end of 
the record), then redefine it as a File Name.   

20 Click OK, then Compile. If you want the multimedia files to be accessible 
from the Multimedia sheet of the Object Information dialog box, you must 
add to each record the common name or database identifier of the sky 
object you want to associate with the multimedia file in that record. This 
requires manual editing of the database text file. 
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Associating Sounds with Events in TheSky6 

Version 6 lets you associate sounds with specific events in TheSky6. You can 
use these “just for fun” (”Good morning, Dave…”), or to provide audible 
reminders (such as announcing that slewing has aborted). 
 
To see which events are supported, open the Windows Control Panel and 
double-click Sounds. As you scroll down the Events list you'll come to a 
section labeled “Sky.” The events are listed alphabetically. Most are self-
explanatory; some need a bit of explanation. 
 
 Background is played at random times, to provide ambiance. As shipped, 

it’s a cricket chirping.  
 End is played when you exit TheSky6.  
 Identify is played when you click within the Virtual Sky.  
 Image Link is played when a successful Image Link match is made.  
 Start is played when TheSky6 starts running. 
 
To create an association between an event and a .WAV file: 
 
1 Open the Control Panel  
2 Double-click Sounds. The Sounds Properties dialog box appears.  
3 Find the event and highlight it. Events already associated with sounds 

have a speaker symbol next to them.  
4 Type the full path of the .WAV file in the Name edit box. If you don’t know 

the path, click the Browse button to search for the file. Or click the arrow 
on the edit box to select from .WAV files in the windows\media 
directory.  

5 Click Apply to make the association. 
 
Click Cancel to quit without making the association. 
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Chapter 17 Image Link Overlays 

The Image Link™ function makes it possible to add CCD images or scanned 
photographs to the Virtual Sky. The image exactly overlays the display – stars 
and galaxies in the image line up precisely with the corresponding objects in 
the Virtual Sky.  
 
Image Link also works with the Digitized Sky Survey, in either high- or low 
compression format. Using RealSkyView (supplied with the RealSky edition of 
the Digitized Sky Survey) to extract the image, TheSky6 can automatically 
create an Image Link overlay for an area of the sky of up to about 2° square.  
 
Image Link turns your CCD and photographic images into interactive star 
charts. Objects in the image can be viewed, labeled and identified, just as if 
they were part of the Virtual Sky. 

Inserting the Image to be Linked 

The image must be inserted before it can be linked to the Virtual Sky. Only 
one image at a time can be linked. 
 
1 Select Pole Up orientation from the Orientation menu. 

Or turn off the “Use computer’s clock” (page 15) button. Either keeps the 
Virtual Sky from updating and shifting as you the link the image. 

2 Set the field of view to 50° or less. 
Linked images are only displayed at field widths below 50°. The projection 
automatically switches to orthographic, which is required when linking 
images. 

3 Move the Virtual Sky to the part of the sky where the image was 
taken. 
Try to get as close a match as possible. Use the zoom function from the 
Find dialog box to get exactly the field width you need. Use the Rotate 
Tool to adjust the angle of the Virtual Sky. When scrolling, press 
CONTROL+SHIFT to make fine adjustments. 

4 Use CCDSoft™ to copy the image to the Windows Clipboard.  
If you don’t have CCDSoft, load the bitmap (.BMP) image into a paint 
program (such as Windows Paint), and copy it to the Clipboard. 

 
Only 8-bit grayscale images can be used to perform a link. If the image is 
in color, it must be first converted to 8-bit grayscale. You can link with the 
grayscale image, then paste the color image over it. 

 
5 Use the Paste command from the Edit menu to insert the image. 
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Once the image is inserted, there are two ways to align it with the Virtual 
Sky. Object Dragging uses manual adjustment. The Link Wizard uses pattern 
recognition to align the image automatically.  
 
Linked images are not permanent. When you exit TheSky6, the linked image 
is removed from the Virtual Sky. 
 

Aligning Automatically with the Link Wizard™ (Professional Edition) 

The Link Wizard uses an advanced pattern-recognition algorithm to align the 
underlying object data in the Virtual Sky with the digital image. The Link 
Wizard has performed successfully on thousands of CCD images, with fields 
of view ranging from 8 arcminutes to over 30°. 

Image Requirements 

For the Link Wizard to do its job, the image should meet the following 
requirements. 
 
 Minimum Size – The image should be at least 100 pixels on a side – 

preferably larger. Small images contain fewer objects, making pattern 
recognition more difficult. 

 1:1 Pixel Aspect Ratio (“square” pixels) – Scanned photographs always have 
a 1:1 ratio, as do most CCD images. Those that aren’t 1:1 must be 
rescaled. Use the Resample command from CCDSoft, or a paint program 
with a resampling function. 

 White Stars – The image must be “positive” – white stars on a black 
background. In CCD terms, this means “high” pixel values for stars, “low” 
for the background. 

 Minimum Number of Stars – The image must have at least six well-defined 
stars that appear in the Tycho, Hipparcos, GSC, or USNO catalogs. Since 
most images are at least 10 arcminutes wide, and the USNO and UCAC 
catalogs go to better than 15th magnitude even in “sparse” areas of the 
sky, this requirement can almost always be met. An image narrower than 
10 arcminutes might not have enough stars for automatic alignment.  

Image Link Setup 

The Image Link Setup dialog box has several optional settings that can make 
it easier for the Link Wizard to find a match. To display this dialog box, select 
the Image Link Setup command from the Image Link fly out, or click the 
Image Link Setup button in the Image Link toolbar. 
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Figure 38 – Image Link Setup dialog box. 

 
The “Show … frame” checkboxes are useful when making your initial rough 
alignment. If “Show image frame” is marked, the borders of the CCD image 
are shown in the Virtual Sky. This makes it easy to distinguish the image 
from the background of the Virtual Sky. 
 
When “Show telescope frame” is marked, the Link Wizard computes the area 
covered by the CCD and displays it as a rectangle in the Virtual Sky. You can 
then determine what will fall in its field before taking a picture. If the Link 
Wizard knows the scale factor of the CCD – how many arcseconds of the sky 
each pixel represents – it can scale the Virtual Sky to exactly match the 
image’s magnification. To calculate the scale factor: 
 
1 Calculate the field of view of the CCD.  

The Compute function in the Add Field of View Indicator dialog box can calculate the field of 
view for you.  

2 Convert the field of view to arcseconds.  
Multiply degrees by 3600 and arcminutes by 60 to get arcseconds.  

3 Divide that result by the number of pixels along one side of the CCD chip.  
This gives the field of view of a single pixel. Don’t round off the answer.  

4 Click the “Known scale” radio button and enter this value in the edit box. 
Fractional values of up to two decimal places are okay. 

 
Once you’ve entered the scale factor, you can limit the area over which the 
Link Wizard searches. Enter a Search Radius between 1 and 10 arcminutes. 
Start with a value about twice the width of the CCD image. 
 

Running the Link Wizard 

Once the image has been inserted, select Image Link from the Tools menu, 
then Link Wizard from the fly out. (Or click the Link Wizard button.) If the 
image meets the requirements listed above, and the Virtual Sky shows 
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essentially the same area as the image, the Link Wizard should find a match 
almost immediately. 
 
The single most important factor in getting a quick, accurate match is setting 
the Virtual Sky’s zoom factor and rotation so that the display closely matches 
the image. The following suggestions should help you do this. 
 
 If you know the catalog number of one of the stars (or galaxies) in the 

image, use the Find dialog box to locate it. Then use the arrow keys to put 
the center of the Virtual Sky near the center of the part of the sky shown 
in the image.  

 The field width of the Virtual Sky should be no more than twice the field 
width of the image. The less area the Link Wizard has to search, the more 
easily it can find a match. (The Link Wizard can now find matches outside 
the current field of view, over a field up to 2° square.) 

 
You might find it useful to create a FOVI that matches your CCD sensor’s 
(or camera’s) field of view. (If the sensor has non-square pixels, the 
FOVI’s dimensions must be scaled to compensate.) Adjust the field width 
so the entire FOVI is visible, and positioned near the edges of the Virtual 
Sky. (See page 104 for information on creating and using FOVIs.) 

 
 Use the Rotate Tool to match the Virtual Sky’s orientation to the image. If 

you set the Virtual Sky’s orientation to Pole Up, and orient your images 
and CCD photographs so that North is at the top and East is to the left, 
you won’t need to rotate the Virtual Sky for a match. These adjustments 
don’t have to be exact – the idea is to quickly “rough in” the settings. This 
leaves the hard work for the Link Wizard. It does the “fiddly bits” – 
adjusting the field width, screen coordinates, and rotation so the Virtual 
Sky exactly lines up with the image. As the Link Wizard searches for a 
match, a progress bar marks its activity. If the Link Wizard doesn’t find a 
match on the first pass, it makes up to six more passes over progressively 
smaller sections of the Virtual Sky. Once a match is found, the Link 
Wizard sets the Image Link display mode to Transparent, so you can 
easily confirm the match is correct. Clicking anywhere within the image 
displays the Object Information dialog box with link information. 

 
No Match? 

If the Link Wizard can’t find a match, or makes an invalid match, check that 
the Virtual Sky is centered on the image area. You might need to adjust the 
magnification and rotation to more closely align with the image. If the Link 
Wizard can’t align the image, you can still perform a manual alignment. If you 
can get close with manual adjustments, the Link Wizard can then (usually) 
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complete the alignment. (Manual alignment is explained in a following 
section, “Aligning Manually with Object Dragging”)  
 
Adjusting the Appearance of the Linked Image 

The linked image is displayed or hidden by selecting the Display Image 
command from the Link Image fly out menu, clicking the Display Image 
button in the Image Link toolbar, or pressing I.  
 
You can scroll or zoom the Virtual Sky while an image is linked. This 
suspends (but does not remove) the link. To restore the link, press I. The 
Virtual Sky returns to the coordinates of the image, and the image is 
redisplayed at the previous field width. The Image Link Setup dialog box has 
several useful controls. To open it, select the Image Link Setup command 
from the Image Link fly out, or click the Image Link Setup button in the 
Image Link toolbar. 
 
 When the Link Wizard achieves a match, it automatically marks the 

“Image is Linked” checkbox. If you clear this checkbox, the link is lost, 
and the image remains centered in the display regardless of how the 
Virtual Sky is scrolled or oriented.  

 
When the Transparent radio button is clicked, stars are visible through the 
linked image. Their values are reversed – white stars are black dots – to keep 
them visible. When the Opaque radio button is clicked, stars are hidden by the 
linked image. Deep-sky objects such as galaxies and nebulae behave 
differently. Their Filled/Outline only behavior interacts with the Non-Stellar 
Fill setting in the Non-Stellar Options dialog box.  
 
 When Color is selected, deep-sky objects always cover the corresponding 

objects in the image.  
 When Transparent or Transparent When Image Is Present is selected, 

deep-sky objects are not filled with their Fill colors, and the image is fully 
visible. Choose according to whether you want deep-sky objects filled 
when no image is linked.  

 
Examples of how these settings affect the Image Link display are shown 
below. 
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Transparent, Filled Transparent, Outline only 

 
Opaque, Color 

 
Opaque, Transparent 

 
 
 To adjust how much of the Virtual Sky is visible, change the Image Size in 

the Image Link Setup dialog box. By default, this value is 100%. Picking a 
smaller value (down to 20%) shows more of the Virtual Sky. Aligning 
Manually with  

Aligning Manually with Object Dragging 

While you are performing a manual alignment, you have to make decisions 
about which patterns in the image correspond to patterns in the Virtual Sky. 
The closer the image is to matching the magnification and orientation of the 
Virtual Sky, the less trouble you’ll have finding a match. A little extra time 
spent in adjusting the Virtual Sky will pay off in a quick alignment. 
 
Once the image has been inserted: 
 
1 Select the Image Link command from the Tools menu.  
2 Choose Setup from the fly out menu.  

Or click the Image Link Setup button in the Image Link toolbar. The Image Link Setup dialog 
box appears. 

3 Click the Transparent radio button so the image won’t hide the Virtual Sky.  
You need to see both to align the image.  

4 Click OK.   
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5 Look for stars in the image that match stars in the Virtual Sky.  
Try to find two stars, preferably on opposite sides of the image. Press I (to toggle the image 
on and off – “blinking” makes it easier to see patterns.  

6 While pressing SHIFT, click on one of the stars and drag the mouse cursor to 
the matching star in the image. 
Drag from the star in the Virtual Sky to the star in the image ( not the other way). A green 
“destination arrow” is drawn to show the direction in which the Virtual Sky will be repositioned.  

7 Repeat for the second star.  
A second “destination arrow” is drawn. You can’t draw more than two arrows at one time. But 
you can repeat the alignment as often as you want, with any stars you choose.  

8 To accept the adjustment, left-click in the Virtual Sky. To discard it, right-click 
in the Virtual Sky.  
The Virtual Sky will be resized, repositioned, and rotated (as required) to match the linked 
image. 

 

You don’t have to use two stars, but lining up a single star rarely produces a 
complete match. But it might sufficiently improve the match to reveal 
additional matching star patterns. If the match isn’t as good as you’d like, you 
can repeat the dragging as many times as you want. Or you can run the Link 
Wizard to complete the match. 
 
An Example for You to Try 
1 Use the Find command to locate and center M2.  
2 Set the field of view to 1°.  
3 In CCDSoft (or RealSkyView), open ngc.lst and view NGC 7089 (M2). Note the 

two bright stars at RA 21h32m49.5s, Dec 00d52m57s and RA 21h32m56.2, Dec 00d54m47s. 
4 Copy the NGC 7089 image to the Clipboard.  
5 Paste the image into the Virtual Sky.  
6 Locate the two bright stars at the coordinates given in Step 2.  
7 While holding down SHIFT, drag a line from each star in the Virtual Sky to the 

matching star in the image.  
8 Click anywhere. 
 
You should get perfect or near-perfect alignment. 

Creating an Automatically Linked Digitized Sky Survey Image 

1 Set the Virtual Sky to Pole Up orientation. 
2 Center the object or the part of the sky you want to create a linked image for. 

The field of view doesn’t matter – TheSky6 will adjust it automatically.  
3 Select Create Digitized Sky Survey Image from the Image Link fly out menu. Or 

click the Create Digitized Sky Survey Image button in the Image Link toolbar.  
4 You are prompted for one of the RealSky disks. Load it and click OK. The “No 

image found to extract” message means you don’t have the CD ROM with data for the part of 
the sky you’ve chosen. (If you have both the North and South RealSky sets, you have a 
complete set of data and you’ll never see this message.) To use 102-CD set of low-
compression disks, the “Low compression” checkbox in RealSkyView’s Digitized Sky Survey 
Setup dialog box must be marked.  

5  The image is extracted. You are prompted to reload TheSky6’s CD ROM. If all 
TheSky6’s databases are on the hard disk, you aren’t prompted. 

6 The linked image is displayed. 
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Chapter 18 Object Paths and Time Skips  

You can use TheSky6 to recreate and relive your favorite astronomical events 
using the time skip control. You can also predict and show the path of solar 
system objects using the Object Paths feature. 

Object Paths 

 
Figure 39 – Sample object paths. 

 
Use TheSky6’s new Object Paths feature to show the past or future path of 
solar system objects against the starry background. The Sun’s analemma, 
retrograde motion of Mars, or the Moon’s nightly path across the sky are a 
few examples. 
 
Setting up and displaying an object path is simple. 
 
1 Select the Object Paths dialog box from the Time Skip fly out 

menu on the Data menu.  
Or, click CONTROL+SHIFT+P, or click the Object Paths button on the Time 
dialog box. The Object Path dialog box appears. 

2 Click the Visible option. 
3 Select the solar system object to create a path.  

The Sun, Moon, planets, comets and local minor planets are available in 
the “Create path for” list. 

4 Choose the type of path to create. 
 Fixed length path (compute when path is created) – Mark this 

option to generate a path that has a specific beginning (the current 
time in TheSky6) and ending (determined by on the “Increment” and 
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“Count” values. For example, an “Increment” of 1 Day and a “Count” 
of 365 equals one year. 

 Time-skip path (path is updated during time skip) – Mark this 
option to create an open-ended path. That is, there is no specific of the 
path. TheSky6 leaves a trail at the position of the object for each time 
skip increment. 

5 Select the style of the Object Path. 
 Connected line – A segmented line is drawn that connects each new 

position of the object. 
 Dots at each position – A round, filled circle is drawn at each time a 

new position of the object is displayed. 
 Object symbol at each position – The object’s symbol is drawn at 

each time a new position of the object is displayed. 
6 Click the Create Path button. 

The “Computed Paths” report shows the status of the created path.  
Fixed-length paths show the number of positions in the path, while Time-
skip paths initially show “0 points, still open,” indicating that the path has 
yet to be created. 

Add Labels 

You can add customized labels at specified intervals using the Add Labels 
dialog box. 
 

 
Figure 40 – Add Labels dialog box. 

 
Position 

Select the location of the time skip label relative to the time skip object. 
Options include left, right, top, bottom and center. 
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Frequency 

Enter a number that specifies how often the time skip label appears. For 
example, if you've generated an object path for the Sun each day over a period 
of one year, entering 30 here will show a time skip label every 30 days. 
 
Entire Path Labeling Options 

This group contains options for labeling the object path (from start to end). 
 

 
Figure 41 – Time skip path labeling example. 

 
Dates 

Mark this option to add the date to the time skip label for time skip position 
objects. 
 
Times 

Mark this option to add the time to the time skip label for time skip position 
objects. 
 
Add Labels 

Click this option to add labels to time skip position objects. 
 
Remove Labels 

Click this option to remove labels from time skip position objects. 
 
Individual Label Group 

This group contains options for creating a user-defined label on a time skip 
object. 
 



TheSky6 
 

200 

Label 

Enter any text description for your time skip label. 
 
Add Date  

Add the current date to the individual time skip label. 
 
Add Time  

Add the current date to the individual time skip label. 
 

 
Figure 42 – Example individual time skip label. 

 
To add an individual label to any time skip position: 
 
1 Generate an object path. 
2 Click on the object path symbol to define a label. Make sure the Object 

List shows Object Path:<Solar System Object Name> for the current 
object.  

3 On the Large Object Information dialog box, click the Utility tab. 
4 Click the Time Skip Label button. 

Show 

Click this button to adjust the Virtual Sky and show the selected Object Path. 

Remove  

Click this button delete the selected Object Path. 

Remove All 

Click this button to delete all Object Paths. 
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Time Skips 

Time Skips can simulate the motion of Solar System bodies, letting you 
observe their behavior over time. It can also update the Virtual Sky at 
selected intervals of a fraction of a second to hundreds of years. All the 
following activities – and more – are possible. 
 
 Watch the proper motion of stars over hundreds of years. 
 View the retrograde motion of the outer planets. 
 Watch solar eclipses and occultations. 
 Plot comet and minor planet paths. 
 Watch a constellation rise or set. 
 Create the Sun’s analemma. 

Orientation and Animation 

The Virtual Sky’s orientation has a significant effect on Time Skip animation. 
If Pole Up is chosen, the sky background remains stationary and only Solar 
System objects move. All objects are displayed. 
 
If Zenith Up is chosen, both the star background and the selected object 
move. (However, if the skip interval is a sidereal day (23 hours, 56 minutes, 4 
seconds), the background stars do not move. This is because, with respect to 
Alt-Az coordinates, the star pattern repeats each sidereal day.) All objects are 
displayed in Zenith Up – except when the Record Trails button is depressed. 
Then only Solar System objects and the Local Horizon are shown.  
 
The Pole Up display can be strikingly beautiful, with the background of stars 
moving against a “locked” planet or comet at the center of the display. The 
Zenith Up display runs faster, and (when Record Trails is selected) the screen 
is uncluttered. 

Setting Up a Simulation 

A Time Skip simulation must be set up before you can run it. 
 
1 Select the appropriate display orientation, as explained above.  
2 Select Location command from the Data menu.  The Location dialog box 

appears.  Pick the Earth coordinates you want to view from. 
3 Select the Time command from the Data menu to display the Time dialog 

box and choose the starting time. Press the “Use computer’s clock” 
button to start simulations at the current time. If you want to start at a 
specific date and time, just enter it in the Time dialog box.  

4 Select the desired skip increment from the Time dialog list box.  Choose a 
default increment, or enter any value you want. Type the time value, 
followed by the letter representing the time unit – d for days, h for 
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hours, m for minutes, s for seconds. Case doesn’t matter. Fractional 
values – like 2.4d – are okay. You can also combine units. Seven days, four 
hours, six minutes, and two seconds is entered as 7d 4h 6m 2s .  You can 
modify default values by adding + or – values to the defaults. For 
example, you can type –10m after the Sunset default: Sunset – 10m. 

5 Select the Object Paths dialog box from the Time Skip fly out menu on the 
Tools menu.  In the “Create path for” list, select the object to include in 
the simulation. Mark the “Time skip path (path is updated during time 
skips)” option and then click “Create Path.” Repeat this procedure for 
each object you wish to track. 

6 To keep a particular object centered on the Virtual Sky, identify it using 
the Find dialog box or by clicking on it and then click the “Lock On” 
button on the Utility tab of the Object Information dialog box. 

 
You’re now ready to run the simulation. 

Running the Simulation 

Use the Time Skip controls on the Time dialog box to control time.  
 
The Go/Step/Stop controls are also available from the keyboard. ALT+] and 
ALT+[ step the simulation forward and backward. 
 
ALT+> and ALT+< run the simulation forward and backward. (You don’t need to 
press SHIFT with the > and < keys.) To stop the simulation, select the Stop 
command from the fly out menu, click the Stop button in the Time Skip tool 
bar, or press ESC. If you recorded the simulation, the trail remains on the 
screen. You can scroll or zoom the display without losing the trail. 
 
To start over, select the Reset Date and Time button on the Time Skip 
toolbar.  
 
You can change any simulation parameter while the simulation is running. You 
do not need to stop or reset. Simply select the Tracking Setup command from 
the Time Skip fly out menu. You can also turn object-trail recording on or off 
from this fly out. 

What’s Visible? 

If you Lock On to one of the objects you’re tracking, that object remains at 
the center of the screen throughout the simulation. 
 
If you select the Not Locked option, the Virtual Sky is not adjusted to show all 
the selected objects. The Virtual Sky keeps its initial position and field width 
throughout the simulation. If all the objects aren’t visible, you must “zoom 



Chapter 18 Object Paths and Time Skips  
 

203 

out” until they can be seen. You might also need to scroll the display in 
anticipation of where the objects will move during the simulation. 

Occultations 

It’s easier to follow occulted objects if you can “see” them behind the Sun, 
Moon, or planets. Select the Options command from the Data menu and mark 
the “Translucent sun and moon” checkbox. 

Scrolling and Zooming During Simulation 

Virtually every command and feature of TheSky6 (including keyboard 
shortcuts) are available while the Time Skip simulation is running. You can 
scroll, zoom, and turn reference lines on and off, even use the Find command, 
without disrupting the simulation. The simulation might pause briefly while 
TheSky6 performs calculations or redraws the screen, but it continues when 
these are completed.  
 
Any recorded trail remains intact, too. However, if you change the trail type, 
the existing trail is erased. 

Using the Time Skip Toolbar 

The controls needed to set up and run a Time Skip simulation are on the 
Time Skip toolbar on the Time dialog box. 
 

 
 
You can choose a skip interval from the combo box, or enter your own value, 
using the single-letter abbreviations (d, h, m, s) for days, hours, minutes, and 
seconds. The skip interval can be changed as you work. You can start with a 
long interval to find an event, and then switch to a short one to study it in 
detail.  
 

The  and  buttons step forward and backward in time. The  and  
buttons continuously move forward and backward in time. The button with the 
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black square is Stop. The button with the “CD eject” symbol resets the date 
and time.   

Using the Time Skip Controls with the Virtual Sky 

You can use the controls in the Time Skip toolbar even when you aren’t 
running a simulation. It’s a lot easier to set the interval to (say) one day and 
click Step Forward, than it is to change times from the Time and Date sheet. 
 
If you’re in Zenith Up orientation (or any horizon-based orientation), 
everything in the Virtual Sky moves when you click a Step or Go button.  
 
If Pole Up is selected, deep-sky object remain fixed and only Solar System 
objects move. 
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Chapter 19 Simulations and Tools 

TheSky6 includes display modes and utilities that can…  
 
 Simulate the Solar System’s motion, in perspective. 
 Predict and simulate Solar and Lunar eclipses. 
 View the positions and motions of Jupiter and Saturn’s moons. 
 View the positions of Saturn’s rings. 
 Display a monthly calendar of the Moon’s phases. 
 Show high-resolution images of the entire Moon’s surface. 
 Show conjunctions between the planets or Moon. 

3D Solar System View 

The first time you go to 3D Solar System mode, it is configured so that… 
 
 All planets, the Sun, and all “marked” comets are enabled. The Sun is at 

the center of the display. 
 The orbits of all planets are visible and the ecliptic grid is displayed. 
 The positions of Solar System objects are as they would be at the date and 

time currently on the Date and Time sheet. 
 The Solar System is oriented as it would be seen when looking (from 

outside the Solar System) towards the equatorial coordinates that are 
currently at the center of the Virtual Sky. 

 The Time Skip interval is set to one day. 
 
Solar System objects can be identified (by clicking on them) and labeled (by 
enabling Common Labels). 
 
The orbit lines for the planets are shown at all times and cannot be turned off. 
One section of each orbit is brighter than the other. The brighter section is 
the part of the orbit in or above the plane of the Ecliptic. Because the Earth’s 
orbit defines the plane of the Ecliptic, its entire orbit is bright. 

Changing the Field of View 

PAGE UP and PAGE DOWN zoom the 3D Solar System display just as they do the 
Virtual Sky. Pressing CONTROL or CONTROL+SHIFT at the same time provides a 
reduced or micro increment (respectively), as it does when zooming the 
Virtual Sky. 
 
If the Virtual Sky is displayed as the background (see “Display Options” 
below), it is set to a field of view of 50° and does not zoom. The reason is that 
the stars and other deep-space objects are so far away (relative even to the 
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diameter of Pluto’s orbit) that there would be no significant change in their 
perspective, regardless of your position within the Solar System.  
 
Changing the Viewpoint 
The arrow keys change the angle of view. 
 

 
 Pressing LEFT or RIGHT changes Theta and rotates the display. Theta is 

measured in the plane of the ecliptic from the First Point of Aries. 
 Pressing UP or DOWN changes Phi and tips the display. Phi is measured from 

an axis perpendicular to the plane of the ecliptic, through the Sun. If you 
change Phi sufficiently, the display “tips over” and you see the Solar 
System from below! (Okay, we know there’s no “up” or “down” in space, 
and “north = up” is set by the fact that astronomical studies were first 
made by civilizations in the Northern hemisphere (Egyptian, Aztec, 
Babylonian, Arabic). But, hey, that’s the way it is.) 

 
Pressing CONTROL or CONTROL+SHIFT while changing the viewpoint gives a 
reduced or micro increment (respectively), as it does when zooming. 

Using the Tracking Setup Dialog Box 

Using the Tracking Setup Dialog Box 

Because the 3D Solar System is a mode of the Virtual Sky, the Tracking 
Setup dialog box controls which objects are visible and how they are tracked, 
just as it does in the Virtual Sky. 
 
All currently displayed objects (including comets and minor planets) are 

Figure 43 – The relationship among Phi, Theta, and the user’s 
viewpoint. 
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listed in the Lock On and View From list boxes. When you Lock On an object, 
it moves to a fixed position at the center of the display, while all other objects 
continue to move. (When you first enter 3D Solar System mode, the display is 
implicitly locked on the Sun.) When you View From an object, that object 
becomes the viewpoint from which the motions of the other objects are seen. 
 
View From can provide some rather spectacular simulations. Try a View 
From the short-period comet 9P/Tempel 1. (Leave Lock On disabled.) 
Lock On and View From can be used together. For example, you might Lock 
On a comet and View From the Earth, to get a better idea of how the comet’s 
path appears in our sky. 
 
Running Time Skip Simulations 

Time Skip animation works exactly the same in 3D Solar System mode as it 
does in the Virtual Sky. (See “Chapter 18 Object Paths and Time Skips ”) 
 
Display Options 

Several display options are available from a context-sensitive menu that pops 
up when you right-click anywhere within the 3D Solar System display, or on 
an object. You can select these options at any time; you don’t have to stop the 
Time Skip simulator. 
 
 Show Background displays the Virtual Sky behind the 3D Solar System. 

The Virtual Sky and 3D Solar System are coordinated with each other. If 
you tip or rotate the Solar System, the Virtual Sky’s coordinates shift to 
match. (Its angle of view is fixed at 50°, however.) 

 Ecliptic Grid displays or hides a grid marking the plane of the Ecliptic. 
 Show Orbit displays the orbital path of the comet or minor planet you right-

clicked on. 
 Clear Orbits erases all comet and minor planet orbits. This command is 

only available when you right-click within the display (not on an object). 
 Orbit Depths draws vertical lines under or over orbit paths of comets and 

minor planets, showing the orbits’ distance above or below the Ecliptic.  
 Zoom To adjusts the field of view so that the orbit path of the selected 

planet falls within the window. 

Printing the Display 

The 3D Solar System display can be printed at any time with the Print 
command. Print Preview works just as it does for the Virtual Sky. 
 
You can also copy the display to the Clipboard by pressing CONTROL+C, or 
clicking the Copy button in the Standard toolbar. You can use the Export 
command from the File menu to create a metafile of the display. The file can 
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be imported into a word processing or graphics program and printed from 
there. 

Daytime Sky Mode 

Daytime Sky mode simulates the rising and setting of the Sun. The Virtual 
Sky’s background lightens and darkens, and objects appear and disappear, 
according to whether they would be visible against the sky. 
 
Daytime Sky mode can be used with any orientation. However, in Pole Up 
(equatorial coordinates) orientation, objects remain visible at all times. You 
must select one of the horizon-based orientations – Zenith Up, North, East, 
South, West, Look Up – for objects to fade and reappear against the sky. 
 
1 On the Date and Time sheet, select the date and time you want. If “Use 

computer’s clock” is marked, the Virtual Sky will change in real time. 
2 Select the orientation you want. Remember that the Sun rises in the East 

and sets in the West. 
3 Select Daytime Sky Mode from the View menu. Or click the Daytime Sky 

Mode button in the View toolbar. 
 
The Time Skip controls can be used with Daytime Sky mode. The Sunrise 
and Sunset Increment settings advance or retard the Virtual Sky about 24 
hours, to the moment at which the top of the Sun’s disk just touches the 
horizon. (The Local Horizon reference line is ignored.)  
 
You can add or subtract time from the Sunrise and Sunset settings, to view 
the Sun at later or earlier times. 
 
1 Click within the Increment edit box  
2 Press RIGHT to move the cursor to the end of the line. 
3 Enter the amount of time in seconds, minutes, or hours. 
 
Negative times are preceded by a minus sign (–). Seconds must be followed 
by s, minutes by m, and hours by h. (Entries without these letters are 
ignored.) You can combine hours, minutes and seconds, and each can have a 
different sign. 

Eclipse Finder and Simulator (Tools menu) 

Selecting the Eclipse Finder command automatically computes all eclipses – 
Solar and Lunar, total and partial – for the decade following the date currently 
on the Date and Time sheet. The Eclipse Finder box lists the dates and types 
of the eclipses.  
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Click on an eclipse to view information about it – the start and end times, the 
time of peak totality, and the magnitude. If the eclipse is not visible from the 
current location, “Not visible from this site” is displayed. 
 
If a Solar eclipse is Total or Annular, the “Show path of totality” checkbox is 
enabled. Marking this checkbox opens a second window showing the path of 
totality over a globe of the Earth. (Because lunar eclipses can be seen from 
almost anywhere on the dark side of the Earth, there is no path of totality to 
show.) The site currently selected on the Location sheet is marked with a 
yellow dot. 
 
Moving the mouse over this window changes the mouse cursor to a hand. 
Drag the hand to rotate the globe to any position. 
 
To view a simulation of a specific eclipse: 
 
1 Highlight the eclipse in the list box.  On the Location sheet, select a site 

or enter coordinates from which the eclipse is visible.  
2 Click the View button. The time and date are set to the starting time of 

the eclipse. The Sun or Moon is placed at the center of the Virtual Sky and 
locked. The Earth’s shadow is displayed (for Lunar eclipses). The time 
interval for Time Skip simulations is set to five minutes.  

3 Click the Step Forward or Go Forward button to view the eclipse. 
 

For Solar eclipses, the Virtual Sky shows the Moon passing in front of the 
Sun. For Lunar eclipses, two concentric circles represent the Earth’s shadow. 
The inner circle represents the umbra. The gray space between the inner and 
outer circles represents the penumbra. 
 
The Earth’s shadow is automatically shown when you run a lunar eclipse 
simulation. You can display it or hide it at any time by marking or clearing the 
“Earth’s shadow” checkbox in the Tracking Setup dialog box. 

Eclipse Magnitude 

The magnitude of an eclipse is defined by: 
 
M = (L1 - m) / (L1 + L2) 
 

Where L2 and L1 are the respective radii of the umbral and penumbral cones at 
the observer’s position, and m is the observer’s distance from the axis of the 
shadow at the time of maximum. The magnitude M is not necessarily the 
eclipsed fraction of the disk, and can be greater than unity in total eclipses. 
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Jupiter’s and Saturn’s Moons 

The display of Jupiter’s Galilean moons is integrated with the Virtual Sky. 
The Virtual Sky also shows the position of the eight principal moons of Saturn 
– Hyperion, Titan, Mimas, Iapetus, Dione, Tethys, Rhea, and Enceladus.  
 
The positions of the moons take into account the finite speed of light – they 
are shown at the positions you’d see them from Earth, at the current time. 
You can see which satellites will be visible before beginning your viewing. Or 
you can find the times at which particular moons pass across a planet’s disk, 
or are occulted by it. 
 
To view the motions of the moons of Jupiter or Saturn: 
 
1 Set the date and time you want on the Date and Time sheet.  
2 Select Find from the Edit menu. Or press F, or click the Find button in the 

Objects toolbar. 
3 Select Jupiter or Saturn from the list box to the right.  
4 Click Center & Frame. The planet is displayed at the center of the Virtual 

Sky at a 3° field of view. (You might need to zoom out a bit to view 
Saturn’s outermost moons.) 

5 Click on the planet. The Object Information dialog box appears.  
6 Select the Utility tab and click Lock On.  
7 Enter the desired time interval in the Time Skip edit box.  
8 Click one of the Time Skip Step or Go controls. 

Saturn’s Rings 

Saturn’s rings are visible in the Virtual Sky. 
 
1 Set the date and time you want on the Time dialog box.  
2 Press F, or click the Find button in the Objects toolbar.  
3 Type “Saturn” in the Find text box, or select it from the Solar System list.  
4 Click Center and Frame. Saturn is displayed at the center of the Virtual 

Sky at about a 3° field of view. The rings should be easy to see.  
Depending on the size of your monitor and the display driver’s resolution, 
you might need to adjust the field of view for the best image.  

Moon Phase Calendar (Tools menu) 

The Moon Phase Calendar displays the relative phase of the Moon for each 
day of the selected month and year. 
 
The month and year currently shown on the Date and Time sheet are the 
default when you display the calendar. Click the Previous or Next buttons to 
see the preceding or following month. 
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The times when the Moon turns full and new are shown on the days when 
they occur. The “first time” (when the new Moon begins to wax) and the “last 
time” (when the full Moon begins to wane) are also shown. Click Print to 
print a copy of the calendar. If the “Moon rise/set” or “Sun rise/set” 
checkboxes are marked, these times are added to the printout. 

Moon Viewer (Tools menu) 

In February 1994, NASA's Clementine Project began mapping the entire 
surface of the Moon. TheSky6's interactive Moon Viewer is a powerful tool 
that can display medium and high-resolution photographs of the Moon's 
visible surface, as well as search for lunar features, and overlay text 
descriptions of hundreds of different lunar features (such as craters, mare, 
crater chains, Apollo landing sites and more) using the Clementine lunar 
photographs. 

Moon Viewer Features 

 Display medium and high-resolution photographs (down to 100 meter 
scale in the Professional Edition) of virtually the entire Moon's visible 
surface. 

 Search for lunar features.  
 Display the name of the nearest lunar feature with a mouse click.  
 Overlay text descriptions (labels) of many of lunar features. 
 Show the longitude and latitude for any point of any location on the Moon. 
 Show the longitude and latitude of the center of images. 
 Outline craters and other features. 
 Expand or decrease the size of the lunar image (by sizing the window). 
 Display a brief history of the source of the lunar feature's name. 
 Show the macroscopic location of the current Moon Viewer image on the 

Virtual Sky's Moon. 
 
Select the Moon Viewer command from the Tools menu to display the Moon 
Viewer window.  
 
Place the mouse cursor over the image to show the Moon’s longitude and 
latitude. Click on the picture to identify the nearest feature.  Use the Up, 
Down, Left (<) and Right buttons (>) to pan to the adjacent picture.  
 
Right-click on the window to access frequently used commands. 
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Figure 44 – Moon Viewer window. 

 
The Moon Viewer can overlay text labels of any or all of the following lunar 
features, including: 
 
 Craters 
 Sub-craters 
 Mare (seas) 
 Landing sites 
 Catena (crater chains) 
 Rima (rilles) 
 Lacus (lakes) 
 Mons (mountains) 
 Dorsum (wrinkle ridges) 
 Promontor (promontories) 
 Vallis (valleys) 
 Other features 

Outlines 

Mark this option to draw the outlines of moon craters directly on the 
photograph. 

Grid 

Mark this option to overlay a latitude and longitude grid on the pictures. 

High Resolution 

Mark this option to display high-resolution Clementine photographs. Medium 
resolution images are displayed by default. 
 

Label 

Mark this option to display the text for the names of lunar features. 
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Image Information 

This area displays the latitude and longitude of the center of the current 
photograph. 

Up/Down/Left Arrow/Right Arrow 

Use these buttons to navigate around the moon's surface. 
 
A black area on a photograph indicates that the Clementine data does not 
completely cover this portion of the Moon's surface. 

Conjunction Finder (Tools menu) 

The Conjunction Finder can locate conjunctions between any two or three 
planets and/or the Sun and Moon, as view from Earth.  
 
Choose the Conjunction Finder command from the Tools menu and then 
mark two or three objects in the Objects list. Earth is listed for reference 
only; it cannot be selected as part of the search. 
 
Click the Start button to begin the search. TheSky6 uses the value entered in 
the “Within (degrees)” text box to determine how close the objects must fall 
before a conjunction is “found.” While searching, the text on the Start button 
changes to Stop and the angular separation between the marked objects is 
graphed in the “Angular Separation Graph.” 
 
Once a conjunction is found, click the Show button to view it. The Virtual Sky 
is oriented so that the objects are centered. 
 

 
Figure 45 – Conjunction Finder window. 

 
For this example, the conjunction between Mercury, Venus and Mars does 
not occurs until September 8, 2008. 
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Figure 46 – Conjunction between Mars, Mercury and Venus. 

Mosaic Command (Tools menu) 

The Mosaic command divides a rectangular area of the sky into smaller 
rectangles, each of which has the dimensions of a selected field-of-view 
indicator (FOVI) or any user-defined size. You can slew to the center of any 
rectangle simply by clicking on it. 
 
This feature provides an easy way to photograph an area of the sky larger 
than a single CCD or film image can cover, or to systematically survey 
sections of the sky (as when searching for comets or minor planets).  
 

 
Figure 47 – Sample mosaic. 

 
1 Select the Mosaic command from the Tools menu. 

The Mosaic dialog box appears. 
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Use the Geometry tab to define the position (in equatorial coordinates), 
geometry, the number of rows and columns, and percentage overlap of the 
primary mosaic. The Advanced tab can be used to duplicate the primary 
mosaic. Mark the Visible option to show the Mosaic area, and then click 
“Apply” to center and frame the mosaic on the Virtual Sky. The Position 
Angle is measured counterclockwise from North.  
 
If you know what optical system and camera you’ll be using, and have 
defined a FOVI, select its description from the “My FOVIs” list and then 
click “Get Geometry From My FOVI.” 

2 Click the Advanced tab. 
The Advanced tab let you replicate the primary mosaic as many times as 
necessary. 
 

 
 
Enter the horizontal (x-axis) and vertical (y-axis) offset for the new 
mosaic. The offset unit is defined as the “width of the primary mosaic.” A 
value of 1 in the “X offset” will place the replicated mosaic’s upper left 
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corner next to the primary mosaic’s upper right corner. (The offset is 
always relative to the upper left corner of the primary mosaic.)  
 
An offset of 0,0 is allowed and will place another mosaic on top of the 
primary mosaic. The mosaics centers are numbered starting at one 
through the total number of mosaic regions. Mosaics are ordered 
alphabetically.  
 
Click the “Add” button to create the new mosaic and add the offset to the 
mosaic replication list. 
 

3 Specify the numbering convention for the mosaic centers.  
 -X,+Y – Mosaic center numbers are incremented right to left by row, 

starting in the upper right corner of the mosaic.  
 

 
 

 +Y,+X – Mosaic center numbers are incremented top to bottom by 
column, starting in the upper right corner of the mosaic. 

 

 
 

 +X,+Y – Mosaic center numbers are incremented left to right by row,  
starting in the upper right corner of the mosaic. 
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 -Y, -X – Mosaic center numbers are incremented bottom to top by 
column, starting in the lower left corner of the mosaic. 
 

 

Lunar 

Mark this option to indicate that this will be a mosaic of the Moon. TheSky6 
will slew the telescope according to the current position of the Moon. 

Copy To Clipboard 

Click the button to copy the equatorial coordinates of the centers of selected 
mosaic to the Windows Clipboard. These coordinates can be used to generate 
a script that slews your telescope to each position. 
 
Sample mosaic data: 
 
  1  A   0   9.32121655 -29.04969590 
  2  A   1   9.32119169 -28.89969638 
  3  A   2   9.32116702 -28.74969737 
  4  A   3   9.32114254 -28.59969785 
  5  A   4   9.30977751 -29.04991248 
  6  A   5   9.30976922 -28.89991265 
  7  A   6   9.30976100 -28.74991333 
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  8  A   7   9.30975284 -28.59991349 
  9  A   8   9.29833849 -29.04991248 
 10  A   9   9.29834678 -28.89991265 
 11  A  10   9.29835500 -28.74991333 
 12  A  11   9.29836316 -28.59991349 
 13  A  12   9.28689945 -29.04969590 
 14  A  13   9.28692431 -28.89969638 
 15  A  14   9.28694898 -28.74969737 
 16  A  15   9.28697346 -28.59969785 

Reset Slewed 

Once you have slewed your telescope to a given frame, parentheses are 
placed around the number in the center of the block, indicating that this frame 
has been imaged. If you wish to start the mosaic process over, click this 
button to clear all the parentheses. 

Using the Mosaic 

Once a link with the telescope is established (page 221) , all you have to do is 
click anywhere within one of the mosaic frames, and the telescope will 
automatically slew to those coordinates and track them. 
 
If you are viewing or photographing the Moon, mark the “Lunar tracking 
rate” checkbox. The telescope’s drive will automatically be reset to the 
sidereal rate. (The previous rate is restored when you remove the mosaic.) 
 
The frames are numbered, but you can select them in any order. (If TheSky6’s 
window is not maximized, or the field of view is too small, the numbers might 
not be displayed.) A selected frame’s border changes color from magenta to 
red, to remind you it’s been “visited.” To reset these frames to magenta, click 
Reset Slewed.  
 
If you’re using the Mosaic feature to take pictures, the CCD or film camera 
has to be aligned with the mosaic frames. You must therefore either position 
the camera to align it with the Virtual Sky, or orient the Virtual Sky to the 
camera. TheSky6 can help you. Use Image Link to align one of your CCD 
images with the Virtual Sky, and then click inside the image to display the 
Object Information dialog box. The “Image Link Information” gives the 
orientation of the image as an angular offset from North. You can then adjust 
the camera mount or the Virtual Sky’s orientation accordingly.  
 
The Mosaic feature works best with equatorial telescopes. Alt-az telescopes 
suffer from field rotation, which causes the field of view to gradually rotate. 
The severity of this effect varies with the altitude coordinates of the area 
being photographed, and the length of time needed to complete the 
photography. A field-rotation corrector might be needed.  
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Options 

The Options dialog box contains miscellaneous options that affect the default 
behavior of TheSky6. 
 

Saving Document Changes Before Exiting 

If you’ve changed the default view, or other settings, while using TheSky6, 
you’re prompted to save the Sky Document before exiting. Clearing the 
Prompt to Save Modified Documents option allows you to bypass this step, 
and exit without saving changes. Some users don’t want to be bothered with 
this message each time they exit TheSky6. 

Showing the Wait Cursor 

While TheSky6 is redrawing the screen, the mouse pointer is switched to a 
wait cursor (normally a rotating hourglass). Clear the Show Wait Cursor 
When Drawing Screen option to override this behavior, and always show the 
normal mouse cursor while the screen is redrawn. 

Copying Sample Files to the My Documents Folder 

TheSky6 automatically copies sample graphical symbols (metafiles), Sky 
Documents, Data Wizard queries, and other files to the My 
Documents\Software Bisque\TheSky6 folder the first time the software is 
launched. You can clear the Copy All Sample Files to <My Documents> At 
Start Up option so that no files are copied. 
 
See the topic “Appendix A File Locations and Database Errors” on page 237 
for information about the My Document folder. 
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Chapter 20 Controlling Your Telescope 

WARNING! 

NEVER attempt to observe the Sun through your telescope! Without a 
specially designed solar filter, viewing the Sun – for even a fraction of a 
second – will cause instantaneous, irreversible eye damage. 
 
When observing during the day, do not point the telescope near the Sun. Do 
not use TheSky6’s automatic-slew feature to find astronomical objects during 
the day. 

Introduction 

TheSky6’s telescope-link system can work with two classes of telescopes. 

Telescopes with Optical Encoders 

The encoders read the rotation of the telescope’s axes, and return numbers 
that represent how much they moved. The following serial interface boxes 
are compatible with TheSky6. 
 
 AB Engineering 
 BBox (Software Bisque) 
 NGC-MAX (JMI) 
 NGC Sky Commander (Lumicon) 
 Sky Commander (SkyComm Engineering) 
 Sky Wizard 3 (Lumicon) 
 Sky Tour (Tele Vue) 
 TheSky Box (Software Bisque) 
 SkyQuest IntelliScope Computerized Object Locator (Orion Telescopes & 

Binoculars) 

Telescopes with Computer Control 

TheSky6 can send positioning and other commands to the following “go to” 
telescope systems. 
 

 Astronomy Command Language-controlled telescopes 
 ArchImage (Meridian Systems) 
 Astro-Physics GTO mounts (all models) 
 Celestron™ Ultima 2000™ telescopes 
 Celestron™ Advanced Series (all models) 
 Celestron™ NexStar (all models) 
 Celestron™ CGE Series (all models) 
 Celestron™ GT Series (all models) 
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 Celestron™ NexStar i Series (all models) 
 DFM Engineering mounts (all models) 
 Gemini control system (Losmandy) 
 Meade™ LX200™ (classic) telescopes 
 Meade™ Autostar (classic) telescopes 
 Meade™ Autostar II (LX200 GPS) telescopes 
 Software Bisque Paramount GT-1100 
 Software Bisque Paramount GT-1100S 
 Software Bisque Paramount ME 
 Telescopes in Education Network (via Internet, TheSky6 Professional 

Edition only)  
 Takahashi™ Temma mounts (all go to models) 

 
In addition, TheSky6 can simulate a telescope link. You can experiment 
without actually having a telescope connected. This is explained on page 233.  
 
Whether your telescope has optical encoders, or computer control, the Virtual 
Sky tracks the telescope’s position. In addition, TheSky6 can position “go to” 
telescope systems. Select an object from TheSky6’s database, and it will point 
the telescope at it. 
 
Details about connecting your computer to your telescope or drive system, 
and calibrating or synchronizing the setup for “go to” telescopes can be found 
in TheSky6 Help.  Select the Contents and Index command from the Help 
menu and search for the name of your telescope. 
 
All systems using optical encoders are set up the same way and are explained 
below in a single section. Computer-controlled telescopes are each set up 
differently. Each is described in TheSky6’s Help.  
 
Documentation for the Software Bisque Paramount ME Robotic Telescope 
System is included in the Paramount ME User’s Guide. 

Setting the Correct Time 

Computer-controlled drive systems typically have an internal clock that must 
be set with high accuracy. (Encoder-based system do not need as high degree 
of accuracy.) Neither radio station time announcements nor the telephone 
company’s time signals are especially accurate. The internal clocks of 
personal computers aren’t accurate, either – they are notorious for gaining or 
losing several seconds a day. 
 
The best source for keeping accurate time is to use an Internet time server.  
See “Keeping Accurate Time” on page 21 for details. 
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Other than the encoders and their interface box, the only extra hardware 
required is a standard serial (RS232) cable to connect the interface to your 
computer. This cable is usually supplied with the encoder system. Make the 
appropriate connections from the encoders to the interface box, and the box 
to your computer, as shown in the drawing below.  

 
 

Setting Up and Using Optical Encoder Systems 

Other than the encoders and their interface box, the only extra hardware 
required is a standard serial (RS232) cable to connect the interface to your 
computer. This cable is usually supplied with the encoder system. Make the 
appropriate connections from the encoders to the interface box, and the box 
to your computer, as shown in the drawing below.  

Configuring the Hardware 

You are now ready to configure the hardware. 
 
1 Select the Setup command from the Telescope menu.  

The Telescope Setup dialog box is displayed.  
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2 From the Control System list box, select the encoder interface you’re using.  
The encoder boxes from Tangent Instruments all speak the same “language” so it does not 
matter which name you select. Just pick one of them. 

3 Click Settings.  
The Telescope Settings dialog box appears. 
 

 
 

4 In the COM Port list box, select the serial port to which the interface is 
connected. 

5 In the Baud Rate list box, select 9600.  
Most encoder interfaces communicate at 9600 baud. The 14.4K, 19.2K, and faster rates are 
provided for interfaces that can operate at higher speeds.  

6 Select your telescope from the Telescope list box.  
If it isn’t listed, choose CUSTOM.  
The number of encoder tics per revolution for the selected telescope is displayed in the 
Encoders edit boxes to the right. If your telescope isn’t listed, don’t worry. Just manually enter 
the correct values in the Encoders edit boxes. If you don’t know these values, contact the 
manufacturer.  

7 Enter the same values in the Tics/Rev edit boxes.  
The RA and Dec values are sometimes different. Don’t switch them. If you own version 1.7 
through 1.99 of the BBox, or version 2.93 through 3.49 of NGC-MAX, enter 32768 for both 
axes. (If you don’t know the version number, choose Options from the Telescope menu, and 
select the Communications Test command from the fly out menu. Click Get Version, and then 
turn the interface box off, then on. The version number will be displayed.)   

8 Set the Clockwise/Counterclockwise options for Altitude and Azimuth 
Direction.  
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If you aren’t sure which way the encoders are supposed to be mounted, contact the 
manufacturer. Or continue with the setup, and see which way the cross hairs move when you 
link the telescope and computer.   

9 Click Configure BBox.  
This Step applies only if you own a BBox, version 1.7 (or later).  
 
If not, skip to Step 10. The BBox is automatically configured for the selected number of 
encoder tics. If you get the message “Cannot configure BBox,” try again. If you still cannot 
configure the box, please refer to the “Troubleshooting” section on page 234. This step need 
be done only once, as the interface box stores the configuration in non-volatile memory.  

10 Click OK to save the configuration. 

Aligning the Encoders 

The computer and the encoders can now communicate. The next step is to 
align the encoders by aiming the telescope at specific stars. This gives 
TheSky6 the information it needs to calculate where the telescope is pointing. 
 
By default, TheSky6 uses Polaris and Capella for alignment stars. Any two 
stars can be used during the alignment procedure.  
 
Please read carefully the procedure below. It describes precisely how to 
choose different alignment stars. Really! (Judging from the number of 
technical support questions we get on this topic, it seems that many don’t 
even bother reading the manual. Gasp!) 
 
1 Set up the telescope where you do your observing.  
2 Select the Link command from the Telescope menu.  
3 Click Establish in the fly out menu.  

Or click the Establish Link button on the toolbar. (The Sky Commander is aligned 
independently of TheSky6, so users can skip the rest of this section.)  

4 If your telescope has an equatorial mount, point it at 90° declination.  
5 If your telescope has an alt-az mount, point it at 90° altitude.  

Specifically, you’re looking for the position where motion in right ascension (or azimuth) 
causes no motion in declination (or altitude). The default angle is 90°. To point the telescope 
at a different angle, exit the Link Establish dialog box. Go back to the Telescope Setup dialog 
box. Enter the angle in the Point Declination edit box. Click OK, then Close. Select Establish 
Link again.  

6 Click OK. 
7 Point the telescope at the first alignment star.  

The default first-alignment star is Polaris. To use a different star, use the Find command to 
locate the star (or just click on it in the Virtual Sky). Then click Align On in the Telescope 
sheet of Object Information dialog box. 

8 Click OK. 
9 Point the telescope at the second alignment star.  

The default second-alignment star is Capella. To use a different star, use the Find command 
to locate the star (or just click on it in the Virtual Sky). Then click Align On in the Object 
Information dialog box.  

10 Click OK.  
The difference between the actual angular separation of the alignment stars and the angle 
measured by the encoders is displayed. A difference of zero indicates a “perfect” alignment. 
Experience has shown that a difference of less than ½° is acceptable. If the difference is 
substantially greater, please refer to “Troubleshooting” on page 234.  

11 Click Accept.  
The alignment is complete. You should see cross hairs in the Virtual Sky, marking the center 
of the field of view of the telescope. 
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As you move the telescope, the cross hairs move to show where the 
telescope is pointing. As the cross hairs reach the edge of the screen, the 
Virtual Sky automatically scrolls to keep the cross hairs visible.  
 
The Establish Link button on the toolbar is “down” to show the telescope link 
is active. Click the Suspend Link button at any time to temporarily disable the 
link and regain manual control of the Virtual Sky. Click the Suspend Link 
button again to restore the link. (These commands are also available from the 
Telescope menu.) 
 
Selecting Alignment Stars 

If you choose different alignment stars, don’t pick closely spaced ones. No 
encoder is perfect; all have some positional error. Generally speaking, the 
greater the angular separation of the alignment stars (in both right ascension 
and declination), the more this error is “averaged out” across the sky. 
 
Realignment with Each Use 

TheSky6 has no provision for saving alignment settings because you must 
align the telescope each time you use it, even when observing from the same 
location. Slight differences in telescope elevation and leveling will invalidate 
the previous calibration, especially at high magnifications. Suspending the link 
does not cause loss of alignment. You do not have to realign when you 
reestablish a link in the current session. 

Software Options 

The Software Options section of the Telescope Setup dialog box provides the 
following additional controls over encoder/drive interface. Mark or clear the 
checkboxes to select or deselect them. 
 
 Confirm slews  

You must confirm any slewing command. 
 Confirm syncs  

You must confirm any synchronization command. 
 Confirm mapping  

You are prompted to confirm each new coordinate point mapped. (Applies 
only to owners of TPoint Telescope Pointing Analysis software, 
http://www.bisque.com/tpoint.) 
Impose slew limits (destination coordinates only)  
Turns on slewing limits, and warns if you try to slew the telescope inside 
them. This checkbox must be marked for the slewing limits to be in effect. 
(The limit lines do not have to be displayed, however.) Slewing limits also 
work with encoder systems. TheSky6 beeps three times if you try to move 
the telescope inside a limit line. 

 Attempt to stop slews in progress through slew limits  

http://www.bisque.com/tpoint
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If you select an object that requires the telescope to slew across the limit 
area, TheSky6 will attempt to stop the slew when the boundary is reached. 

 Switch to night vision upon link  
The Virtual Sky automatically turns the title bar, tool bars, and Status bar 
red when the link is established. If you also want the stars to be red, 
select the Stellar Options command from the View menu and mark the 
“Red in night vision” checkbox. 

 Show the number of packets, retries, failures  
Gives detailed information about serial-link activity. We recommend 
turning this on when connected to the Mount Wilson Observatory. It can 
provide useful information when you get “retry” or error messages. 
Otherwise, you’d select this option only when you have a communications 
problem with the serial link to your encoder or telescope. 

 Close Object Information dialog box upon slew  
When you click the Slew To button to move to the selected object, the 
Object Information dialog box closes to keep the screen uncluttered. 

 Enable TheSky modeling  
Enables the TPoint model for improved positioning accuracy. (Applies 
only to owners of TPoint Telescope Pointing Analysis software, 
http://www.bisque.com/tpoint.) 

 Always keep telescope cross hairs on screen 
This is the default – the display follows the telescope, and vice versa. If 
this checkbox is cleared, the telescope and the Virtual Sky can be 
independently repositioned. 

 Cross Hair Update Period (milliseconds)  
The Cross Hair Update Period determines how often TheSky6 
communicates with the attached encoder or control system. 

 
The 500 ms default is about right for most computer-controlled 
telescopes. If you have a fast computer, try 250 ms. Much-smaller values 
might force the computer to spend so much time communicating with the 
telescope that its performance becomes sluggish. You might want to 
experiment to find the smallest value that doesn’t interfere with normal 
operation of TheSky6. 
 
This setting also affects TheSky6’s ability to halt slewing into a limit zone.  
The more often the computer interrogates the telescope, the more likely 
TheSky6 will be able to stop the slew in time. The 500 ms default is too 
slow for encoder systems – checking only twice each second makes it 
difficult to perform minor adjustments on the telescope’s position. Try 250 
ms (or less, if you have a fast computer). 

Using the Link 

The cross hairs in the Virtual Sky will now “follow” the telescope. This is 
true whether you move the telescope by hand, or let its motor drive turn it. 

http://www.bisque.com/tpoint
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Be sure you’ve marked the “Use computer’s clock” checkbox. The Virtual 
Sky will then update automatically. (The time between updates can be 
changed. See page 15.) If you select a specific date and time, the Virtual Sky 
does not update. The display will not match what you see through the 
telescope. 

Terminating the Link 

Select the Link command from the Telescope menu and click Terminate in 
the fly out menu. (Or click the Terminate Link button on the toolbar.) 

Finding a Particular Object 

TheSky6 can help you position the telescope on a particular object. (This 
feature is not available with the Sky Commander.) 
 
1 Use the Find command to locate the object.  
2 Click Guide To in the Object Information dialog box.  

The Guide To dialog box is displayed. The current position of the telescope is shown by the 
long lines (“guiding needles”) in the Axis circles. The object’s coordinates are indicated by 
short lines (“destination marks”) at the edges of the circles. Mark the Enlarge checkbox if you 
want a larger display for greater precision.  

3 Starting with the RA/Az axis, move the telescope to align the needles with the marks. 
When the needle and mark are aligned, use the telescope’s fine adjustment to make the 
middle, red “LED” illuminate. Lock the RA/Az axis.  
On B&W displays, the illuminated “LED” is brighter than those surrounding it.  

4 Repeat Step 3 for the Dec/Alt axis.  
When both red “LEDs” are lit, the Guide To dialog box automatically closes. 

 
The Virtual Sky’s cross hairs are now over the desired object. When you look 
through the telescope, the object should be near the center of the field. If 
“Impose slew limits” is enabled, TheSky6 warns you if you try to move the 
telescope into a limit-line region. 

Setting Up and Using your Go To Telescope 

TheSky6 can drive most commercial telescopes. The only additional hardware 
needed is a telescope cable, to connect your computer to the telescope’s 
serial port. These can be purchased from the Software Bisque Store 
(http://www.bisque.com).  
 
We strongly recommend that you read the telescope’s owner manual 
carefully, and become thoroughly familiar with the telescope’s operation, 
before using TheSky6 to control it. Do not attempt daytime slewing before you 
have read and understood the “Daytime Slewing” section of the Meade 
manual. 
 
Details about connecting your computer to your telescope or drive system, 
and calibrating or synchronizing the setup for “go to” telescopes can be found 

http://www.bisque.com
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in TheSky6 Help. Select the Contents and Index command from the Help 
menu and search for the name of your telescope. 
 
The following general procedure applies to most “go to” telescopes.  

Configuring the Interface 

TheSky6 must be configured so your computer can communicate with the 
telescope. 
 
1 Turn off the telescope. 
2 Using the appropriate cable, connect the serial port on the telescope to an 

unused serial port.  
If your computer does not have a serial port, you’ll need to purchase a USB to serial adaptor. 
Select the Contents and Index command from the Help menu and search for “serial port 
alternatives” for details. 

3 Turn on the telescope.  
4 Select the Setup command from the Telescope menu. 
5 In the Control System list box, select the name of your telescope in the Name 

list. 
If you’re not sure which one to choose, select the Contents and Index command from the Help 
menu and search for your telescope name. 

6 Click Settings. The Settings dialog box appears. 
7 In the COM Port list box, select the serial port to use.  

Make sure that the port is not a modem. Only standard serial ports that are not being used by 
any other device should be used. 

8 In the Baud Rate list box, select 9600.  
All current interfaces run at 9600 baud. 

Linking to and Synchronizing with the Telescope 

Most “go to” drive systems must be properly configured before TheSky6 can 
control them. You can do this “by hand,” using the telescope’s hand paddle. 
Or, you can do it from within TheSky6.  (Note that all Celestron telescopes 
cannot be synchronized from TheSky6 and must be aligned using the hand 
paddle.) 
 
 The time and terrestrial coordinates must be entered. If the telescope is 

connected to your computer, you might find it easier to use TheSky6 to 
initialize the telescope. See the telescope specific instructions in 
TheSky6’s Help for details about initializing your telescope.  

 The telescope must be aligned. See the telescope specific instructions in 
TheSky6’s Help for details about aligning your telescope. 

Software Synchronization 

The following procedure applies if your telescope can be synchronized 
through software.  If your telescope must be aligned first, do so following the 
manufacturers initialization instructions now. 
 
1 Turn off the telescope. 
2 For altitude/azimuth use, level the telescope as accurately as you can.  
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Use a carpenter’s level – it’s more accurate than the level in the telescope’s tripod. 
3 Select the Link command from the Telescope menu. 
4 Choose Establish from the fly out menu.  

If the “Switch to night vision” checkbox is marked, the screen, cursors and menus turn red. 
Cross hairs appear at the center of the Virtual Sky, showing the current position the telescope 
“thinks” it is pointing.  If you receive a “Can’t establish link” message, be sure the connections 
are correct and the telescope is turned on.  

5 If you haven’t set the telescope’s time and coordinates, do so now. 
6 Move the telescope to position a known deep-space object (preferably a star) 

at the center of the telescope’s field.  
Don’t use a planet, nebula, or galaxy. Star coordinates are more accurate, and a star is a true 
“point source.”  

7 Click on that star in the Virtual Sky.   
The Object Information dialog box appears. If the star is not highlighted in the Object List, 
click on it. 

8 Click Sync. 
This button is located on the Telescope tab of the Large Object Information dialog box. Some 
telescopes do not support software synchronization (such as Celestron “go to” telescopes) 
and must be aligned using the telescope’s hand paddle. 

 
The telescope is now aligned and can be used with TheSky6. The Virtual 
Sky’s cross hairs should jump to the object used for synchronization, or be 
centered on the star used during the hand paddle initialization. 
 
When the link is active, TheSky6 and the telescope are interdependent. 
If you use the telescope’s drive controls (or any of TheSky6’s controls) to 
reposition it, the Virtual Sky tracks the movement. 
 
The Establish Link button on the toolbar is “down” to show the link is active. 
 
Click the Suspend Link button at any time to suspend the link. TheSky6 and 
the telescope are then independent, and behave as if there were no link. (If 
you suspend the link while the telescope is slewing, the slewing continues to 
completion.) Click Suspend Link again to restore the link. 
 
Once the link is restored, the Virtual Sky repositions itself at whatever new 
position the telescope has been driven to. The opposite, however, is not true. 
If the Virtual Sky is repositioned when there’s no link, the telescope does not 
move to match it. You must select an object and click Slew. 

Slewing While the Link is Suspended 

The Suspend Link command does not actually keep commands from being 
sent to the telescope. Its main purpose is to let you reposition the Virtual 
Sky, without having to keep the cross hairs on-screen. You can still slew the 
telescope. Follow the instructions in “Slewing to a Specific Object” below. 

Slewing to a Specific Object 

1 Click on the object in the Virtual Sky.  
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If it isn’t visible, select the Edit command from the File menu to locate the 
object. 

2 Click the Slew button on the toolbar of the Object Information dialog box.  
The box below appears, and remains until the slewing is completed. 
Clicking Cancel sends a command to the telescope stop slewing. 

 
There’s a quicker way to slew, without displaying the Object Information 
dialog box. 
 
1 Right-click on the object in the Virtual Sky. 
2 Select the Slew To command from the Virtual Sky’s pop-up menu. 

Motion Controls 

The Motion Controls dialog box moves the telescope a specific distance each 
time one of the motion buttons is clicked. The increments are preset at 0.5, 1, 
5, 15, and 30 arcseconds; 1, 5, and 30 arcminutes; and 1, 5 and 10 degrees.  
 
Motion can be in four directions – North, East, South, or West. Motion can be 
with respect to Horizon (Alt-Az) or Equatorial (RA-Dec) coordinates. Click 
the radio button of the coordinate system you want to use. 
 
The Motion Controls dialog box is non-modal. It can remain open while you’re 
doing other things. 
 
The Motion Controls command has a check mark next to it if the dialog box is 
displayed. Select the Motion Controls command a second time to remove the 
dialog box. Or press ALT+M. 
 

Focuser 

The Focuser dialog box controls the focus and focus speed of a pulse focuser 
connected to the telescope focuser port. This feature is especially useful 
when viewing CCD images on a monitor while focusing. This dialog box is 
non-modal and can remain open while you’re doing other things. 
 
The number displayed indicates how many times you’ve clicked the Slow and 
Fast buttons, and in which direction. Clicking Fast changes the count by 1000, 
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Slow changes the count by 1. For example, if the number is 4007, you’ve 
clicked Slow seven times and Fast four times.  
 
The Focuser command is “checked” if the dialog box is displayed. Select the 
Focuser command a second time to remove the dialog box and check mark. 
 
TheSky6 does not control serial port focusers. Consider using Software 
Bisque and SBIG’s CCDSoft Version 5 (www.bisque.com/ccdsoft) to control 
your serial port focuser.  

Reticle  

The Reticle dialog box changes the reticle brightness and reticle flash mode 
(Astro-Physics GTO mounts and Meade LX200 telescopes only). 

Set Park 

Sets the telescope’s park position (ACL, Astro-Physics GTO mounts, Meade 
16" LX200 and Software Bisque Paramount only). 

Park 

Moves the telescope to its park position (ACL, Astro-Physics GTO mounts, 
Meade 16" LX200 and Software Bisque Paramount only). 

Find Home 

The telescope searches for its “home” sensors and reports the results. The 
home position must be found (once) before a “parked” position can be set 
(ACL, Meade 16" LX-200 and Software Bisque Paramount only). 

Align Home 

Establishes “home” position and stores it in telescope’s memory. The 
conditions listed in the prompt below must be met before clicking OK. (ACL, 
Meade 16" LX-200, and Software Bisque Paramount GT-1100 only) 

Terminal 

The Terminal command lets you send commands directly to the telescope 
control system. Type a command in the Command edit box, then click Send. 
The drive’s response appears in the Response edit box. Contact the 
telescope’s manufacturer for your telescope control system’s communication 
protocol specifications. 
Linking Your Telescope with TheSky 175 

Set LST 

Sets telescope’s Local Sidereal Time (LST), using time set in TheSky6 
(ACL only). 

http://www.bisque.com/ccdsoft
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Star Search 

 
 
Slews the telescope in a spiral pattern of increasing size to locate an object. 
(Software Bisque Paramount and Telescope Simulator only.) 

Status 

Reports status of 32 control system specific items. (ACL only) 

Terminating the Link 

Select the Link command from the Telescope menu and click Terminate in 
the fly out menu. (Or click the Terminate Link button on the toolbar.) 

Using the Telescope Simulator 

1 Select the Setup command from the Telescope menu.  
2 In the Telescope Setup dialog box, choose Simulator from the Control 

System list.  
3 Click Settings. The Settings dialog box appears.  
4 Select values for Velocity and Acceleration. The defaults are 1°/second 

and 1°/second². If your telescope’s capabilities differ, you might want to 
change these. The simulation will more-closely mimic the telescope’s 
behavior. The Baud Rate setting doesn’t matter. However, you must 
select a port that is not currently in use by another running program. 

5 Click OK, and then Close.   
 
Select the Setup command from the Telescope menu. Choose Establish from 
the fly out menu. Or click the Establish Link button in the Telescope toolbar. 
The Simulator slews to its “home” position (1 hour right ascension, 0 degrees 
declination). 

Digital Setting Circles 

TheSky6 can display the telescope’s position coordinates, in large characters, 
so they can easily be read at a distance. This feature is available with both 
encoder-based systems and telescopes having full computer control. To use 
it, select Digital Setting Circles from the Telescope menu. The Virtual Sky is 
replaced with a screen that shows the right ascension and declination of the 
telescope.  
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Figure 48 – Digital Setting Circles window. 

 
Press ESC to return to the Virtual Sky. As explained previously, no encoder is 
perfectly accurate. The coordinates shown might differ slightly from the 
telescope’s actual position. 

Troubleshooting the Telescope Setup 

Physically connecting a hardware device to computer software is not always a 
simple task. Things can, and often do, go wrong.  
 
 Both the software and the hardware must be correctly configured.   

Communication ports, cables, connectors and telescope control systems 
all must be plugged in, turned on, connected and initialized before 
attempting to be “linked” to the computer. 

 Connection cables must be wired correctly. TheSky requires “bi-
directional” communication most devices.  This means that the 
connecting cable must be wired properly to send and receive commands 
from TheSky6.  

 The communication port (serial or parallel) must be operational. The 
internal software that controls the telescope should be the latest version 
from the manufacturer of the device. 

 The proper telescope firmware (that is, the software that is run by the 
telescope’s control system) must be correct before TheSky6 can control 
the telescope. Make sure you’re running the latest firmware for your 
telescope. Contact the telescope’s manufacturer for details about possible 
firmware updates. 

 
If any of the above is not working, TheSky6 may not be able to establish 
communications with the device.  
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TheSky6 Help includes an extensive troubleshooting section. Select the 
Contents and Index command from the Help menu and search for 
“troubleshooting” for more information. 
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Appendix A File Locations and Database Errors 

Database File Locations 

TheSky6 accesses hundreds of files and databases during normal operation. 
These files may occupy as much as 80 gigabytes of disc space (when using the 
TheSky6 Professional Edition and the optional USNO stellar database). 
Keeping track of all these files is made simple with the File Locations 
command on the Data menu.  
 
The File Locations dialog box lists TheSky6’s files in a “Windows Explorer” 
format. There are two high-level folders: Data (Application Data) and User 
Data.  
 
Application Data refers to the files and folders that are used by TheSky6 to 
display databases of objects. Specifically, Application Data is read only data. 
User Data refers to all the files and folders that store data that can be saved 
by the end-user. This distinction is made so that users who have restricted 
access on a computer or network can still run and use TheSky6.  See “User-
Defined File Locations” on page 239 for more information. 
 
Expand each folder to view the subfolders. Highlight any folder in the list to 
display its complete path name (including drive letter) in the Selection group.  
 
To verify the location of any component, highlight it, and then click the Verify 
button. A green check mark indicates that the correct files reside in this 
folder. A red exclamation mark indicates that TheSky6 could not location the 
required files for this component. Click the Browse button or the Edit button 
to modify the location of the folder when this happens.  To verify the location 
of every database at once, click the Verify All button.  
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Figure 49 – File Locations dialog box after clicking the Verify All button.  

Defaults  

When TheSky6 is installed, all databases are copied into subfolders of the 
<TheSky6>\Data folder. Click the Defaults button to restore this folder 
structure. 
 
Notes 

 Bold text indicates that the files in this folder are required for normal 
operation. 

 Regular text indicates that files or databases in this folder are optional. 
 XP Professional users must have administrative privileges to modify the 

location of TheSky6’s files. 
 
Accessing Databases from a Network 

The File Locations dialog box makes setting up TheSky6 to access databases 
from a network drive simple. Once you’ve copied TheSky6’s Data folder to 
your network drive, highlight the Data folder, then click the Browse or Edit 
buttons.  Select or enter the network drive and then press the OK button.  
 
You’ll be asked to confirm the changes. Select Yes to accept them, or No to 
reject them. 
 

 
Figure 50 –File Locations confirmation message. 
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User-Defined File Locations 

By default, TheSky6 adheres to the Microsoft Windows My Documents 
convention for storing user-created and user-modified files. The first time 
TheSky6 is launched, a folder named Software Bisque\TheSky6 is created in 
the My Documents folder, and all files that can be modified by the end-user are 
copied into subfolders of this folder. You might notice a slight delay while this 
takes place.  To override this behavior, select the Options command from the 
Tools menu, and then clear the “Copy all sample files to <My Documents> 
at Startup” option.  
 
Using the My Documents convention to store user-created files has the 
following advantages. 
  
 Files created in this folder are not uninstalled, so backing up your data is 

simple. 
 Users have one familiar, easily accessible place to store their data. 
 Sharing data between applications is simple because all applications can 

access the My Documents folder. 
 Family members can share a single computer without reservation of 

overwriting or deleting someone else’s important files. 
 Parents can allow children to run the application without giving them full 

access to the computer. 
 Under Windows 2000 and XP Pro, this is the only folder that has 

guaranteed read/write access for all users. 
 Under Windows 2000 and XP, the user does not have to have 

administrative privileges to run the application and saved his/her data. 
 Under Windows 2000 and XP, the user does not have to have 

administrative privileges to run the application and saved his/her data. 
 Multiple users can share a single computer each having his or her own 

preferences and settings. 
 Under Windows XP Home, TheSky6 supports Fast User Switching.  
 The My Documents folder is an “abstracted” location and can be 

redirected to anywhere on a network by an administrator, transparently. 
 My Documents is easily accessible from the operating system, with 

shortcuts on the Start menu and all File Open dialog boxes. 
 My Documents allows TheSky6 to be run in a secure environment. 
 
The My Documents folder is a convention used by Windows XP to save user-
defined files. You can modify the folder where TheSky6 saves user-defined 
files by editing the User Data folder in the File Locations command of the 
Data menu.  
 
If you prefer not using the My Documents convention, then TheSky6 can be 
configured to save user-defined files to any location. 
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Configuring the Location of User-Defined Files 

The location of user-defined files can be configured just like other database 
files. Select the File Locations command from the Data Menu to display the 
File Locations dialog box (Figure 49) , and then highlight the “User Data” 
folder. Click the Browse button to select and existing folder, or the Edit 
button to specify a new folder. 

Missing or Anomalous Catalog Data 

You may notice some irregularities in the stellar and non-stellar catalog data. 
Errors in the astronomical catalogs are caused when photographs are 
scanned, or by human error. 

Diffraction Spikes and Halos 

The areas around some bright stars do not show any dim, high-magnitude 
stars. The “empty” areas take the form of halos or diffraction spikes. These 
optical artifacts obscure dimmer objects on the photographic plates from 
which the GSC data are derived. 

“Burned-Out” Areas 

The GSC data were derived from photographic plates given heavy exposure 
to bring out detail. As a result, the central regions of globular clusters and 
bright nebulae are sometimes overexposed, and show no detail. This can be 
seen (for example) as an empty square area in NGC 5139. It is also the reason 
why the Trapezium shows little detail. 

Missing Data 

There are no data for several areas. In particular, there is a blank rectangular 
region in Hercules, at about 17h 20m RA, 33º 13' Dec. (The Hipparcos- Tycho 
catalogs include some of the brighter stars in this region.) 

Anomalous Data 

There are two rows of “stars,” centered at 22h 10m 34.5s RA, -11° 38' 12" 
Dec, and 22h 08m 17.6s RA, -11° 39' 53" Dec. 

Other Errors…? 

The contracts under which Software Bisque provides astronomical databases 
prevent us from adding to or altering them. If you find additional errors or 
omissions, please let us know so we can report them. 
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Appendix B Function & Accelerator Keys 

All commands in TheSky6 are accessible using the keyboard, and many 
keyboard keys can be used as "shortcuts" to commonly used commands.  
   
The mouse can be controlled using the keyboard by activating options 
available in the Accessibility Options icon in the Ctrl Panel. Click Start 
|Settings | Control Panel, and then double-click the Accessibility 
Options icon. The Mouse tab on the Accessibility Properties dialog box 
has options for using MouseKeys. Use the numeric keypad to move the 
mouse over any object. Press the (+) key on the numeric keypad to simulate 
a left-mouse click.  
   
The following table lists the keyboard keys that can be used to execute 
commands in TheSky6. 
   
Pressing the Alt key plus the underlined letter in the menu command can 
access menu commands.  

Windows Function & Accelerator Keys 

  

Keyboard Key Command/Description 

PgUp  Increases the field of view of the Virtual Sky.  

PgDn  Decreases the field of view of the Virtual Sky.  

Left Arrow  Pans the Virtual Sky to the right, as if you were turning your head in this 
direction to view a different portion of the sky.  

Right Arrow  Pans the Virtual Sky to the left, as if you were turning your head in this 
direction to view a different portion of the sky.  

Up Arrow  Pans the Virtual Sky down, as if you were moving your head in this direction 
to view a different portion of the sky.  

Down Arrow  Pans the Virtual Sky up, as if you were moving your head in this direction to 
view a different portion of the sky.  

Home  Zooms to the maximum field of view for the current wide-field projection.  

End  Zooms to the minimum field of view for the current wide-field projection, one 
arcminute.  

E  Look East.  

F  Displays the Find dialog box.  

H Toggles the Scroll Bars on the Virtual Sky. 

I  Toggles the Image Link image on and off.  

N  Look North.  
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S  Look South.  

V Toggles the Scroll Bars on the Virtual Sky. 

W  Look West.  

Z  Look Up (at the zenith).  

Space Bar  Toggles the Full Screen command on and off.  

F4  Removes the current User Defined Data.  

Alt+'='  Rotates the Virtual Sky counterclockwise.  

Alt+','  Begins a time skip animation, moving backwards in time.  

Alt+'-'  Rotates the Virtual Sky clockwise.  

Alt+'.'  Begins a time skip animation, moving forward in time.  

Alt+C  Displays the Import dialog box.  

Alt+L  Displays the Labels Setup dialog box.  

Alt+M  When a telescope link is currently established, displays the telescope’s 
motion Ctrl window.  

Alt+P  Displays the Display Properties dialog box.  

Alt+R  Displays the Rotate Tool.  

Alt+U  Displays the User Defined Data dialog box.  

Alt+Z  Zooms to a 200-degree field of view.  

Alt+[  Steps backward in time by one time skip increment.  

Alt+]  Steps forward in time by one time skip increment.  

Ctrl+B  Zooms to a 50-degree field of view.  

Ctrl+C  Copies the current Virtual Sky to the Clipboard as a bitmap.  

Ctrl+D Executes the Image Link Wizard command (page 189). 

Ctrl+E  Zooms to a 100-degree field of view.  

Ctrl+F  Displays the Find dialog box.  

Ctrl+N  Creates a new Sky Document.  

Ctrl+O  Displays the Open dialog box.  

Ctrl+P  Prints the Virtual Sky.  

Ctrl+S  Saves the current Sky Document.  

Ctrl+T  Zooms to a 1-degree field of view.  

Ctrl+V  Pastes the contents of the clipboard at the insertion point.  

Ctrl+W  Zooms to a 180-degree field of view.  

Ctrl+X  Cuts the highlighted text to the clipboard.  

Ctrl+Z  Undoes the previous move command.  

Shift+Click When clicking on an Image Symbol, the Object Information dialog box is 
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displayed instead of a photograph of the object. 

Shift+B  Displays the previous picture in the Slide Show list.  

Shift+C  Displays the Create Slide Show List dialog box 

Shift+F  Displays the next picture in the Slide Show List.  

Ctrl+Click Add a User-Defined Object at the current mouse position. 

Ctrl+Shift+3 3D Solar System Simulator command. 

Ctrl+Shift+A Satellites dialog box. 

Ctrl+Shift+D Display Explorer dialog box. 

Ctrl+Shift+E Eclipse Finder window. 

Ctrl+Shift+F Field of View Indicator dialog box. 

Ctrl+Shift+I Image Manager dialog box. 

Ctrl+Shift+J Conjunction Finder dialog box. 

Ctrl+Shift+L Location dialog box. 

Ctrl+Shift+N Turns Night Vision Mode on or off. 

Ctrl+Shift+M Mosaic dialog box. 

Ctrl+Shift+O Real Mode Options dialog box. 

Ctrl+Shift+P Object Paths dialog box. 

Ctrl+Shift+R Reference Lines dialog box. 

Ctrl+Shift+S Displays the Sky Database Manager dialog box. 

Ctrl+Shift+T Display the Time dialog box. 

Ctrl+Shift+W Display the Data Wizard dialog box. 

Ctrl+Alt+F Zooms to a 10-degree field of view.  
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Object Information Dialog Box Keyboard Shortcuts 

 
  

TheSky6 assigns keyboard shortcuts to access the toolbar button commands 
in the Object Information dialog box. These shortcuts also allow voice 
recognition software access toolbar commands. 

  
Shortcut Command 
Ctrl+N  Center 
Ctrl+A Copy 
Ctrl+P  Print 
Ctrl+L  Observer’s Log  
Ctrl+D  Distance 
Ctrl+R  Rise/Transit/Set 
Ctrl+T Spectral Class 
Ctrl+G Angular Separation 
Ctrl+B Solar System Information 
Ctrl+S Slew Telescope 
Ctrl+M Map 
Ctrl+I  Toggle display of the large/small Object Information 

dialog boxes 
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Appendix C Reference Data 

Common Star Names 

“Common” means the non-scientific name or designation — Mizar, for 
example, is the same star as Zeta-Ursae Majoris. 
 

Acamar 

Achernar 

Acrab 

Acrux 

Acubens 

Adhafera 

Adhara 

Albali 

Albireo 

Alchiba 

Alcor 

Alcyone 

Aldebaran 

Alderamin 

Alfirk 

Algedi 

Algenib 

Algieba 

Algol 

Algorab 

Alhena 

Alioth 

Alkaid 

Alkalurops 

Alkes 

Almach 

AlNair 

Alnasl 

Alnilam 

Alnitak 

Alpha Centauri 

Alphard 

Alphecca 

Alpheratz 

Alrakis 

Alrescha 

Alshain 

Altair 

Altais 

Alterf 

Aludra 

Alula Australis 

Alula Borealis 

Alya 

Ankaa 

Antares 

Arcturus 

Arkab 

Arneb 

Ascella 

Asellus Australis 

Asellus Borealis 

Aspidiske 

Atik 

Atlas 

Atria 

Avior 

Azha 

Baten Kaitos 

Barnard's Star 

Beid 

Bellatrix 

Betelguese 

Biham 

Canopus 

Capella 

Caph 

Castor 

Cebalrai 

Celaeno 

Chara 

Chertan 

Cor Caroli 

Cursa 

Dabih 

Deneb 

Deneb Algedi 

Denebola 

Diphda 

Double Double 

Dubhe 

Edasich 

Electra 

Elnath 

Eltanin 

Enif 

Errai 

Fomalhaut 

Furud 

Gacrux 

Giausar 

Gienah 

Gomeisa 

Graffias 

Grumium 

Hadar 

Hamal 

Hind's Crimson Star 

Homam 

Izar 

Kaffaljidhma 

Kaus Australis 

Kaus Borealis 

Kaus Media 

Keid 

Kitalpha 

Kochab 

Kornephoros 

Kurhah 

Lesath 

Maia 

Marfik 

Markab 

Matar 

Mebsuta 

Megrez 

Meissa 

Mekbuda 

Menkalinan 

Menkar 

Menkent 

Menkib 

Merak 

Merope 

Mesarthim 

Miaplacidus 

Mimosa 

Mintaka 

Mira 

Mirach 

Mirfak 

Mirzam 

Mizar 

Muphrid 

Muscida 

Nashira 

Navi 

Nekkar 

Nihal 

Nunki 

Nusakan 

Osiris 

Peacock 

Phact 

Phecda 

Pherkad 

Pleione 

Polaris (North Star) 

Pollux 

Porrima 

Procyon 

Propus 

Rasalas 

Rasalgethi 

Rasalhague 

Rastaban 

Regor 

Regulus 

Rigel 

Rotanev 

Ruchbah 

Rukbat 

Sabik 

Sadalmelik 

Sadalsuud 

Sadr 

Saiph 

Scheat 

Schedar 

Seginus 

Shaula 

Sheliak 

Sheratan 

Sirius 

Skat 

Spica 

Sterope 

Sualocin 

Suhail 

Sulafat 

Syrma 

Talitha 

Tania Australis 

Tania Borealis 

Tarazed 

Taygeta 

Thuban 

Trapezium 

Unukalhai 

UU 

Vega 

Vindemiatrix 

Wasat 

Wazn 

Wezen 

Yed Posterior 

Yed Prior 

Zaniah 

Zaurak 

Zavijava 

Zosma 

Zubenelgenubi 

Zubeneschamali 
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Object-Type Index Numbers 
 

Object 
Type 

Index Object 
Type 

Index Object Type Index Object 
Type 

Index 

Unknown 
Object 
Type 

-1 Bright 
Nebula 

15 Saturn 31 Ecliptic 47 

Star 0 Dark 
Nebula 

16 Uranus 32 Horizon 
Grid 

48 

Variable 
Star 

1 Planetary 
Nebula 

17 Neptune 33 Horizon 
Lines 

49 

Suspected 
Variable 

2 NGC 
Probable 

Star 

18 Pluto 34 Meridian 50 

Double Star 3 Other NGC 19 Moon 35 Equatorial 
Grid 

51 

Galaxy 4 Mixed 
Deep Sky 

20 Comet 36 Galactic 
Equator 

52 

Type C 
Galaxy 

5 Non-stellar 
GSC 

21 Minor Planet 37 Milky Way 53 

Elliptical 
Galaxy 

6 Quasar 22 Extended 
Comet 

38 Reference 
Line 

54 

Lenticular 
Galaxy 

7 X-Ray 
Source 

23 Extended 
Minor Planet 

39 Reference 
Point 

55 

Spiral 
Galaxy 

8 Radio 
Source 

24 Satellite 40 Field of 
View 

Indicator 

56 

Irregular 
Galaxy 

9 Sun 25 Image 41 Sky Chart 57 

Cluster of 
Galaxies 

10 Mercury 26 Video 42 Sky 
Legend 

58 

Open 
Cluster 

11 Venus 27 Sound 43 Telescope 
Limit 

59 

Globular 
Cluster 

12 Earth 28 Notes 44   

Cluster + 
Nebulosity 

13 Mars 29 Constellation 
Figure 

45   

Nebula 14 Jupiter 30 Constellation 
Boundary 

46   
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Index 

A 
AAVSO...................................................142 
Aberration .................................................33 
Accelerator Keys.....................................241 
Adding 

user-defined object types ......................76 
Adding User-Defined Data .....................135 
Align Home command............................232 
Align on.....................................................49 
Alignment stars ...............................161, 225 
Alt-Az coordinates ....................................33 
analemma ................................................201 
Angle of view 

changing................................................27 
maximum/minimum..............................30 
minimum/maximum..............................22 

Angular separation ....................................43 
angular size 

zoom box...............................................94 
Animation 

setting up.............................................201 
Appearance 

stars .......................................................83 
Arrow keys 

scrolling with ........................................30 
Astrometry ...............................................84 
Astrometry Databases .............................85 
Astronomy Command Language ............221 
Auxiliary Files ........................................237 
Azimuthal Equal-Area .............................23 
Azimuthal Equal-Distance.......................23 

B 
Background 

sky color................................................65 
BBox .......................................................221 
Blindness 

solar-induced.......................................221 
Brightest 

magnitude..............................................39 

Bull’s eye.................................................. 43 

C 
Catalog numbers 

entering ................................................. 61 
labeling ............................................... 114 

Catalogs 
cross refs to other catalogs ................... 41 
list ................................................... 40, 55 
list of searchable ................................... 43 
selecting which to display .................... 37 
with funny names ................................. 55 

CCD 
astrometric databases............................ 85 
field of view........................................ 104 
projection.............................................. 83 

CCD camera 
FOVI................................................... 108 

Centering objects ................................ 34, 54 
Chart Mode............................................... 81 
Charts 

AAVSO .............................................. 142 
Chart Mode........................................... 81 
databases .............................................. 84 
feature object ...................................... 144 
fonts .................................................... 144 
format ................................................. 142 
fraction of display printed .......... 141, 144 
legend ................................................. 142 
margins ............................................... 143 
prefixes ............................................... 143 
title...................................................... 142 

Clicking the mouse ................................... 11 
Clock 

use computer's ...................................... 21 
Colors 

custom................................................. 131 
red ......................................................... 88 
spectral.................................................. 43 

Comets 
adding to display................................. 117 
importing ............................................ 119 
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plotting path ........................................197 
Comment lines ........................................173 
Common name labels..........................55, 68 

displaying............................................113 
Compass points, orienting to.....................99 
Computer time ..........................................21 
Computer-controlled telescopes 

models supported ................................221 
Computer's clock 

setting....................................................20 
Configuring Object Tips ..........................93 
Conjunction Finder .................................213 
Constellation 

boundaries .................................38, 74, 98 
drawings................................................98 
lines .......................................................98 

Constellation Boundaries ..........................97 
Constellation Figures ................................97 
Control Panel 

themes ...................................................88 
Coordinates, converting between epochs..32 
Cooridnate systems, differences ...............33 
Copy........................................................100 
Copyright, respecting..............................148 
Core databases ........................................237 
Core Databases 

management ..........................................37 
Creating Sky Databases ..........................164 
Custom 

databases .............................................168 
Customize 

Object Information report .....................49 

D 
Databases 

astrometry .............................................40 
charting .................................................40 
management ........................................159 
on/off.....................................................37 

Date 
displaying current..................................94 

Date, setting ..............................................15 
Daytime Sky Mode .................................208 
Daytime slewing, warning ......................221 
Density 

controlling .............................................83 

Detectors 
CCD.................................................... 108 

Differences 
Pole Up vs. Zenith Up .......................... 34 

Digital setting circles .............................. 233 
Digitized Sky Survey thumbnail images .. 87 
Dione ...................................................... 210 
Disclaimers ................................... 3, 42, 104 
Display 

centering ............................................... 34 
dragging................................................ 32 
pictures ............................................... 179 
scrolling ................................................ 30 
zooming ................................................ 27 

Display Properties .................................. 129 
files ..................................................... 133 
fill ....................................................... 131 
font...................................................... 129 
line ...................................................... 130 
symbol ................................................ 132 

Distance .................................................... 43 
Double stars, catalogs of........................... 42 
Dragging the mouse.................................. 11 

E 
Earth location............................................ 94 
Earth's shadow, displaying ....................... 72 
Eclipse Finder and Simulator ................. 208 
Ecliptic...................................................... 98 
Edit 

user-defined object type symbols ....... 178 
Enceladus................................................ 210 
Encoders 

aligning ............................................... 225 
models supported................................ 221 
realignment ......................................... 226 
setting up ............................................ 223 

Equatorial coordinates 
precession ............................................. 91 

Equatorial grid .......................................... 38 
Equatorial Grid ......................................... 97 
Equatorial Lines........................................ 98 
Escape key 

pressing................................................. 89 
Exporting 

star chart as bitmap............................. 146 
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star chart as metafile ...........................146 
star chart layers ...................................147 

Extended minor planets...........................120 
Eyepiece 

field of view ........................................107 

F 
Faintest 

magnitude..............................................39 
Field of View Indicators.........................104 
Field width 

changing................................................27 
current ...................................................94 

Filter 
by magnitude.........................................38 

Finding objects....................................43, 52 
by catalog designation...........................55 
by type...................................................52 
Magellanic Clouds ................................63 
multiple .................................................55 
name......................................................54 

FOVI .......................................................104 
as telescope cross hair .........................106 
Eyepieces ............................................107 
moving ................................................105 
rotating ................................................106 
telescope mask ....................................106 

Free Rotation orientation ..........................24 
Full Screen command ...............................81 
Full Screen Mode......................................93 

G 
G reenwich, time zone of ..........................14 
Galactic equator ........................................38 
Galactic pole 

markers..................................................98 
Galaxies 

PGC.......................................................41 
Galilean moons .......................................210 
Getting started...........................................11 
Gnomonic projection ................................23 
GSC catalog ............................................237 
Guide Star Catalog....................................40 

H 
Halo 

Moon..................................................... 65 
Sun........................................................ 65 

Halos on Bright Stars .............................. 86 
Help .......................................................... 12 
Hipparcos catalog ..................................... 40 
Hipparcos-Tycho catalog........................ 237 
Horizon glow ............................................ 65 
Horizon grid.............................................. 38 
Horizon Grid............................................. 97 
Horizon image 

match local horizon line ..................... 100 
Horizon-based Lines ............................... 99 
Hubble Guide Star Catalog....................... 40 
Hyperion ................................................. 210 

I 
Iapetus..................................................... 210 
IC catalog.................................................. 41 
Identifying objects .................................... 43 
Image Groups ......................................... 181 
Image Link.............................................. 189 
Image Manager ....................................... 181 
Import 

Sky Databases..................................... 164 
Internet 

comet orbital elements........................ 120 
minor planet orbital elements ............. 120 
satellite TLEs...................................... 122 

J 
Julian date................................................. 91 
Jupiter's moons ....................................... 210 

L 
Labeling 

stars..................................................... 113 
Labels 

adding to display................................. 113 
Landscape orientation............................. 142 
Legend .................................................... 142 
Limit lines 

telescope ....................................... 38, 101 
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Limiting 
magnitude..............................................38 

Lines 
adding to display...................................97 

Link Wizard ............................................190 
Local horizon ............................................97 

refracted .............................................101 
local sidereal time ...............................91, 94 
location......................................................14 
Location 

database files.......................................237 
terrestrial ...............................................13 

Look commands........................................24 
LST ...........................................................91 
Lunar 

features................................................211 
Lunar eclipses 

viewing................................................208 

M 
Menus 

accessing in Full Screen mode..............81 
Mercator projection...................................21 
Meridian line.......................................74, 99 
Messier objects, finding ............................57 
Milky Way ..........................................63, 65 

photograph ............................................98 
picture ...................................................65 
polygon .................................................98 

Mimas .....................................................210 
Minor planets 

adding to display.................................117 
extended ..............................................120 

Mirror Image command ............................83 
Moon 

Viewer.................................................211 
Moon Phase Calendar command ............210 
Moonrise .................................................157 
Moons 

of Jupiter .............................................210 
of Saturn..............................................210 

Mosaic command ....................................214 
Motion Controls dialog box ....................231 
Move To command ...................................32 
Multimedia property sheet ........................47 
My FOVIs ...............................................109 

N 
NGC catalog ............................................. 40 
Night Vision Mode ................................... 88 
Non-Stellar Options.................................. 86 
North Galactic Pole .................................. 98 
North/East Indicator ........................... 75, 99 
Nutation .................................................... 33 

O 

Object Tips............................................... 93 
Observer’s Log ........................................ 45 
Opacity 

telescope mask.................................... 110 
Optical Encoders ...................See Encoders 
Orbital elements 

entering ............................................... 117 
Orientation 

Virtual Sky types .................................. 23 

P 
Page Setup command ............................. 142 
Park .......................................................... 49 
Park command ........................................ 232 
Paste........................................................ 100 
Phonetic matches ...................................... 55 
Pole Up orientation................................... 23 
Position angle ........................................... 43 
Position error ............................................ 43 
Precession ........................................... 33, 91 
Principal Galaxy Catalog.......................... 41 
Print command........................................ 141 
Projections 

understanding ....................................... 21 
Proper motion ............................... 40, 43, 84 

vectors............................................. 75, 85 
Proper Motion.......................................... 85 
Properties 

display................................................. 129 
Properties ..................See Display Properties 

R 
Real Mode 

constellation drawings .......................... 65 
horizon glow......................................... 65 
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Moon halo .............................................65 
panoramic horizon ................................65 

Redraw Screen command .........................90 
Reference Lines .......................................97 
Refracted horizon....................................101 
Refraction..................................................33 
Report 

Sun and Moon.....................................156 
Rhea ........................................................210 
Rings 

of Saturn..............................................210 
Rise time ...................................................43 
Rotate Tool........................................24, 192 

S 
SAO catalog ..............................................56 
Satellites 

TLEs....................................................121 
tracking .................................................49 

Saturn 
rings.....................................................210 

Saving 
prompt to save message ........................90 

Scrolling 
arrow keys.............................................30 
direction ................................................31 
incremental............................................31 

Set Park ....................................................49 
Set time .....................................................43 
Set tracking rates .....................................49 
Slide Show command .............................179 
Solar eclipse ............................................209 
Solar ecliptic .......................................74, 98 
Solar System Simulator...........................205 
South Galactic Pole...................................98 
Star 

density ...................................................84 
limiting brightness ................................38 

Star Search command .............................233 
stars 

labeling................................................113 
Stars 

appearance.............................................83 
red in Night Vision mode.....................86 

Status Bar ............................................34, 94 
Stellar options ...........................................83 

Stereographic projection........................... 22 
Sun and Moon Report............................. 156 
Sunrise .................................................... 157 
Symbols 

editing ................................................. 132 
Sync .......................................................... 48 

T 
Tables, creating....................................... 149 
Telescope 

FOVI................................................... 107 
troubleshooting ................................... 234 

Telescope Limit Lines .......................... 101 
Telescope Link 

configuring the interface..................... 229 
sending commands ............................. 232 
slewing to a specific object................. 230 
synchronization................................... 229 

telescope position ..................................... 94 
Telescope property sheet .......................... 48 
Telrad™ Finder ...................................... 110 
Terminal command................................. 232 
Tethys ..................................................... 210 
Themes ..................................................... 88 
Time 

current................................................... 21 
Titan........................................................ 210 
TLEs ....................................................... 121 
Tracking rates.......................................... 49 
Tracking satellites ................................... 49 
Transit time............................................... 43 
Translucent Sun and Moon....................... 88 
Twilight time 

begin and end...................................... 157 
Two-line-elements .................................. 121 

U 
UCAC catalog .............................. 37, 79, 85 
Undo ......................................................... 95 
universal time ........................................... 91 
Update Solar System ............................... 90 
Uranometria charts ................................. 147 
User-Defined Data command ................. 135 
User-defined object types ......................... 76 
USNO catalog....................... 37, 42, 85, 237 
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UT .............................................................91 
Utility property sheet ................................48 

W 
Washington catalog 

double stars ...........................................41 

Z 
Zenith Up orientation ............................... 23 
Zoom Box ................................................. 28 
Zoom buttons ........................................... 27 
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